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INTRODUCTION 

This manual provides descriptive 
information for B 20 Systems 
applications. 

and operational 
word processing 

Informa tion 
follows: 

Sec.t ion 1, 
Section 2, 
Section 3, 
Section 4, 
Section 5, 
Section 6, 
Section 7, 
Appendix A, 
Appendix B, 
Appendix C, 
Appendix D, 
Appendix E, 
Appendix F, 

Appendix G, 
Glossary 
Index 

in the 

Overview 
Keyboard 
Screen 

manual is 

Basic Operations 
Advanced Operations 
List Operations 
Spelli ng Checker 
Status Messages 

presented 

Print Wheel Configuration 
Printer Configuration 
Hardware Considerations 
Programming Features 
Files Created by the Word 
Processor 
Document Exchange Format (DEP) 

as 



SECTION 1 

OVERVIEW 

WORD PROCESSOR FEATURES 

The Word Processor is a versatile document­
preparation tool that incorporates the following 
features: 

o Printed characters can be boldface, single or 
double underlined, superscript, subscript, 
and overstruck (a hyphen printed over a 
character). 

o Tabs can be set for left-aligned, right­
aligned, decimal-aligned, centered, and 
evenly spaced left-aligned text. All tab 
settings can have optional leader dots. 

o A ruler display shows tab and paragraph 
indent stops and paper width. 

o Previous edits can be undone with a single 
keystroke. 

o Previous edits can be repeated with a single 
keystroke. 

o The screen can be divided into mUltiple 
windows so that several sections of one or 
more documents are shown at the same time. 

o Several documents can be edited at the same 
time. 

o Text is easily moved within a document or 
from one document to another. 

o You can confirm each text replacement during 
Search and Replace operations. 

o The same document you were working on when 
you finished the previous word processing 
session can automatically appear on the 
screen when you invoke the Word Processor. 
The text and cursor positions are the same as 
they were on the screen when the previous 
session was finished. 
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o Document utilities allow you to open, copy, 
rename, and delete documents, and to change 
the work area. A directory of your documents 
also is provided. 

o Paragraph formatting includes paragraph 
blocking and indenting, paragraph spacing, 
line spacing, and margin justification. 

o Page formatting includes setting paper length 
and width; text length and width; top, 
bottom, and side margins; and header and 
footer positions. 

o Ribbon color and print wheel can be changed 
during printing. Variable character spacing 
is provided (8 pitch, 10 pitch, 12 pitch, 15 
pitch, and proportional). 

o Direci and spooled printing are provided. 
Both operations allow you to perform other 
word processing functions while your document 
is being printed. 

o The printer status feature allows you to 
check the progress of your document while it 
is in the print queue awaiting printing. 

o List processing sorts and merges files to 
produce mUltiple copies of form documents. 

o The spellini checker feature checks the 
spelling of approximately 75,000 words and 
tells you when to correct a misspelled 
word. It also provides automatic hyphen­
ation. 

o You can gain access to other programs while 
in the Word Processor. 

o The document exchange format provides a 
common language which allows you to convert 
non-B 20 format word processing documents to 
B 20 format word processing documents. 



GENERAL 

SECTION 2 

KEYBOARD 

The keyhoard is similar to a standard typewriter 
keyboard but has additional keys. (See Figure 2-
1.) It is divided into six key pads , each of 
which performs special word processing 
functions. These pads are 

0 typewriter 

0 cursor 

0 function 

0 control 

0 display 

0 numeric 

The keys of each pad are pressed singly, or in 
combination with other keys. 

See Sections 4 and 5, for details of all the 
commands invoked when the various keys and key 
combinations are pressed. 

TYPEWRITER PAD 

The typewriter pad keys are used to enter 
characters at the cursor position. Many of these 
keys are used with the SHIFT or CODE key to 
invoke commands. 

Hyphen (-) inserts a breaking required hyphen. 
(See "Special Characters" in Section 
4. ) 

CODE-hyphen 
inserts a discretionary hyphen. 

CODE-SHIFT-hyphen 
inserts a nonbreaking required 
hyphen. 

2-1 
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Figure 2-1. Keyboard. 



BACKSPACE 

TAB 

LOCK 

RETURN 

in insert mode, moves the cursor one 
position to the left and then 
deletes the character at the cursor 
position. In overtype mode, it 
moves the cursor one position to the 
left (or, if the cursor is at the 
beginning of a line, to the end of 
the preceding line) but does not 
delete a character. 

CODE-BACKSPACE 
inserts a required backspace for an 
overstriking character. (See 
"Required Backspace" in Section 4.) 

moves the cursor to the next tab 
stop. 

CODE-TAB 
moves the left paragraph indent 
forward to the next tab stop. 

CODE-SHIFT-TAB 
moves the left paragraph indent back 
to the previous tab stop. 

locks the SHIFT key for entering 
uppercase alphabetic characters. 
(This key has a light that is on for 
uppercase and off for lowercase.) 
Unlike the SHIFT-LOCK key of a 
typewriter, this key affects only 
the alphabetic keys. 

moves the cursor to the next line to 
begin a new paragraph and inserts a 
paragraph symbol. 

SHIFT-RETURN 
begins a new line without beginning 
a new paragraph and inserts a new 
line symbol. 

CODE-SHIFT-RETURN 
moves the left paragraph indent back 
to the far left margin. 
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CURSOR PAD 
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SHIFT 

CODE 

spacebar 

is similar to the SHIFT key on a 
typewriter. It allows you to enter 
uppercase alphabetic characters, 
punctuation marks, and symbols from 
the typewriter pad. SHIFT also is 
used together with other keys to 
invoke" commands. 

is used together with other keys to 
invoke commands. 

inserts a space. 

CODE-spacebar 
inserts a discretionary line break. 

CODE-SHIFT-spacebar 
inserts a nonbreaking space. 

(See "Special Characters" in Section 4.) 

The cursor pad keys have two functions: the 
cursor keys control cursor movement and the Mark 
'and Bound keys make selections. (See "Multiple 
Windows in a Single Document" in Section 5 for 
details on how the cursor keys work in multiple 
windows.) 

Up Arrow ( i ) 
moves the cursor upward one line at 
a time. If the cursor is at the top 
of the screen, it remains there. 

SHIFT-up arrow 
moves the cursor upward in 
increments of several lines. 

CODE-up arrow 
quickly moves the cursor to the top 
border of the window in which it is 
positioned. 



Left Arrow (- ) 
moves the cursor one position to the 
left. 

SHIFT-left arrow 
moves the cursor left in increments 
of several characters. 

CODE-left arrow 
quickly moves the cursor to the 
beginning of the current line. 

Down Arrow ( ! ) 
moves the cursor downward one line 
at a time. If the cursor is at the 
bottom of the screen, it remains 
there. 

SHIFT-down arrow 
moves the cursor downward in incre­
ments of several lines. 

CODE-down arrow 
quickly moves the cursor to the 
bottom border of the window in which 
it is positioned. 

Right Arrow (- ) 

MARK 

moves the cursor one position to the 
right. 

SHIFT-right arrow 
moves the cursor right in incre­
ments of several characters. 

CODE-right arrow 
quickly moves the cursor to the end 
of the current line. 

selects and highlights (in reverse 
video) the character or space in 
which the cursor is positioned. 
(Also see MARK WORD, MARK LINE, MARK 
PARA, MARK PAGE, MARK COLUMN, MARK 
DOC, and BOUND.) 

CODE-MARK 
removes the highlight from selected 
text without changing the text. 
(CODE-MARK applies to selections 
made with all Mark commands.) 
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BOUND moves the cursor and extends the 
selection to include more char­
acters, spaces, words, lines, pages, 
columns, or paragraphs. (See MARK, 
MARK WORD, MARK LINE, MARK PARA, 
MARK PAGE, and MARK COLUMN.) 

FUNCTION PAD 

2-6 

The function pad keys invoke a number of func­
tions unique to the Word Processor. The keyboard 
label strip shows the names of the function pad 
keys. 

REDO (fl) repeats the last editing operation. 

DOCUMENTS (CODE-fl) 
invokes the Documents command for 
opening, deleting, copying, and 
renaming documents; changing work 
areas; and listing the document 
directory. 

UNDO (f2) undoes the last editing operation. 

POINT OF LAST EDIT (CODE-f2) 

TABS (f3) 

remembers the position within the 
document that was last edited and 
positions the cursor at that point. 

invokes the Tabs command for setting 
and clearing tab stops. 

INDENT (CODE-f3) 
invokes the Paragraph Indent command 
for specifying left and right 
paragraph indents and first line 
indents. 

FORMAT (f4) invokes the Format command for 
formatting text being entered or 
edited. 



PRINT (SHIFT-f4) 
invokes the Print command for print­
ing entire documents or separate 
pages. 

REVIEW (CODE-f4) 
invokes the Review Document command 
for checking hyphenation and widows, 
and for repaginating the document 
without printing it. 

HEADER (f5) invokes the Header command for 
specifying running header text for 
the top of each printed page. 

FOOTER (SHIFT-f5) 
invokes the Footer command for 
specifying running footer text for 
the bottom of each printed page. 

PAGE # (CODE-f5) 
invokes the Page Number command for 
entering a page number symbol that 
is replaced with the actual page 
number during printing. 

PAGE # (CODE-SHIFT-f5) 
invokes the Roman Page Number 
command for entering a Roman page 
number symbol that is replaced with 
the actual page number during 
printing. 

SEARCH (f6) invokes the Search command for 
searching the document for specified 
text. 

REPLACE (SHIFT-f6) 
invokes the Replace command for 
replacing old text with new text, in 
a selection or throughout the 
document. 
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GO TO PAGE (CODE-f6) 
shifts a specific page into the 
current window and places the cursor 
at the beginning of the page. 

RECALL PHRASE (f7) 
invokes the Recall Phrase command 
for recalling stored phrases. 

STORE PHRASE (SHIFT-f7) 
invokes the Store Phrase command for 
storing phrases. 

COMMANDS (CODE-f7) 
invokes the Commands menu for 
choosing Sort and Merge operations 
and accessing non-Word Processor 
applications. 

MARK WORD (f8) 
selects and highlights (in reverse 
video) the word in which the cursor 
is positioned. 

MARK PAGE (CODE-f8) 
selects and highlights the page in 
which the cursor is positioned. 

MARK LINE (f9) 
selects and highlights the line in 
which the cursor is positioned. 

MARK COLUMN (CODE-f9) 
selects and highlights the column in 
which the cursor is positioned. 

MARK PARA (flO) 
selects and highlights the paragraph 
in which the cursor is positioned. 

MARK DOCUMENT (CODE-flO) 
selects and highlights the entire 
document in which the cursor is 
positioned. 



CONTROL PAD 
The control pad keys perform general editing and 
control functions. 

HELP 

CANCEL 

MOVE 

COpy 

DELETE 

OVERTYPE 

FINISH 

ACTION 

lists all commands. 

cancels a command and dismisses the 
form or menu (if any). 

moves the selected text to the 
cursor position (and deletes the 
selected text at its original 
location). 

copies the selected text to the 
cursor position (but leaves the 
selected text at its original 
location). 

deletes the character at the cursor 
position; also, deletes the 
selection in which the cursor is 
positioned. 

allows each character that is typed 
to replace the existing character at 
that position. (The key has a light 
that is on for overtyping text and 
off for inserting text.) 

finishes a word processing session, 
saving all the edits and returning 
the Executive to the screen. 

has no effect by itself. 

ACTION-FINISH 
(that is, pressing ACTION and FINISH 
at the same time) exits the word 
processor without saving any 
documents and returns the Executive 
to the screen. 
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DISPLAY PAD 
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The display pad keys move displayed text up or 
down by lines or by pages. 

NEXT PAGE 

PREV PAGE 

SCROLL UP 

shifts the text in the current 
window to show the next screenful of 
text. 

CODE-NEXT PAGE 
invokes the Forced Page command to 
force a page to start at the cursor 
position. 

shifts the text in the current 
window to show the previous 
screenful of text. 

scrolls the text in the window up­
ward one line at a time. Within mul­
tiple windows, SCROLL UP expands the 
current window upward when the cur­
sor is on the window boundary. (See 
Section 5, "Advanced Operations.") 

SHIFT-SCROLL UP 
scrolls the text upward in screen­
sized increments. Within mUltiple 
windows, SHIFT-SCROLL UP expands the 
current window upward in screen­
sized increments when the cursor is 
on the window. boundary. 

SCROLL DOWN scrolls the text in the window 
downward one line at a time. Within 
mUltiple windows, SCROLL DOWN ex 
pands the current window downward 
when the cursor is on the window 
boundary. 

SHIFT-SCROLL DOWN 
scrolls the text downward in screen­
sized increments. Within multiple 
windows, SHIFT-SCROLL DOWN expands 
the current window downward in 
screen-sized increments when the 
cursor is on the window boundary .. 



NUMERIC PAD 

The numeric pad keys are used to enter numbers 
conveniently. The numeric pad also includes the 
GO and NEXT keys. 

GO 

NEXT 

executes a command or responds ("go 
ahead") to a request by the Word 
Processor for confirmation. 

moves the cursor from item to item 
in a form. 
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GENERAL 

SECTION 3 

SCREEN 

The Word Processor screen, shown in Figure 3-1, 
is divided into two sections: the ruler display 
and the main text area, or window. These 
sections are separated by the document status 
line. 

When the Word Processor is running on a B 22 
workstation, text is displayed on the screen in 
lines of up to 132 characters. Up to 34 lines 
can be displayed on the screen at one time, 
including two lines for the ruler display, one 
line for the document status line, and 31 lines 
of text. (If the Word Processor is running on a 
B 21 workstation, see Appendix D.) 

1 ". , , , , ' , , I 12' , , , I I I I I I,' • I , 1.1 I I I I .. ' , I • I • I • I b I I • I I • I I I I. I I I , I • I I t I • I •• I I • I I I' , I I I 
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Verticil Scrolling 

To scrol I the text on the screen up ind down. 
one line it i time, press SCROLL UP or SCROLL 
~N once for eich line. Pressing SCROLL UP or 
SCROLL DO~N continuously scrolls the text up or 
down progressively in one-line increments. 

To scrol I the text in screen-sized increments, 
press SHIFT whi Ie pressing SCROLL UP or SCROLL 
oOlm. 

Figure 3-1. Word Processor Screen. 
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At the start of a word processing session, when 
the Word Processor is first invoked and no 
document has been opened, the screen contains 
the ruler display and the Documents command form. 
At this time a document can be opened by pressing 
the letter "0". If a newly created document has 
been opened, the screen contains the ruler 
display and the document status line. The main 
text area is blank and contains the cursor. (See 
"Invoking the Word Processor through the 
Executive" and "Opening a Document through the 
Word Processor" in Section 4.) 

If an existing document has been opened, the 
screen contains the ruler displ~y, document 
status line, and the first page of text. 

RULER DISPLAY 

The ruler display, shown in Figure 3-2, is at the 
top of the screen and is used for setting 
paragraph indents and tab stops. It is divided 
into units that correspond to the columns of 
text. It is scaled with long ticks at half-inch 
or one-third inch intervals and short ticks 
elsewhere. A "shadow cursor" within the ruler 
indicates the horizontal position of the cursor 
elsewhere on the screen. 

Paragraph indents and tab stops for the current 
line of text are indicated on the ruler display 
by the symbols shown in Table 3-1 below. 

DOCUMENT STATUS LINE 
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The document status line is the highlighted strip 
just above the text area. It shows the name of 
the current document, the number of the page on 
the screen, and the number of the line at which 
the cursor is positioned. "This information is 
updated as the cursor is moved within the 
document. 
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Figure 3-2. Ruler Display. 

Table 3-1. Ruler Display Symbols. 

Symbol Description 

First line paragraph indent 

Left paragraph indent 

L 

R 

C 

D 

Right paragraph indent 

Left-aligned tab 

Right-aligned tab 

Centered tab 

Decimal tab 

Leader dots 

3-3 



CURSOR 

WINDOWS 
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The cursor is the movable blinking underline on 
the screen that indicates where the next 
character can be entered. The cursor moves 
automatically as text is entered and edited. Use 
the cursor control keys to move the cursor to any 
point on the screen. (See "Moving within the 
Document" in Section 4 for instructions on using 
these keys.) 

A window is a part of a document that is 
currently displayed on the screen. The content 
of the window changes as text is entered or 
edited. 

You can shift the content of the current window 
by using the NEXT PAGE, PREV PAGE, or SCROLL UP 
and SCROLL DOWN keys. 

Press NEXT PAGE to shift the next page of text 
into the current window. Press PREV PAGE to 
shift the previous page of text into the current 
window. 

Press SCROLL UP or SCROLL DOWN to move the text 
up or down one line at a time. Continuously 
press SCROLL UP or SCROLL DOWN to quickly scroll 
the text up or down in one-line increments. 

To scroll the text in screen-sized increments, 
press SHIFT together with SCROLL UP or SCROLL 
DOWN. 

One or more sections of the same document 
together with one or more sections of a different 
document can be viewed on the screen at the same 
time. (See "Multiple Windows in a Single 
Document" and "Multiple Documents on a Single 
Screen" in Section 5 for descriptions of this 
feature.) 



STATUS MESSAGES AND PROMPTS 

The bottom line of the screen is used for status 
messages and prompts. A status message informs 
you of a particular occurrence within the system. 
(See Appendix A.) A prompt gUides you through 
certain procedures. For example, when you use the 
Finish command to finish a document, the prompt 

Press GO to confirm FINISH, or CANCEL to cancel 
the command 

appears to tell you to confirm the command. 
Press GO, and the message 

Saving .... 

appears as well as a row of empty boxes. As the 
boxes are filled in, it indicates what percentage 
of the save has been done so far. 
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GENERAL 

SECTION 4 

BASIC OPERATIONS 

This section describes the operations most 
frequently used in word processing. It discusses 
signing on; opening and closing documents; 
creating and editing documents; moving the 
cursor; formatting characters, paragraphs, and 
pages; hyphenation; printing; and using document 
utilities. 

The commands used during most of these operations 
are summarized in Table 4-1. 
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Command 

Bound 

Breaking 
Required 
Hyphen 

Close Window 

Commands 

Copy 

Date/Time 

Delete 

Discard 
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Table 4-1. Summary of Commands. 

Keystroke 

BOUND 

Hyphen 

CODE-c 

COMMANDS (CODE-f7) 

COpy 

CODE-t 

DELETE 

CODE-u 

Description 

Moves the cursor and extends 
the selection to include 
additional characters, 
columns, lines, pages, 
paragraphs, or words. (See 
Mark, Mark tolumn, Mark 
Line, Mark Page, Mark Para, 
and Mark Word.) 

Inserts a standard hyphen 
for phrases that must be 
hyphenated, but can be split 
after a hyphen. 

Closes the current document 
and removes it from the 
screen. 

Invokes the Commands 
function for specifying 
Sort/Select, Merge, Spelling 
Checker, and for accessing 
non-Word Processor 
applications. 

Copies selected text from 
one location in the document 
to another location 
specified by the cursor 
position. 

Displays the current date 
and time at the bottom of 
the screen. 

Deletes a single character 
or a block of characters. 

Discards all edits made in 
the current document since 
the last Finish or Save. 



Table 4-1. Summary of Commands. (Page 2 of 6) 

Command Keystroke 

Discretionary CODE-hyphen 
Hyphen 

Discretionary CODE-spacebar 
Line Break 

Divide Window CODE-d 

Documents 

Finish 

Footer 

Forced Page 

Format 

Go to 
Beginning 

Go to End 

Go to Page 

Header 

DOCUMENTS (CODE-f1) 

FINISH 

FOOTER (SHIFT-fS) 

CODE-NEXT PAGE 

FORMAT (f4) 

CODE-b 

CODE-e 

GO TO PAGE 
(CODE-f6) 

HEADER (fS) 

Description 

Allows a word at the end of 
the line to be split by 
a hyphen. 

Allows a phrase at the end 
of a line to be split. 

Adds another window to the 
current screen. 

Opens, copies, deletes, 
renames documents; changes 
work area; lists document 
directory. 

Finishes a word processing 
session by saving all edits 
and closing all documents. 

Specifies the text that 
appears at the bottom of 
each printed page. 

Forces a new page to begin. 

Invokes the Format command 
for specifying character, 
line, and page formats. 

Moves the cursor to the be­
ginning of the document. 

Moves the cursor to the end 
of the document. 

Shifts a specific page into 
the current window and 
places the cursor at the 
beginning of the page. 

Specifies the text that 
appears at the top of each 
printed page. 
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Table 4-1. Summary of Commands. (Page 3 of 6) 

Command 

Help 

Insert 
Hexadecimal 

Insert 
Literal 

Locate 

Mark 

Mark Column 

Mark 
Document 

Mark Line 

Mark Page 

Mark 
Paragraph 

Mark Word 

4-4 

Keystroke 

HELP 

CODE-i 

CODE-' or 
CODE-SHIFT-' 

CODE-l 

MARK 

MARK COLUMN 
(CODE-f9) 

MARK DOC (CODE-flO) 

MARK LINE (f9) 

MARK PAGE (CODE-f8) 

MARK PARA (flO) 

MARK WORD (f8) 

Description 

Displays a list of command 
names and keystrokes. 

Inserts a hexadecimal char­
acter in the text. 

Inserts a literal character 
in the text. 

Shifts the text containing 
the cursor or the selection 
to the center of the current 
window. 

Selects and highlights the 
character at the cursor 
position. 

Selects and highlights the 
column in which the cursor 
is positioned. 

Selects and highlights the 
entire document in which the 
cursor is positioned. 

Selects and highlights the 
line in which the cursor is 
positioned. 

Selects and highlights the 
page in which the cursor is 
positioned. 

Selects and highlights the 
paragraph in which the 
cursor is positioned. 

Selects and highlights the 
word at the cursor position. 



Table 4-1. Summary of Commands. (Page 4 of 6) 

Command 

Move 

Nonbreaking 
Hyphen 

Nonbreaking 
Space 

Open Document 

Outline 
Indent 

Page Number 

Page Number 
(Roman) 

Paragraph 
Indent 

Point of 
Last Edit 

Print 

Printer 
Status 

Recall Phrase 

Keystroke 

MOVE 

CODE-SHIFT-hyphen 

CODE-SHIFT-spacebar 

CODE-o 

CODE-TAB 

PAGE II (CODE-fS) 

PAGE II 
(CODE-SHIFT-fS) 

INDENT (CODE-f3) 

POINT OF LAST EDIT 
(CODE-f2) 

PRINT (SHIFT-f4) 

CODE-p 

RECALL PHRASE (f7) 

Description 

Moves selected text to the 
current cursor position and 
deletes the text from the 
original location. 

Keeps a hyphenated expres­
sion together on one line, 
rather than breaking it at a 
hyphen. 

Keeps a phrase together 
on one line, rather than 
breaking it at a space. 

Opens an existing document 
or creates a ~ew one. 

Moves left indent forward 
to the next tab stop. 

Enters a page number symbol 
into a header or footer. The 
symbol is replaced with the 
actual page number during 
printing. 

Enters a Roman page number 
symbol into a header or 
footer. The symbol is re­
placed with the actual Roman 
page number during printing. 

Sets right and left para­
graph indents, and first 
line and other line 
indents. 

Positions the cursor to the 
last editing point within 
the document. 

Prints a document. 

Checks the status of a print 
request; allows you to halt, 
resume, cancel printing; 
lists print queue entries. 

Recalls a stored phrase. 
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Table 4-1. Summary of Commands. (Page 5 of 6) 

Command Keystroke 

Recover RECOVER (Executive 
command) 

Redo REDO (f1) 

Remove Format CODE-r 

Replace REPLACE (SHIFT-f6) 

Required CODE-BACKSPACE 
Backspace 

Review REVIEW (CODE-f4) 
Document 

Save CODE-s 

Search SEARCH (f6) 

Store Phrase STORE PHRASE 
(SHIFT-f7) 

Tabs TABS (f3) 

Thumb CODE-A, 1-0 

Total CODE-SHIFT-RETURN 
Unindent 

Undo UNDO (f2) 

Unindent CODE-SHIFT-TAB 
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Description 

Restores any edits that may 
have been lost because of 
power loss or other system 
failure. 

Repeats the last command. 

Removes all formatting from 
the document. 

Replaces old text with new 
text. 

Allows the printing of one 
character over anothe~. 

Checks for hyphenation and 
widows; repaginates the 
current document without 
printing it. 

Saves all edits made during 
a word processing session 
without closing the current 
document. 

Searches through a document 
for specific text. 

Stores a phrase for later 
recall. 

Sets and clears tabs for 
columnar text. 

Moves the cursor directly to 
a specific position in a 
document. 

Moves the left paragraph 
indent back to the far left 
margin stop. 

Undoes the last editing 
operation. 

Moves the left paragraph 
indent to the previous tab 
stop. 



Table 4-1. Summary of Commands. (Page 6 of 6) 

Command Keystroke 

Visible CODE-v 

Description 

Displays visible represen­
tations of nonprinting char­
acters. 

Word Backspace CODE-w Backspaces and deletes the 
word to the left of the 
cursor position. 

Zoom CODE-z On a B 22 workstation, 
switches the screen between 
80 characters to a line and 
132 characters to a line. 

COMMANDS 

A command is invoked when a key or a combination 
of keys (with or without the CODE or SHIFT key) 
is pressed. When you invoke most commands, a 
form or menu appears at the bottom of the screen 
and temporarily overlays the text. Certain 
commands cause a brief prompt to appear at the 
bottom of the screen. The differences among 
forms, menus, and prompts are described below. 

For example, Figure 4-1 shows the Replace form. 

REPLACE: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Search for: 
Replace with: 
ChecK caps? Yes 
Confirm each? Yes 

No 
No 

(Press Y or N) 
(Press Y or N) 

Figure 4-1. Example of a Form. 
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The first line gives the name of the form and 
tells which actions to perform in this operation. 
Pressing GO executes the operation, pressing NEXT 
moves the highlight from item to item, and pres­
sing CANCEL stops the operation. 

The highlighted (reverse video) areas in the form 
accent the places where you either enter text or 
choose an option. In the above example, enter 
the string of text to be searched for, press 
NEXT, and then enter the text that will replace 
the searched-for text when it is found. 

The "Check caps" and "Confirm each" options give 
you the choice of whether or not to use them. 
When you press Y or N, the highlight over the 
"Yes" or "No" becomes brighter. 

After you have completed the form, press GO to 
execute the operation. 

When a form appears on the screen, the cursor is 
at the first position of the first item to be 
filled in or chosen. The cursor moves back to 
the text area when the operation is completed, 
and the form goes away. 

A form can contain default values. Default 
values appear in full brightness; other choices 
are displayed in half-brightness. If you want 
the default values to remain, there are two ways 
to bypass them. You can bypass them by pressing 
the NEXT key to go to the next item; or, if the 
default values of the rest of the options on the 
form are to remain, press GO. For example, in 
the Replace form, if you do not wish to choose 
"Check caps" or "Confirm each" and the default is 
shown to be "No", fill in the "Search for" and 
"Replace with" items and press GO. 

PARAGRAPH INDENT: (press CANCEL to dismiss) 

Move cursor to desired indent position, then: 

Press L to set Left indent 
R Right indent 
F First line indent only 
o Other lines 

Figure 4-2. Example of a Menu. 



A menu offers one choice among a set of options. 
The Paragraph Indent menu in Figure 4-2 gives you 
a choice of options that are represented by 
various keys. 

In the above menu, you press the letter that 
represents the type of paragraph indent you 
need. This action sets the paragraph indent and 
causes the menu to leave the screen. 

When a menu appears on the screen, the cursor 
remains within the text area. 

A prompt offers no choices and requires no input. 
A prompt is a brief message that simply tells you 
what further steps are needed to execute the 
command that was just invoked. The Move prompt in 
Figure 4-3 tells you what to do to execute the 
Move command. 

MOVE: (Press GO to execute, CANCEL to dismiss) 

Select text to be moved, then press GO to execute 

Figure 4-3. Example of a Prompt. 

When a prompt appears on the screen, the cursor 
remains within the text area. 
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STARTING A WORD PROCESSING SESSION 
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You can invoke the Word Processor with or without 
using the Executive, depending on how your system 
is configured. Procedures for invoking the Word 
Processor by either method are described here. 
Figure 4-4 further. illustrates how the Word 
Processor is invoked. 

Sign On 
Display 

1 Sign On to 
Executive 

Executive 

1 WRITEone command 
(with document name) 

Word 
Processor 

I 

Sign On 
Display 

Sign On dl rectly 
to Word 
Processor 

Word 
Processor 

Open doc ument 
ments with Docu 

or Open 
Document 
command 

Document 

Figure 4-4. Invoking the Word Processor. 



Signing On to the Executive 

Selection 

Password 

Day/Date/Time 

Selection 
Password 

When the system is initialized, the first form to 
appear on the screen is the Signon form. At this 
point, the screen looks like Figure 4-5. 

(Current day/date/time shown here) 

BURROUGHS B 20 OPERATING SYSTEM BTOS n,n 

Enter an application name or leave this line blank 
to display a Command form. 

Enter your assigned password (optional). 

Enter the current day, date and time (if not already set). 

then pres$the GO 

Day/Date/Time (e.g., Mon 6/21/82 8:00 am) 

Figure 4-5. Sign On Form. 

The Sign On form is used to gain access to the Burroughs system 
by entering a user identification and password. (Whether or not 
a password is required depends on the installation.) A user name 
is required when using the word processor on mUltiple 
workstations. An error "There is alreay a user named" occurs 
when more than one user starts a word processing session using 
the same user name. Therefore, four user names have already been 
established during the installation of the B 20 Executive 
WRITEone word processing system. They are as follows: WRITE!, 
WRITE2, WRITE3, and WRITE4. These user names have been set up so 
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the word processor is invoked immediately. In addition, the PATH 
is automatically set to a corresponding [SYS]<WRITEn> directory 
so that all documents saved during a word processing session will 
be saved under this directory. If it is desired to change the 
names of these four user names or to add new user names refer to 
the section titled "Changing or Adding User Names with the Word 
Processor" below. 
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To sign on to the system: 

1. Obtain a user name and password (if 
necessary) from the system administrator at 
your installation or use one of the four user 
names which have been established during the 
installation of the B 20 Executive WRITEone 
word processing system. 

2. Enter your user name in the highlight next to 
"Selection". 

3. If you are not entering a password or 
changing the date and time, skip steps 4 and 
5 and press GO. I 

4. If it is necessary to enter a password: 

a. Press NEXT to move the highlight to 
"Password". 

b. Enter the password. 

5. If you wish to change the day/date/time: 

a. Press NEXT to move the highlight to 
"Day/Date/Time". 

b. Enter day/date/time, using the form 
"Mon 1/18/82 10:00 am". 

6'. Press GO. 

At this point, one of two things can happen 
(determined by your user profile). If the system 
administrator has specified that you use only the 
Word Processor, the Word Processor is invoked 
immediately. (See "Invoking the Word Processor 
without the Executive," below.) If you use other 
programs in addition to the Word Processor, the 
Executive is invoked and can then be used to 
invoke the Word Processor. (See "Invoking the 
Word Processor through the Executive," below.) 



CHANGING ORADDING USER NAMES WITH THE 
WORD PROCESSOR 

Changing User Names 

To change the names of the .user files while in 
the Word Processor, do the following: 

1. Press the CODE key and the f1 key at the same 
time. 

2. Press R for Rename document and the following 
form will be displayed. Fill it in as 
follows: 

RENAME DOCUMENT 

Old document name: 
New document name: 
Password: 

Press the Go key. 

[sys]<sys>Write1.user 
[sys]<sys>Jane.user 
(optional) 

When the DOCUMENTS menu appears again, the user 
can change the directory that the user gets 
logged into as signon time by: 

3. Pressing 0 to Open the new document. The 
following form will be displaye? Fill it in 
as f.ollows: 

OPEN DOCUMENT 

Document name: '[sys]<sys>Jane.user 
Password: (optional) 
Allow changes: ~es 
Copy from document: 

Press the GO key. 

The Jane.user file will then be displayed. Move 
the cursor to the entry :SignOnDirectory: and 
position the cursor at the beginning of Writel. 
Press the DELETE key to delete Writel and then 
type Jane for the new entry. Press the FINISH 
key to save the document and go into Command mode 

(the Executive). Before using this new .user 
file, the user should create a new directory 
because it does not exist yet on the system. This 
is done in Command mode with the CREATE DIRECTORY 
command as shown below: 
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CREATE DIRECTORY 

New directory name Jane 
[Default protection level] 15 

Press the GO key. 

Adding User Names 

To add additional .user files while in the Word 
Processor. pr.ess the CODE key and fl at the same 
time. Press C for Copy document, and the 
following form will be displayed. Fill it in as 
follows: 

COPY DOCUMENT 

Old document name: 
New document name: 
Password: 

Press the GO key. 

[sys]<sys>Jane.user 
[sys]<sys>John.user 
(optional) 

Again, to change the directory, follow the 
instructions mentioned above under the heading 
CHANGING USER NAMES WITH WORD PROCESSOR. 

Invoking the Word Processor Without the Executive 
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When you have entered the proper user name for 
invoking the Word Processor without going through 
the Executive, the Word Processor is immediately 
invoked. The following message appears on the 
screen: 

.Would you like to display the same documents as 
in your last session? Press GO to confirm, 
CANCEL to start a new session. 

If you press GO, the Word Processor opens the 
document that you were working on at the end of 
the previous word processing session. The cursor 
is in the same position in the document as it was 
before, so you can easily continue from where you 
left off. 



If you want to open a new document or a document 
other than the one you were working on at the end 
of the previous word processing session, press 
CANCEL. The message goes away and the Documents 
menu appears, as shown in Figure 4-6. 

DOCUMENTS: (press FINISH to exit Word Processor) 

Press 0 to Open document Press W to change Work area 
D Delete document L List documents 
C Copy document 
R Rename document 

Figure 4-6. Documents Menu (#1). 

You can now open a new or existing document. 
(See "Opening a Document through the Word 
Processor," below.) 

Invoking the Word Processor Through the Executive 

When you have entered the proper user name for 
invoking the Executive, the screen changes to 
look like Figure 4-7. 

o Enter "WRITEone" in the highlight next 
to "Command". 

You now have the choice of opening a document 
through the Executive or through the Word 
Processor. (See "Opening a Document through the 
Word Processor," below.) 

To open a document through the Executive: 

1. Press RETURN to move the highlight to 
"Document(s)". 
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Selection 

Password 

Day/Date/Time 

Selection 
Password 

(Current day/date/time shown here) 

.... "'" 

Enter an application name or leave this line blank 
to displav a Command form. 

Enter your assigned password (optional). 

Enter the current day, date and time (if not already setl. 

~~~~;GO~t~ 

1-
Day/Date/Time (e.g., Mon 6/21/82 8:00 am) 

Command 

Figure 4-'. Executive Command Form. 

2. Enter the document name. 

3. Press GO. 

If an existing document is opened, the Word 
Processor is invoked, and the screen changes to 
show the first page of text. 

If the document is new, the following blinking 
message appears: 

Press GO to create document X, CANCEL to cancel 
command. 



In this case, press GO again to open the 
document. The Word Processor is invoked and the 
screen changes to show the ruler display and a 
blank text area. 

If you want to open a document through the Word 
Processor: 

o Press GO after entering "WRITEone" in 
the highlight next to "Command". 

The Word Processor is invoked, and the screen 
shows the ruler display and the Documents menu. 
Now, follow the procedures below to open a 
document. 

Opening a Document Through the Word Processor 

The Documents menu, shown in Figure 4-6, has many 
options. However, the only one you need here is 
the "Open Document" option. "Open Document" 
allows you to open an existing document or create 
a new one. 

You invoke the "Open Document" option by pressing 
O. The Open Document form appears on the 
screen. (See Figure 4-8.) "Open Document" has 
several options for you to choose when you are 
opening an existing document or creating a new 
document. 

The "Password" option allows you to specify a 
password, if necessary. (For information on 
passwords, see the B 20 Software Operation 
Guide, section 8, "Establishing Security".) 

The "Allow changes" option allows you to specify 
whether or not changes can be made to the 
document while it is open during a particular 
session. This option has a default value of 
"Yes" because you usually open a document to make 
changes to it. However, there are times when you 
want to specify "No" for "Allow changes". 
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For example, if you want only to look at a 
document and make sure that it can't be changed 
(such as a letter being inserted if you 
accidentally press a key), specify "No" for 
"Allow changes". If other users in your cluster 
want to look at your document at their 
workstations at the same time you are looking at 
it, specify "No" for "Allow changes". 

The value you specify for "Allow changes" is only 
in effect for the current word processing 
session. 
You can use the "Copy from document" option if 
you are going to create the document by copying a 
document that already exists. If you do copy an 
existing document, be sure to give the new 
document a different name. 

To open a document with the Documents menu: 

1. Press 0 to Open document. 

2. The Open Document form appears, as shown in 
Figure 4-8. 

OPEN DOCUMENT: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Document name: 
Password: 
Allow changes? Yes No (Press Y or N) 
Copy from document: 

Figure 4-8. Open Document Form. 

3. Enter the name of the document. (It must not 
contain more than 46 alphanumeric char­
acters.) 

4. If you must enter a password: 

a. Press NEXT to move the highlight to "Pass 
word". (For information on passwords, see 
the B 20 Software Operation Guide, 
section 8, "Establishing Security".) 

b. Enter the password. 



5. If the document should not be changed during 
this word processing session or is to be 
viewed by more than one user in your cluster: 

a. Press NEXT to move the highlight to "Allow 
changes". 

b. Press N. 

·6. If the document can be changed: 

a. Press GO, or 

b. Move the highlight to "Copy from 
Document". 

7. If the document is to be copied from another 
document, enter the name of the document that 
is being copied. 

8. When the form is completed, press GO. The 
Open Document form goes away and the first 
page of the opened document appears on the 
screen. 

If you specified a new document, the following 
message appears: 

Press GO to create document X, CANCEL to 
cancel command. 

Press GO again to confirm. The message goes 
away, and the new document opens. 

If you press GO before you enter the document 
name, the following message appears: 

Please fill in "Document Name" 

Enter the document name and press GO again. 

You can open a document with the Documents menu 
at any time during a word processing session. 
For instructions on invoking the Documents 
command, see the "Document Utilities" subsection 
below. 
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Help Command 

The Help command, which you invoke by pressing 
HELP on the control pad, displays an alphabetical 
listing of every command used in the Word 
Processor. This listing also describes each 
command and tells which keystrokes are used to 
invoke it. 

Date/Time Command 
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The Date/Time command, which you invoke by 
pressing CODE-t, displays the current date and 
time at the bottom of the screen. Figure 4-9 
shows the date and time message. 

DATE AND TIME: (Press CANCEL to dismiss) 

The time is now 2:23 PM on Wednesday, October 27, 1982. 

Figure 4-9. Date/Time Message. 

The date and time message remains on the screen 
until you press CANCEL, or until it is replaced 
by a menu or form. The message is continuously 
updated as it is displayed. 



ENTERING A NEW DOCUMENT 

Entering Text 

Enter text as you would enter text on a 
typewriter. Simply type the characters from the 
typewriter pad of the keyboard. You can format 
text, paragraphs, and pages as you enter them. 
(See "Character Formatting," "Paragraph For 
matting," and "Page Formatting," below.) 

As text is entered and the end of a line is 
reached, the text automatically wraps to the next 
line. Press the RETURN key only when you reach 
the end of a paragraph and want to begin a new 
paragraph with the next sentence. 

To end a line or sentence without ending a 
paragraph and before the text wraps around to the 
next line, press SHIFT-RETURN. For example, 
press SHIFT-RETURN when typing the lines of a 
table to use the same paragraph or indent format 
for the entire table. 

NOTE 

It is recommended that SHIFT-RETURN be used 
instead of the RETURN key whenever blank lines 
are needed to separate groups of text. If this 
is done then the performance of WRITEone will be 
improved. 

Text is entered with the keyboard in either 
insert mode or overtype mode. The keyboard is 
normally in insert mode. When the keyboard is in 
insert mode, anything you type into existing text 
causes the typed text to be inserted just before 
the cursor. None of the existing text is 
deleted. The cursor, and any characters to the 
right of it, move to the right. 

To change the keyboard to overtype mode, press 
the OVERTYPE key. The light on the key turns 
on. When the keyboard is in overtype mode, any 
thing you type into existing text replaces that 
text. 

To end overtype mode and return to insert mode, 
press OVERTYPE again. The light on the key now 
turns off. 
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Correcting Text 

Deleting Text 

You may want to change or correct the text that 
you just entered. See "Moving within the Docu­
ment," below, for instructions on using the cur­
sor control keys to move the cursor to the text 
that needs revisio~. Follow the procedures 
described here to make the changes. 

To delete the single character at the cursor 
position, press the DELETE key. DELETE, pressed 
continuously, deletes characters as the cursor 
moves forward through the text. You also can 
delete words, lines, paragraphs, or pages by 
first selecting them (see "Selections," below) 
and then pressing DELETE. 

In insert mode, you can delete a character to the 
left of the cursor position by pressing the 
BACKSPACE key. BACKSPACE moves the cursor one 
position to the left and deletes the character in 
that position. Pressing BACKSPACE when the 
cursor is at the left margin of a line moves the 
cursor to the last character of the preceding 
line and deletes that character. Pressing 
BACKSPACE when the cursor is at the left margin 
of the top line of the screen deletes the last 
character of the preceding line and scrolls the 
text down one line. 

You also can use BACKSPACE to delete a blank 
line. For example, if you inserted some blank 
lines between paragraphs using SHIFT-RETURN, and 
you want to delete one of the lines, move the 
cursor to any position in that blank line and 
press BACKSPACE. The blank line is deleted. 

Deleting a Single Word 
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The Word Backspace command, which you invoke by 
pressing CODE-w, allows you to delete the word or 
part of the word to the left of the cursor 
position. For example, suppose you are typing the 
phrase 

For this type of computer 

and just as you finish typing "computer," you 
decide to change "computer" to "workstation." 



Inserting Text 

Simply press CODE-w. "Computer" is deleted and 
you can now type "workstation" in its place. 

Word Backspace is similar to backspacing, in that 
it deletes the characters to the left of the 
cursor position. Consequently, if the cursor is 
at the last letter of the word you want to delete 
and you press CODE-w, all the letters of that 
word except the last letter are deleted. Hence, 
to delete the entire word, make sure the cursor 
is in the space to the right of the word before 
you press CODE-w. 

This caution also applies to deleting a word 
anywhere in the text. Remember to move the 
cursor to the space to the right of the word 
before you delete that word. 

Word Backspace deletes only in insert mode. If 
you press CODE-w when the OVERTYPE light is on, 
the cursor simply backspaces to the first 
character of the word it is in. No characters 
are deleted. 

To insert new text in a document (insert mode), 
move the cursor to the place in the text where 
you want to make the insertion. Type the new 
text. The typed characters are inserted just 
before the cursor. The cursor, and any 
characters on the line to the right of it, move 
to the right. 

As characters are inserted, the line becomes 
longer, and text automatically wraps around to 
the next line. 

Inserting a character at the right margin of a 
line moves the cursor to the left margin of the 
next line. Inserting a character at the right 
edge of the bottom line of the current window 
moves the cursor to the left margin of the next 
line and scrolls the text up one line. 

If you insert text into a blank area on a line 
that contains some text, the inserted text (and 
the cursor) move back to the previous text. 
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Overtyping 

To replace, rather than insert, text in a 
document (overtype mode), press the OVERTYPE 
key. (The light on the key turns on.) You now 
can move the cursor to any position in the text 
and type characters exactly as before, but every 
character typed replaces the existing one (if 
any) at the cursor position. End over type mode 
and return to insert mode by pressing OVERTYPE 
again~ (The light on the key turns off.) 

During overtype mode, the BACKSPACE key behaves 
as does the backspace key on a typewriter. Press 
BACKSPACE to backspace to any text that needs to 
be replaced. (No characters are deleted.) 

Req u i red Backspace 
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The Required Backspace command, which you invoke 
by pressing CODE-BACKSPACE, allows you to type 
one character over another. For example, you can 
enter a not-equal sign (~) or a plus/minus sign 
(~). On the ~creen, only one character appears 
(such as the / of the ~). However, both charac­
ters are printed. (See "Special Characters" for 
a description of what appears on the screen when 
Required Backspace is invoked and the Visible 
command is in effect.) 

The following steps show how to enter a not-equal 
sign (~): 

1. 

2. 

3. 

4. 

Type = (equal sign). 

Press CODE-BACKSPACE. The cursor moves one 
position to the left and the = disappears 
from the screen (but not from memory). 

Type / (slash). 

The / remains on the screen. 

When the text is printed, the not-equal sign (~) 
will appear. 



Saving a Document 

The Save command, which you invoke by pressing 
CODE-s, saves the documents that are opened and 
worked on any time during an editing session 
without exiting the Word Processor. This command 
saves all operations performed in that session. 

When this command is invoked, a row of empty 
boxes will be displayed. As the operation 
proceeds, the boxes will be filled in in 
proportion to the progress that has been made in 
completing the save. 

Use of this command is optional. Documents are 
saved automatically when FINISH is pressed. 
However, periodic saving of your document is 
recommended because it shortens 
recovery time and improves performance. 

Occasionally, when memory gets low (as after a 
complicated Search and Replace operation), the 
Word Processor reminds you to save your documents 
with the message "Memory low. Please save." This 
will be displayed when memory is just starting to 
become low. If a save isn't done at this point 
and the user continues the word processing 
session, performance of the word processor will 
be reduced .. Another message will then be 
displayed, "Memory very low. Please save", 
indicating the memory situation is more serious. 
Performance will be further reduced, and certain 
operations, such as large replacements, may not 
have enough free memory left to execute 
successfully. If a save still isn't done then 
the message, "Memory extremely low. Please save", 
is displayed indicating the memory situation has 
reached a crisis state. If a save is not 
executed immediately, any operation may cause the 
word processor to fail due to lack of memory. 

The user should never let the word processor come 
to this point and it is recommended that a save 
be done when the first message is displayed. In 
fact the user should not wait for this message to 
appear before doing a save. They should try to 
do periodic saves to prevent this message from 
ever having to be displayed. This will improve 
the performance of the word processor and prevent 
any operations from not being performed 
completely. 
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Finishing a Document 

At the completion of a word processing session, 
press the FINISH key. FINISH saves all text 
entered and edited during the session. When you 
press FINISH, the following message appears: 

Press GO to confirm FINISH, CANCEL to cancel 
command 

When GO is pressed, the word processor will 
display a row of empty boxes. As the operation 
proceeds, the boxes will be filled in in 
proportion to the progress that has been made in 
completing the FINISH. 

When FINISH has been completed and the document 
has been saved, the word processing session 
ends. 

OPENING A DOCUMENT 
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There are two ways to open a document during a 
word processing session. You can use the 
Documents command (described below in the 
"Document Utilities" subsection) or the Open 
Document command (described below) to open an 
existing document or to create a new one. 

The Open Document command, which you invoke by 
pres~ing CODE-o, allows you to open a new or 
existing document at any time during a word 
processing session. (See Figure 4-10.) 

The "Password" option allows you to specify a 
password, if necessary. (For information on 
passwords, see the B 20 Software Operation Guide, 
section 8, "Establishing Security".) 

The "Allow changes" option allows you to specify 
whether or not changes can be made to the 
document while it is open during a particular 
session. This option has a default value of 
"Yes", because you will usually open a file to 
make changes to it. However, there are times 
when you want to specify "No" for "Allow 
changes". 



For example, if you want only to look at a 
document and make sure that it can't be changed 
(such as a letter being inserted if you accident 
ally press a key), specify "No" for "Allow 
changes". If other users in your cluster want to 
look at your document at their workstations at 
the same time you are looking at it, specify "No" 
for "Allow changes". 

The value you specify for "Allow changes" is only 
in effect for the current word processing 
session. 

You can use the "Copy from document" option if 
you are going to create the document by copying a 
document that already exists. If you do copy an 
existing document, be sure to give the new 
document a different name. 

To open a document with the Open Document 
command: 

1. Press CODE-o. The Open Document form, shown 
in Figure 4-10, appears on the screen. 

2. Enter the name of the document. (It must not 
contain more than 46 alphanumeric charac­
ters.) 

3. If you must enter a password: 

a. Press NEXT to move the highlight to 
"Password". 

b. Enter the password. 

OPEN DOCUMENT: (press GO to execute, NEXT for next item, CANCEL to dismiss) 

Document name: 
Password: 
Allow changes? Yes No (Press Y or N) 
Copy from document: 

Figure 4-10. Open Document Form. 
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4. If the document should not be changed during 
this word processing session or is to be 
viewed by more than one user in your cluster: 

a. Press NEXT to move the highlight to "Allow 
changes". 

b .. Press N. 

5. If the document can be changed, 

a. Press GO, or 

b. Move the highlight to "Copy from 
document". 

6. If the document is to be copied from another 
document, enter the name of the document that 
is being copied. 

7. When the form is completed, press GO. The 
form goes away and the first page of the 
opened document appears on the screen. 

If you specified a new docum~nt, the following 
message appears: 

Press GO to create document X, CANCEL to cancel 
command 

Press GO again to confirm. The message goes 
away, and the new document opens. 

If you press GO before you enter the document 
name, the following message appears: 

Please fill in "Document Name" 

Enter the document name and press GO again. 

If you entered the name of a document that is 
already open, the following message appears: 

Document X is already open 

Enter another document name and press GO. 



MOVING WITHIN THE DOCUMENT 

Vertical Scrolling 

There are many ways to move the cursor to 
specific areas within a document. You can use 
the SCROLL keys, cursor control keys, NEXT PAGE, 
and PREV PAGE. The Go to Page, Go to Beginning, 
and Go to End commands move the cursor to 
specific areas. You can also use the Search 
command to position the cursor at specific 
text. (See "Searching for Text," below.) 

To scroll the text on the screeri up and down, one 
line at a time, press SCROLL UP or SCROLL DOWN 
once for each line. Pressing SCROLL UP or SCROLL 
DOWN continuously scrolls the text up or down 
progressively in one-line increments. 

To scroll the text in screen-sized increments, 
press SHIFT while pressing SCROLL UP or SCROLL 
DOWN. 

Horizontal Scrolling 

To scroll the text horizontally on the screen, 
use the right or left arrow cursor control key. 
To view the right portion of the screen and shift 
its content to the f?r left, press the right 
arrow key continuously. When the cursor reaches 
the right margin, the text shifts to the left and 
the leftmost text disappears. The ruler display 
also shifts to the left. To view the left 
portion of the screen and shift its content to 
the far right, press the left arrow key 
continuously. When the cursor reaches the left 
margin, the text shifts to the right along with 
the ruler display. 

Cursor Control Keys 

You can use the cursor control keys to move the 
cursor around the screen manually. These keys 
are used by themselves or in combination with 
SHIFT and CODE. The following descriptions 
pertain to cursor movement within a single 
window. (For descriptions of how these keys work 
in multiple windows and documents, see "Multiple 
Windows in a Single Document" in Section 5, 
"Advanced Operations.") 
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Up Arrow ( t ). 

Down Arrow ( ~ ) 

The up arrow key ( i ) moves the cursor upward 
one line at a time. If the cursor is at the top 
of the window, it remains there. 

SHIFT-up arrow moves the cursor upward in 
increments of several lines. 

CODE-up arrow moves the cursor to the top of the 
window in which it is positioned. If the cursor 
is already at the top of the window, it is moved 
into the top of the next window. 

The down arrow key ( ~ ) moves the cursor down 
ward one line at a time. If the cursor is at the 
bottom of the window, it remains there. 

SHIFT-down arrow moves the cursor downward in 
increments of several lines. 

CODE-down arrow moves the cursor to the bottom of 
the window in which it is positioned. If the 
cursor is already at the bottom of the window, it 
is moved into the next window. 

Left Arrow (+-) 

The left arrow key (+- ) moves the cursor one 
position to the left. 

SHIFT-left arrow moves the cursor to the left in 
increments of several characters. 

CODE-left arrow moves the cursor to the beginning 
of the current line. 

Right Arrow (- ) 
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The right arrow key (- ) moves the cursor one 
position to the right. 

SHIFT-right arrow moves the cursor to the right 
in increments of several characters. 

CODE-right arrow moves the cursor to the end of 
the current line. 



Moving to the Next Page or to the Previous Page 

Two keys change the page in the current window. 
NEXT PAGE shifts the next page of text into the 
current window. PREV PAGE shifts the previous 
page of text into the current window: The cursor 
remains at the same relative position within the 
newly displayed page. 

Moving to a Specific Page 

The Go to Page command shifts a specific page in 
the document to the current window. The Go to 
Page command, which you invoke by pressing CODE­
f6, displays the Go to Page form shown in Figure 
4-11. 

GO TO PAGE: (Press GO to execute, CANCEL to dismiss) 

Page number: 

Figure 4-11. Go to Page Form. 

To shift a specific page into the current window: 

1. Press GO TO PAGE (CODE-f6). The Go to Page 
form appears, with the cursor next to "Page 
number". 

2. Type the number of the page you want. 

3. ·Press GO. 

The specified page appears on the screen with the 
cursor at the beginning of the first line of 
text. 
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Moving to the Beginning or End of the Document 

The Go to Beginning command moves the cursor to 
the first character on the first line of text in 
the document. Invoke this command by pressing 
CODE-b. The Go to End command moves the cursor 
to the last text character in the document. 
Invoke this command by pressing CODE-e. 

EDITING A DOCUMENT 

Selections 

A selection is a contiguous block of characters 
that has been chosen for a particular 
operation. When selected, these characters are 
highlighted on the screen. A selection can 
consist of one or more characters, spaces, words, 
columns, lines, paragraphs, pages, or an entire 
document. Making a selection is the easiest way 
to format, move, copy, or delete blocks of text. 

Making a Selection 
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Selections are made with any of the Mark com­
mands. The seven MARK keys on the keyboard 
represent commands with those same names. These 
keys are 

0 MARK 

0 MARK WORD (fS) 

0 MARK PAGE (CODE-B) 

0 MARK LINE (f9) 

0 MARK COLUMN (CODE-f9) 

0 MARK PARA (flO) 

0 MARK DOC (CODE-flO) 

MARK selects and highlights the character or 
space that contains the cursor, or that is 
nearest to the cursor on the same line. Any text 
character or nonprinting control character (for 
example, carriage return, paragraph symbol) can 
be selected. (Use the Visible command, described 
below under "Special Characters," to see 
nonprinting characters.) 



MARK WORD selects and highlights the word 
containing the cursor. 

MARK LINE selects and highlights the line 
containing the cursor. 

MARK COLUMN selects and highlights the column 
containing the cursor. 

MARK PARA selects and highlights the paragraph 
containing the cursor. 

MARK PAGE selects and highlights the page 
containing the cursor. 

MARK DOC selects and highlights the document 
containing the cursor. 

To make a selection: 

1. Move the cursor to the first character of the 
text you want to select. 

2. Press the appropriate MARK key. 

The selection is highlighted. You can then use 
the selection as needed. 

A selection need not always contain text. For 
example, you can use MARK LINE to select a blank 
line for deletion. 

Figure 4-12 shows a screen containing a selection 
made with the Mark Line and Bound commands. 

Extending a Selection 

To extend a selection, press BOUND. Depending on 
which type of selection is made, BOUND moves the 
cursor and extends the highlight to the next 
space, character, word, line, column, paragraph, 
or page. 

For example, the cursor is positioned in the 
first word of the following text: 

The Word Processing Reference Manual describes 
an interactive word processor. 
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1. Press MARK WORD and the word "The" is 
selected and highlighted. 

2. Press BOUND once. The cursor moves to the 
space following "The" and the highlighted 
selection extends to include that space. 

3. Press BOUND aga~n. The cursor moves to the 
next word ("Word") and it is highlighted and 
added to the selection. 
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Vertical Scrolling 

To scrol I the text in screen-sized increments, 
press SHIFT while pressing SCROLL UP or SCROLL 
DOIo/N. 

Figure 4-12. Example of a Selection. 
You can extend or reduce a selection by many 
characters by moving the cursor to the last 
character to be part of the selection and 
pressing BOUND. The selection is automatically 
extended or reduced to include that cursor 
position. 

You also can change a selection by repeating the 
Mark key that was used to make the selection. 
For example, pressing MARK PARA a second time 
moves the highlight and the cursor downward to 
the next paragraph. Pressing MARK PARA a third 
time again moves the highlight and the cursor to 
the next paragraph, and so on. 



Removing a Selection 

A selection is temporary. It is removed as soon 
as it is used in a procedure, or when another 
selection is made. Alternatively, you can press 
CODE-MARK to remove the highlight and restore the 
text to its normal appearance. 

Deleting Selected Text 

Moving Text 

To delete selected text: 

1. Move the cursor into the selection. 

2. Press DELETE. The selected text is deleted. 

There are two ways to move text to any location 
within a document: 

o By first selecting the text to be moved, 
moving the cursor to the position where the 
text is to be placed, and then invoking the 
Move command by pressing MOVE. 

o By moving the cursor to the position where 
the text is to be placed, invoking the Move 
command by pressing MOVE, selecting the text 
to be moved, and then pressing GO. 

To use the first procedure, in which you make the 
selection before pressing MOVE: 

1. Use the appropriate Mark (and Bound) command 
to select the text to be moved. 

2. Move the cursor to the position where you 
want the text to appear. 

3. Press MOVE. The selected text moves to the 
cursor position (and is deleted from its 
original location). 

To use the second procedure, in which you make 
the selection after pressing MOVE: 

1. Move the cursor to the position where you 
want the text to appear. 
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Copying Text 
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2. Press MOVE. The Move prompt, shown in Figure 
4-13, appears on the screen. 

3. Once you have pressed MOVE and the Move 
prompt is displayed, you can move the cursor 
to the beginning of the text to be moved. 
(The Word Processor remembers where the 
cursor was located when MOVE was pressed.) 
Use the appropriate Mark (and Bound) command 
to select the text to be moved. 

4. Press GO. The selected text moves to the 
position where the cursor was located when 
MOVE was pressed (and is deleted from its 
original location). 

MOVE: (Press GO to execute, CANCEL to dismiss) 

Select text to be moved, then press GO to execute 

Figure 4-13. Move Prompt. 

The Copy command works in almost the same way as 
the Move command. There are two'ways to copy 
text to any location within a document: 

o By first selecting the text to be copied, 
moving the cursor to the position where the 
copied text is to be placed, and then 
invoking the Copy command by pressing COPY. 

o By moving the cursor to the position where 
the text is to be placed, invoking the Copy 
command by pressing COPY, selecting the text 
to be copied, and then pressing GO. 



To use the first procedure, in which you make the 
selection before pressing COPY: 

1. Use the appropriate Mark (and Bound) command 
to select the text to be copied. 

2. Move the cursor to the position where you 
want the copied text to appear. 

3. Press COPY. The selected text is copied to 
the cursor position (but is not deleted from 
its original location). 

To use the second procedure, in which you make 
the selection after pressing COPY: 

1. Move the cursor to the position where you 
want the copied text to appear. 

2. Press COPY. The Copy prompt, shown in Figure· 
4-14, appears on the screen. 

COpy: (press GO to execute, CANCEL to dismiss) 

Select text to be copied, then press GO to execute 

Figure 4-14. Copy Prompt. 

3. Once you have pressed COPY and the Copy 
prompt is displayed, you can move the cursor 
to the beginning of the text to be copied. 
(The Word Processor remembers where the 
cursor was located when COPY was pressed.) 
Use the appropriate Mark (and Bound) command 
to select the text to be copied. 

4. Press GO. The selected text is copied to the 
position where the cursor was located when 
COpy was pressed (but is not deleted from its 
original location). 
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You can invoke the Search command to search for a 
string of one or more characters within a 
document. The search starts at the cursor 
position. The Word Processor ignores format 
attributes during a search and searches only for 
alphanumeric characters. For example, if you 
specify a search string that is underlined, the 
underline is ignored and the search is made only 
for the actual text in the string. 

If you specify the "Check caps" option, the 
system searches only for the words that have the 
same uppercase and lowercase characters as does 
the search string. Otherwise, the system 
searches for all characters contained in the 
search string regardless of uppercase and lower­
case characteristics. 

The Search command, which you invoke by pressing 
SEARCH (f6), displays the SEARCH form shown in 
Figure 4-15. 

SEARCH: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Search for: 
Check caps? Yes No (Press Y or N) 

Figure4-1S. Search Form. 

To search for a particular text string, 
regardless of uppercase and lowercase 
characteristics: 

1. Press SEARCH (f6). The Search form appears. 

2. Enter the text string in the highlighted 
area. 

3. Press GO. 



Replacing Text 

To search for a matching uppercase and lowercase 
text string: 

1. Press SEARCH (f6). The Search form appears. 

2. Enter the text string in the highlighted 
area. 

3. Press NEXT to move the highlight to "Check 
caps". 

4. Press Y. 

5. Press GO. 

When you press GO, the message 

Searching ... 

appears at the top of the form. The highlighted 
area in the form goes away. 

When the text is found, the Search form goes 
away. The cursor is positioned at the end of the 
text string, which is now highlighted. To remove 
the highlight, press CODE-MARK. (See "Selec­
tions," above.) 

If the string is not found, the blinking message 

Not found 

appears at the top of the form. The highlighted 
area in the form remains. 

You can use the Replace command to search the 
document for a specific character string and 
replace it with another character string. If no 
selection is made, the system searches the entire 
document for the search string, irrespective of 
the cursor position. However, if a selection has 
been made, the search-and-replacement is made 
only in the selected text. 
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If you specify the "Check caps" option, the Word 
Processor searches for and replaces only the text 
that has the same uppercase and lowercase 
characters as the search string. Otherwise, the 
system searches for and replaces all characters 
contained in the search string, regardless of 
uppercase and lowercase. However, the replace 
ment inherits the uppercase and lowercase charac 
teristics of the replaced text. For example, if 
the search string is "which" and the replacement 
is "that", the Word Processor finds "which" and 
"Which". The replacements inherit both uppercase 
and lowercase characters and become "that" and 
"That". In addition, if at least the first two 
characters of the replaced text are uppercase 
alphabetic, then the replacement will be all 
uppercase. 

If you specify the "Confirm each" option, the 
Word Processor stops at each place where a 
replacement is possible. Press GO to make the 
replacement, press NEXT to continue without 
making the replacement, or press CANCEL to stop 
the replacement. 

Only alphanumeric characters are valid in the 
search-and-replace strings. That is, no 
formatting attributes can be assigned to the 
strings. However, the replacement inherits the 
formatting attributes of the replaced text. For 
example, if the search string is "the" and the 
replacement is "a", the Word Processor finds 
"the", "the", "the", and so on. The replacements 
inherit these format attributes and become "a", 
"a", "a", and so on. 

The Replace command, which you invoke by pressing 
REPLACE (SHIFT-f6), displays the Replace form 
shown in Figure 4-16. The cursor leaves the text 
and goes to the highlight next to "Search for". 

REPLACE: (press GO to execute, NEXT for next item, CANCEL to dismiss) 

Search for: 
Replace with: 
Check caps? Yes 
Confirm each? Yes 

No 
No 

(Press Y or N) 
(Press Y or N) 

Figure 4-16. Replace Form. 



To search for a specific character string and 
replace it with other characters: 

1. Press REPLACE (SHIFT-f6). The Replace form 
appears. 

2. Type the character string to be searched for. 

3. Press NEXT to move the highlight to "Replace 
with". 

4. Type the replacement string. 

S. If the "Check caps" or "Confirm each" option 
is not wanted, press GO. 

6. If the "Check caps" or "Confirm each" option 

a. Press NEXT to move the highlight to either 
option. 

b. Press Y. 

7. Press GO. 

When you press GO, the search begins. The 
message 

Replacing ... 

appears at the top of the form until completion. 

At completion of the search-and-replacement, the 
form goes away and the cursor returns to the text 
area. The following message appears at the 
bottom of the screen, showing the number of 
replacements made: 

3 replacements made 

The next keystroke removes the message. 

If no search string is found, the message 

Not found 

appears at the top of the form. 

To enter another search string, press NEXT to 
move the highlight to "Search for". 
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You can use the Forced Page command to force text 
to start on a new page. For example, suppose you 
are typing text that contains a table. As you 
enter the text, you discover that there is not 
enough room on that page for the entire table. 
You use the Forced Page command to end the page 
just before you start typing the table. This 
procedure allows you to type the table on a new 
page. 

You invoke the Forced Page command by pressing 
CODE-NEXT PAGE. This command indicates the new 
page by inserting a double line of dashes in the 
text where the previous page ended. 

If CODE-NEXT PAGE is pressed when the cursor is 
in the middle of a line of text, the text is 
broken at that point and the double line of 
dashes is inserted. 

To specify a forced page break: 

1. Move the cursor to the position in the text 
where you want the new page to start. 

2. Press CODE-NEXT PAGE. 

3. The double line of dashes is inserted and a 
new page begins. 

To remove the forced page break: 

1. Move the cursor to the double line of dashes. 

2. Press DELETE. 

The Redo command, which you invoke by pressing 
REDO (fl), repeats the previous editing 
operation. For example, if you have just invoked 
the Search command to find some text, use Redo to 
find succeeding occurrences of that text. 

Redo works only if no other operation was per­
formed after the previous editing operation. For 
example, if you just used the Search command, and 
then typed some text into a sentence, pressing 
Redo will not repeat the Search operation. 



Undoing an Edit 

The Undo command, which you invoke by pressing 
UNDO (f2), "undoes" the last editing operation. 

For example, if you just mistakenly deleted a 
selection, press UNDO to restore it. Pressing 
UNDO again deletes the selection again. (It 
"undoes" the Undo.) 

Undo only works if no other operation was 
performed after the previous editing operation. 

Jumping to the Last Edit Point 

TABS 

The Point of Last Edit command , which you invoke 
by pressing POINT OF LAST EDIT (CODE-f2), 
remembers the position in your document where you 
last edited and places the cursor there. 

For example, if you edit at one position, then 
cursor to another position and edit there, 
pressing CODE-f2 will position the cursor back to 
the first editing point. This feature is useful 
if while editing a document you wish to scan or 
alter text at some other position in the document 
and then you want to quickly return to the 
original position to continue editing. 

The word processor actually remembers more than 
just the last editing point, so that multiple 
depressions of CODE-f2 will reposition the cursor 
at each editing point. 

Text, either numeric or alphabetic, can be 
entered and automatically formatted into 
columns. Use the Tabs command to specify the tab 
settings and the type of columnar format. The 
Tabs command, which you invoke by pressing TABS 
(f3), displays the Tabs menu shown in Figure 
4-17. To facilitate the setting of multiple tab 
stops, the TABS menu will remain up when a tab 
stop is set. Any selection present will also· 
remain. To remove the menu and the selection, 
press the CANCEL key. The ruler display at the 
top of the screen is your guide to the location 
of the tab stops. (See "Ruler Display" in 
Section 3, "Screens.") 
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TABS: (Press CANCEL to dismiss) 

Move cursor to desired tab stop, then: 

Press L for 
R 
C 
D 
E 

Left-aligned tab 
Right-aligned tab 
Centered tab 
Decimal tab 
Evenly spaced left-aligned tabs 
leader dots 

Press 0 to clear One tab at cursor position 
A All tabs in current paragraph 

Figure 4-17. Tabs Menu. 

Setti n9 Tabs 
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The Tabs command; which you invoke by pressing 
TABS (f3), includes five types of tabs. 

o Left-aligned tab: text is left-aligned at 
the tab stop. 

o Right-aligned tab: text is right-aligned at 
the tab stop. Note that the data will be 
positioned to the left of the tab stop. 

o Center tab: text is centered at the tab 
stop. 

o Decimal tab: text is aligned under the 
decimal point. 

o Evenly spaced left-aligned tabs: tabs are 
set at evenly spaced intervals across the 
page. 

Leader dots can be specified for any of the above 
tab settings except evenly spaced left-aligned 
tabs. 

You can set evenly spaced left-aligned tabs with 
just one keystroke. This option sets a series of 
tab stops across the ruler display. The space 
between tab stops is determined by the position 
of the first tab stop in relation to the begin­
ning of the ruler. 



For example, if you specify the first tab at the 
one-inch mark on the ruler, the tab stops are 
automatically set at one-inch intervals. Or, if 
you specify the first tab at the one-and-one­
half-inch mark on the ruler, the tab stops are 
automatically set at one-and-one-half-inch 
intervals. 

Tabs can be set to the left or to the right of a 
paragraph indent setting. 

To set tabs: 

1. Press TABS (f3). The Tabs menu appears. 

2. Move the cursor to the desired tab stop on 
the ruler display. 

3. Choose the desired type of tab setting by 
entering the corresponding tab symbol. 

Press L for Left-aligned tab, 
Press R for Right-aligned tab 
Press C for Centered tab 
Press D for Decimal tab 
Press E for Evenly spaced left-aligned tabs 
Press . for leader dots 

4. When you have selected anyone of the above 
tab settings except leader dots, the selected 
tab symbol is displayed at the cursor 
position on the ruler display. Note that the 
Tabs menu is still dfsplayed so that 
additional tabs can be set. When all the 
desired tab stops have been set, press the 
CANCEL key to dismiss the TABS menu. 

If you selected Leader dots, the Leader Dots 
menu, shown in Figure 4-18, appears. 

1. Move the cursor to the desired tab stop on 
the ruler display. 

2. Select the desired type of tab setting with 
leader dots by typing the corresponding tab 
symbol. 

Press L for Left-aligned tab 
Press R for Right-aligned tab 
Press C for Centered tab 
Press D for Decimal tab 
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Clearing Tabs 
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3. The selected tab symbol and leader dots 
appear in the ruler display. The Leader Dots 
menu is still displayed so that addtional 
leader dot tabs can be se.t. When all the 
desired tab stops have been set, press the 
CANCEL key to dismiss the Leader Dots menu. 

LEADER DOTS: (Press CANCEL to dismiss) 

Press L for Left-aligned tab 
R Right-aligned tab 
C Centered tab 
o Decimal tab 

Figure 4-18. Leader Dots Menu. 

If you are specifying a series of identical tab 
settings across a page, such as right-aligned 
tabs at even or uneven intervals, use the Redo 
command after specifying the first tab setting. 

To do so, specify the first tab setting using the 
above procedures. Then, move the cursor to the 
next required tab stop and press REDO. Repeat 
these steps to set the other tabs. Redo will 
work only when you are specifying the same type 
of tab setting. 

You can clear existing tab settings with the Tabs 
command. Pressing TABS (f3) brings up the Tabs 
menu, as shown in Figure 4-17. The ruler display 
at the top of the screen shows where each tab is 
set. 

To clear one or more tab settings: 

1. Press TABS (f3). The Tabs menu appears. 

2. To clear one tab setting, move the cursor to 
that tab setting. 

3. Type O. 



4. The tab setting at the cursor position is 
cleared. The tab symbol is removed from the 
ruler display. 

5. To clear all tab settings, press A. 

6. All tab settings are cleared. All tab 
symbols are removed from the ruler display. 

To clear a few tab settings (but not all), use 
the Redo command. To do so, clear one tab 
setting using steps 1 through 3, above. Then 
move the cursor to the next tab setting you wish 
to clear and press REDO. Repeat, moving the 
cursor and pressing REDO to clear additional tab 
settings. 

Entering Tabular Text 

The TAB key on the typewriter pad is used to 
enter tabular text. This key is similar to the 
tab key on a typewriter. TAB moves the cursor to 
the settings specified by the tab stops on the 
ruler display. 

TAB also acts as a return key. After you enter 
the last column of text on a line, press TAB to 
move the cursor to the first tab stop on the next 
line. 

For example, in the table below, tab stops have 
been set for two columns of left-aligned text. 
The cursor is positioned to the right of "Mary 
Smith". 

Name Employee No. 

James Johnson 
Mary Smith 

123789 

To continue entering text in the table: 

1. Press TAB. The cursor moves to the next tab 
setting under "Employee No." 

2. Enter the employee number. 

3. Press TAB again. The cursor moves to the 
first tab setting on the next line under 
"Name" (just below "Mary Smith"). 

4. Enter another name. 

5. Repeat the above steps to enter more text. 
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Entering Center Tab Text 

When using centered tabs with even numbered 
character strings, the additional character will 
be placed to the left of the tab stop. This 
should not be of concern, as when this text is 
printed out the characters will align correctly 
with respect to each other and the center tab. 

Entering Decimal Tab Text 

When entering decimal' 'tab data, any character 
which is not in the following set ($, -, +, =, {, 
[, (, <, @, #, 0-9) will not act as a delimiter 
for a decimal tab stop. That is, if a -9.9 is 
entered at a decimal tab stop, the decimal point 
will not align correctly. 

Entering Right Aligned Tab Text 
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When entering right aligned 'tab data, spaces will 
not be considered part of the field for right 
aligned tabs. However, if spaces are desired, a 
non-breaking space (CODE-SHIFT-spacebar) can be 
used and will align correctly. 



CHARACTER FORMATTING 

Certain formatting characteristics apply to one 
or more adjacent characters. Characters are 
formatted with combinations of the following 
attributes: -

0 underline 

0 double underline 

0 boldface 

0 superscript 

0 subscript 

0 struck-out text 

The above attributes .are specified with the 
Format command. 

Format Command 

The Format command, which you invoke by pressing 
FORMAT (f4), displays the Format menu shown in 
Figure 4-19. This menu serves two purposes. The 
top of the menu shows the current characteristics 
of the paragraph or selection in which the cursor 
is positioned. The rest of the menu tells you 
what keys to press to specify the various format 
attributes. If you made any format changes to the 
text (for example, you change the text from 
single spacing to double spacing), the Format 
menu reflects that change the next time it 
appears. 

The Format menu is in two parts. The first part 
is displayed when FORMAT (f4) is pressed. 
Pressing FORMAT a sec'ond time displays the second 
part of the menu. (Pressing FORMAT a third time 
causes the first part of the menu to reappear.) 

Although the Format menu is in two parts and each 
part displays different sets of options, you can 
choose any of the options when either part is 
displayed. 
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(Once you are familiar with using the Format 
command, you can specify a format attribute 
without causing the menu to appear. To do so, 
press FORMAT and then quickly type the character 
that represents the option you want.) 

FORMAT: (Press CANCEL to dismiss) 

Current: * Normal Text 
*. Left Fl ush 

* Courier 72 * lO-pitch 
* Single Spaced 

Press B for Boldface text 
Underlined text 
Double-underlined text 

S Struck-out text 

Press ~ for Superscript text 
Subscript text 

A Alternate ribbon color 
K merge Keyword 

or CODE and indicated key to remove attribute 

Press N for Normal text Press FORMAT again for more choices 

Format Menu (Part 1) 

FORMAT: (press CANCEL to dismiss) 
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Current: 

Press L for Left-flush text 
C Centered text 
J Justified text 
R Right-flush text 

press P to change Page format 
press space bar to change pitch 
press W to change print Wheel 

Format Menu (Part 2) 

Press 1 for Single-spaced text 
2 Double-spaced text 
/ Single/double spacing 
1/2 1 1/2-line spacing 
o Other line spacing 

Press FORMAT again for more choices 

Figure 4·19. Format Menu, Parts 1 and 2. 

In Figure 4-19, the current paragraph is shown to 
have normal, left-flush, single-spaced, 10-pitch 
text, and the print wheel in use is Courier 72. 
Instructions for using the Format menu to specify 
particular attributes appear below according to 
function. 



Underlines 

Both new and existing text can be underlined. 
Single or double underlining is both specified 
and removed with the Format command. (See 
"Format Command," above.) 

To underline text as it is entered: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press - (hyphen) for single underline, or 
press = (equal sign) for double underline. 

3. The Format menu goes away. 

4. Enter text. For single underline the text is 
automatically underlined as it is entered. 
For double underline the text will appear in 
half brightness. -

To stop underlining text as it is entered: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press CODE- - (hyphen) to stop the single 
underline or press CODE- = (equal sign) to 
stop the double underline. 

3. The Format menu goes away. Text no longer is 
underlined as it is entered. 

To underline existing text: 

1. Use the appropriate Mark (and Bound) command 
to select the text to be underlined. (See 
"Selections," above.) 

2. Press FORMAT (f4). The Format menu appears. 

3. Press - (hyphen) for single underline or 
press = (equal sign) for double underline. 

4. The Format menu goes away. For single 
underline the selected text is underlined 
(and the highlight goes away). For double 
underline the text appears in half brightness 
(and the highlight goes away). 
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Boldface 
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To remove the underline from existing text: 

1. Use the appropriate Mark (and Bound) command 
to select the underlined text. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press CODE- - (hyphen) to remove single 
underlining or press CODE- = (equal sign) to 
remove double underlining. 

4. The Format menu goes away. The underlining 
is removed from the selected text (and the 
highlight goes away). 

A character or string of characters can be 
printed in boldface. The boldface attribute can 
be specified for new or existing text. When 
boldface text has been specified, it appears on 
the screen in half-brightness. 

Boldface text is specified with the Format 
command. (See "Format Command," above.) 
Boldface text is changed back to normal text with 
the same command. 

To specify boldface text as it is entered: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press B. 

3. The Format menu goes away. 

4. Enter text. It will appear in half-brightness 
on the screen. 

To stop entering boldface text: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press CODE-B. The Format menu goes away. 

3. Enter text. It will appear in normal 
brightness on the screen. 



Superscript 

To change existing text to boldface: 

1. Use the appropriate Mark (and Bound) command 
to select and highlight the text. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press B. 

4. The Format menu goes away. The selected text 
changes to half-brightness. 

To change existing boldface text back to normal 
text: 

1. Use the appropriate Mark (and Bound) command 
to select and highlight the boldface text. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press CODE-B. 

4. The Format menu goes away. The selected text 
returns to normal brightness. 

Text can be printed above the normal line of 
text. Text above the line is known as 
superscript and is specified with the Format 
command. (See "Format Command," above.) This 
command is also used to change superscript text 
back to normal text. Superscript text appears on 
the screen in half-brightness. However, if the 
digits 0-9 are used, they will be displayed on 
the screen as small supercripted digits and will 
not appear in half brightness. When these digits 
(0-9) are printed they will print as full size 
digits, the same as any other superscripted 
character. 

To specify superscript as you enter text: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press ~ (caret). 

3. The Format menu goes away. 

4. Enter text. It appears on the screen in 
half-brightness except the digits 0-9 which 
appear as small superscripted digits. 
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Subscript 
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To stop entering superscript text: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press CODE-A (caret). 

3. The Format menu goes away. 

4. Enter text. It appears on the screen in 
normal brightness and digits will display 
full size. 

To change existing text to superscript: 

1. Use the appropriate Mark (and Bound) command 
to select and highlight the text to be 
changed. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press A (caret). 

4. The Format menu goes away. The selected text 
changes to superscript text and is displayed 
on the screen in half-brightness except the 
digits 0-9 which appear as small 
superscripted digits. 

To change superscript text to normal text: 

1. Use the appropriate Mark (and Bound) command 
to select and highlight the superscript text. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press CODE-A (caret). 

4. The Format menu goes away. The selected 
superscript text changes back to normal text. 

Text can be printed below the normal line of 
text. This kind of text is known as subscript 
and is specified with the Format command. (See 
"Format Command," above.) This command also is 
used to change subscript text back to normal 
text. Subscript text appears on the screen in 
half-brightness. However, if the digits 0-9 are 
used, they will be displayed on the screen as 
small subscripted digits and will not appear in 
half brightness. When-these digits (0-9) are 
printed they will print as full size digits, the 
same as any other subscripted character. 



To specify subscript as you enter text: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press. (period). 

3. The Format menu goes away. 

4. Enter text. It appears on the screen in 
half-brightness except the digits 0-9 which 
appear as small subscripted digits. 

To stop entering subscript text: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press CODE- . (period). 

3. The Format menu goes away. 

4. Enter text. It appears on the screen in 
normal brightness and digits will display 
full size. 

To change existing text to subscript text: 

1. Use the appropriate Mark (and Bound) command 
to select and highlight the text to be 
changed. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press. (period). 

4. The Format menu goes away. The selected text 
changes tQ subscript text and is displayed 
on the screen in half-brightness except the 
digits 0-9 which appear as small subscripted 
digits. 

To change subscript text to normal text: 

1. Use the appropriate Mark (and Bound) command 
to select and highlight the subscript text. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press CODE- . (period). 

4. The Format menu goes away. The selected 
subscript text changes back to normal text. 
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Struck-Out Text 

When you are revIsIng a document, you may wish to 
retain deleted text in some form. The Word 
Processor allows you to print "deleted" text and 
indicate its state in the printed document. 

For example, you are deleting a phrase in a draft 
copy of a document but want to show that this 
phrase will be removed from the final copy. Do 
the following: 

1. Use the Mark Word and Bound commands to 
select the phrase to be struck out. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press S. 

4. The Format menu goes away. The selected 
phrase appears on the screen in half­
brightness. 

5. When the document is printed, the "deleted" 
or struck-out phrase looks like this: 

.all men are created equal, but some men 
are created more equal EABa 9EAeFB. 

Removing Multiple Character Format Attributes 
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Your document might have a block of text 
containing more than one kind of character format 
attribute. For example, a paragraph contains 
words that are both boldface and underlined. If 
that block of text needs to be changed back to 
normal (no character format attributes), it is 
not necessary to remove each attribute 
individually. 

To remove multiple format attributes at one time: 

1. Use the appropriate Mark (and Bound) command 
to select the formatted text to be changed 
back to normal. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press N for normal text. 

4. The Format menu goes away. The character 
format attributes are removed, and the 
selected text changes back to normal. 



SPECIAL CHARACTERS 

Visible Command 

The Word Processor provides several special 
characters for better control of text 
formatting. These characters are 

o discretionary hyphen 

o breaking required hyphen 

o nonbreaking required hyphen 

o nonbreaking space 

o discretionary line break 

The Visible command, which you invoke by pressing 
CODE-v, causes these special characters to appear 
on the screen. There are three levels of 
visibility on the screen. When Visible is not 
invoked, the screen contains regular spaces 
between words and shows no special characters or 
symbols. Pressing CODE-v once causes small dots 
to appear in the spaces, and paragraph symbols to 
appear at the beginning of each paragraph. 
Pressing CODE-v again causes the special 
characters to appear. Pressing CODE-va third 
time causes all special characters and symbols to 
disappear, leaving the screen as it was 
originally. 

For example, if you are using the Required 
Backspace command, you can see the special 
character inserted by the command by pressing 
CODE-v twice. Required Backspace inserts a 
special character that appears on the screen only 
when Visible is invoked. The special character 
does not appear in the printed document. 

Discretionary Hyphen 

A discretionary hyphen can be inserted when a 
word breaks at the end of a line, and not 
otherwise. Sometimes a long word cannot fit at 
the end of a line. The Word Processor wraps the 
word around to the next line, leaving large 
"holes" in the previous line. Placing a discre­
tionary hyphen in the long word causes the word 
to break when it would otherwise extend beyond 
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the end of a line. If the text is later edited 
so that the word no longer breaks at the end of a 
line, the hyphen does not appear. 

To specify a discretionary hyphen, plac~ the 
cursor to the right of the letter at which you 
want the word to break and then press CODE­
hyphen. 

Breaking Required Hyphen 

A breaking required hyphen is the standard hyphen 
that is used in expressions such as father-in-law 
and tailor-made.· These expressions must always 
be hyphenated, but can be broken, if necessary, 
after a hyphen: 

A breaking required hyphen is typed with the 
standard hyphen key. 

Nonbreaking Required Hyphen 

A nonbreaking required hyphen keeps expressions 
together as a group at the end of a line, rather 
than breaking them at a hyphen. For example, the 
expression 3-2, as in Figur~ 3-2, or the phone 
number 800-538-7560, should not break. 

Type a nonbreaking required hyphen with CODE­
SHIFT-hyphen at the position where the hyphen 
appears in the text. 

Nonbreaking Space 
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A nonbreaking space keeps expressions together as 
a group at the end of a line rather than 
splitting them at a space. For example, the 
equation A + B = C should not split. 

Type a nonbreaking space with CODE-SHIFT-spacebar 
at the position where the space appears in the 
text. 



Discretionary Line Break 

A discretionary line break can be inserted into a 
phrase or a sentence to split it at a specific 
place at the end of a line. For example, an 
expression such as and/or can be split after the 
slash (/) if the line ends there. 

To specify a discretionary line break, place the 
cursor to the right of the character at which you 
want the line to split and then press CODE­
spacebar. 

PARAGRAPH FORMATTING 

Certain formatting characteristics apply to one 
or more adjacent paragraphs. Paragraphs are 
formatted with combinations of the following 
attributes: 

o left and right paragraph indents 

o first line indent 

o spacing between lines of a paragraph 

o text alignment (left-flush, right-flush, 
justified, centered) 

o tab settings 

Setting Paragraph Indents 

Left and right paragraph indents are specified 
with the Paragraph Indent command. The Paragraph 
Indent command, which you invoke by pressing 
INDENT (CODE-f3), displays the Paragraph Indent 
menu shown in Figure 4-20. 

Paragraphs can be formatted in square block mode 
or can have the first line or other lines 
indented. Block paragraphs are specified by the 
setting of the left indent. The ruler display is 
your guide to setting indent stops. (See Section 
3, "Screens.") 

4-59 



It is not necessary to Mark one specific paragraph of 
existing text to select it for a paragraph indent change. 
However, to change paragraph indents in two or more 
consecutive paragraphs of existing text or in an entire 
document of existing text, it is necessary to select those 
paragraphs or to select the document. (See "Making a 
Selection," above.) 

Specifying Left and Right Indents 
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To specify left (block) and right paragraph 
indents while entering new text: 

1. Press INDENT (CODE-f3). The Paragraph Indent 
menu appears. 

2. Move the cursor to the desired indent stop on 

the ruler display. 

3. Choose the desired type of paragraph indent 
by pressing the corresponding letter: 

Press L to set Left indent 
Press R to set Right indent 

4. After you have chosen the desired indent, the 
indent symbol appears on the ruler display at 
the new indent stop, and the form goes 
away. The text you enter will be formatted 
according to the new indent setting. 

PARAGRAPH INDEN1': (Press CANCEL to dismiss) 

Move cursor to desired indent position, then: 

Press L to set Left indent 
R Right indent 
F First line indent only 
a Other lines 

Figure 4-20 Paragraph Indent Menu. 



To change existing paragraph indents: 

1. Use the appropriate Mark (and Bound) command 
to select the paragraphs to be changed. If 
only one paragraph requires a changed 
paragraph indent, it is not necessary to 
select that paragraph as long as the cursor 
is positioned within it. 

2. Press INDENT (CODE-f3). The Paragraph Indent 
menu appears. 

3. Move the cursor to the new paragraph indent 
setting. 

4. Choose the desired typ~ of paragraph indent 
by pressing the appropriate letter: 

5. 

Press L to set Left indent 
Press R to set Right indent 

The menu goes away. The indent symbol 
appears on the ruler display at the new 
indent stop. The paragraph or selected 
paragraphs are reformatted to reflect the 
indent setting. 

Indenting the First Line of a Paragraph 

new 

The first line of a paragraph can be automati­
cally indented to the right or to the left of the 
left indent setting each time RETURN is pressed 
The Paragraph Indent command is used to set 
first-line paragraph indents. 

To set the first-line paragraph indent while 
entering text: 

1. Press INDENT (CODE-f3). The Paragraph Indent 
menu appears. 

2. Move the cursor to the desired first-line 
paragraph indent stop on the ruler display. 
This indent stop can be to the right or to 
the left of the existing paragraph indent 
stop. 
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3. Press F for first-line paragraph indent. The 
paragraph symbol appears in the ruler display 
to denote the first-line paragraph indent 
stop and the menu goes away. 

4. Press INDENT again. The Paragraph Indent 
menu reappears. 

5. Move the cursor to the desired indent stop 
for the other lines of the paragraph. 

6. Press O. The indent symbol appears in the 
ruler display to denote the indent stop for 
the other lines of the paragraph and the menu 
goes away. 

To change existing first-line paragraph indents: 

1. Use the appropriate Mark (and Bound) command 
to select the paragraphs to be changed. If 
only one paragraph requires a changed first­
line paragraph indent, it is not necessary to 
select that paragraph as long as the cursor 
is positioned within it. 

2. Press INDENT (CODE-f3). The Paragraph Indent 
menu appears. 

3. Move the cursor to the desired first-line 
indent stop on the ruler display. This 
indent stop can be to the right or to the 
left of the existing paragraph indent stop. 

4. Press F for first-line paragraph indent. The 
paragraph symbol appears in the ruler display 
to denote the first-line paragraph indent 
stop and the menu goes away. 

5. Press INDENT again. The Paragraph Indent 
menu reappears. 

6. Move the cursor to the desired indent stop 
for the other lines of the paragraph. 

7. Press O. The indent symbol appears in the 
ruler display to denote the indent stop for 
the other lines of the paragraph and the menu 
goes away. 

Figures 4-21 and 4-22 show examples of first-line 
paragraph indents. 
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Co •• .ands .are invoked by pressing .a key or a co.bination of keys 

~ith or without the CODE or SHIFT key). ~hen 
you invoke certain co •• ands, a ~ or ~ 
appears at the bottoa of the sc~een and 
temporari Iy overlays the text. The dIfferences 
between a forM and a aenu are described beloN. 

Figure 4-1 shows the Replace~. The first I~ne 
gives the na.e of the form and tells Nh~ch 
actions to perfor. in this operation. PressIng 
GO executes the operation, pressing NEXT .o~es 
the highlight fro. item to ite~, and pressIng 
CANCEL stops the operation. 

Figure 4-2l. Example of Left First-Line Paragraph Indent. 

Changing Indents 

Three commands are used to change or remove left 
paragraph indent settings: Outline Indent, 
Unindent, and Total Unindent. These commands 
move the text forward or backward to the next or 
previous tab (not indent) stops. These 
commands affect the paragraph in which the cursor 
is positioned. The ruler display also changes to 
reflect the new indents: 
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When a form appears on the screen the 

cursor is at the first position of the first item 
to be fi lied In or chosen. The cursor moves back 
to the text area when the operation Is completed, 
and the form goes away. 

A form can contain default values. 
Default values are displayed in full brightness' 
choices are displayed In half-brightness. If yo~ 
want the default values to remain, there are two 
ways to bypass them. You can bypass them by 
pressing NEXT to go to the next item. Or, if the 
default values of the rest of the options are to 
remain, press GO. 

Figure 4-22. Example of Right First-Line Paragraph Indent. 

If the cursor is at the beginning of a line and 
text is to be entered, invoking any of these 
commands will cause the new text to be indented 
according to the new left indent setting. 

If the cursor is positioned in existing text, the 
text is reformatted according to the new left 
indent setting. 

Press CODE-TAB to invoke the Outline Indent 
command, which moves the left paragraph indent 
forward to the next tab stop. The indent symbol 
on the ruler display moves forward accordingly. 
If the ruler display does not show any tab stops, 
the cursor will move at half-inch intervals. 



Line Spacing 

Press CODE-SHIFT-TAB to invoke the Unindent 
command, which moves the left paragraph indent 
back to the previous tab stop. The indent symbol 
on the ruler display moves back accordingly. If 
the ruler display does not show any tab stops, 
the cursor will move at half-inch intervals. 

Press CODE-SHIFT-RETURN to invoke the Total 
Unindent command, which moves the left paragraph 
indent back to the far left margin (the default 
left margin). 

Text is automatically single spaced as it is 
typed into a new document. However, the spacing 
between lines in either a newly created document 
or an existing document can be changed. Use the 
Format command to specify any of the following 
line spacings with one keystroke: 

o single-spaced text 

o double-spaced text 

o one-and one-half-spaced text 

o double spaced between paragraphs when text is 
single spaced 

In addition, you can specify other line spacing 
such as two-and one-half-spaced or triple-spaced 
text. 

Line spacing is a paragraph attribute: a change 
in line spacing within a paragraph affects the 
entire paragraph. No matter where the cursor is 
within that paragraph, the entire paragraph 
changes. In addition, when a new paragraph 
begins after RETURN is pressed, the new paragraph 
inherits the spacing characteristics of the 
previous paragraph. The procedures for changing 
line spacing in specific paragraphs of a document 
are described below. 
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It is not necessary to Mark one specific 
paragraph of existing text to select it for a 
line spacing change. However, to change line 
spacing in two or more consecutive paragraphs of 
existing text or in an entire document of 
existing text, it is necessary to select those 
paragraphs or the document. (See "Making a 
Selection," above.) 

Single and double spacing show on the screen; 
half-line spacing does not. However, the 
document status line always reflects the current 
line position of the cursor: For example, if the 
line position is 11 1/2 (because the paragraph 
has one-half line spacing), the document status 
line shows that line number. 

The Format command is used to specify line 
spacing. (See Figure 4-19 for the Format menu.) 

To choose line spacing either for text being 
entered or for existing text: 

1. Move the cursor to the place where you want 
the new line spacing to begin. 

2. Press FORMAT (f4) twice. The Format menu 
appears. 

3. Choose the type of line spacing you need: 

Press 1 for Single-spaced text 
Press 2 for Double-spaced text 
Press / for Single/double spacing 
Press 1/2 for 1 1/2-line spacing 
Press a for Other line spacing 

4. If you choose anyone of the first four line 
spacing choices, the Format menu goes away 
and the following occurs: 

o If you are entering text, it is now 
spaced according to the new line spacing. 

o If you are changing existing text, the 
p~ragraph containing the cursor or the 
selection changes its line spacing. 

5. If you choose a for other line spacing, the 
Line Spacing form, shown in Figure 4-23, 
appears. 



LINE SPACING: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Before: 
Within: 
After: 

Example 

Currently 
3.0 lines 
2.0 lines 
0.0 lines 

(Please enter measurements in lines) 

Figure 4-23. Line Spacing Form. 

The Line Spacing form shows the line spacing for 
the paragraph containing the cursor and provides 
areas in which to specify line spacing other than 
the spacing options provided on the Format 
menu. 

To specify other line spacing: 

1. Enter the number of spaces to appear above 
the paragraph. 

2. Press NEXT to move the highlight to "Within". 

3. Enter the number of spaces to appear between 
the lines within the paragraph. 

4. Press NEXT to" move the highlight to "After". 

5. Enter 0.0 (zero). 

6. Press GO. 

7. The Line Spacing form goes away, and the line 
spacing in the document changes accordingly. 

The following example tells you how to change 
line spacing as you enter text into a document. 

You are writing a one-page memo to announce a new 
alarm system in a building. The memo will 
contain four paragraphs, the second of which is 
to have boldface type and double spacing to 
accentuate its meaning. 
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Text Alignment 
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Set the first paragraph with single spaces within 
the paragraph and a double space after the 
paragraph. You can do so by pressing FORMAT (f4) 
and entering "/". Note that as you enter text, 
the document status line reflects the current 
spacing when the cursor goes to a new line. 

At the very start of the second paragraph, after 
you press RETURN but before any text is entered, 
change the line spacing to double spaced within 
the paragraph and four spaces before and after 
it. Do so by pressing FORMAT (f4) and 
specifying "0" in the Format menu. When the Line 
Spacing form appears, specify four lines for 
"Before", two lines for "Within", four lines for 
"After", and press GO. After the Line Spacing 
form goes away, press Format again and specify 
"B" for boldface text. When you enter text, it 
will be double spaced and displayed in half­
brightness on the screen. Press RETURN again at 
the end of the second paragraph. 

At the start of the third paragraph, before any 
text is entered, change the line spacing back to 
single spaced with double spaces before and after 
the paragraph. Do so by pressing FORMAT (f4) and 
entering "/" again. Remove the boldface format 
attribute by pressing FORMAT and then pressing 
CODE-b. All text that you subsequently enter in 
this paragraph and in the fourth paragraph will 
have the same spacing as did the first paragraph. 

See "Line Spacing" in Section 5, "Advanced 
Operations," for more information about speci­
fying line spacing. 

You can specify different ways of aligning text 
at left and right margins. Text can be right 
flush, left flush, or justified (right and 
left). Text can also be centered on a page, 
which is convenient for entering titles. Text 
alignment is specified with the Format command. 
(See "Format Command," above.) 

The position at which the text is aligned at the 
left and right is determined by the paragraph 
indent that you specify. The margin is the 
actual space between the edge of the paper and 
the edge of the text. 



Specifying left-flush text causes the text to 
line up evenly against the left paragraph indent 
position. This position is the default, and all 
new text is entered left flush unless specified 
otherwise. Left-flush text has an uneven right 
margin. 

Specifying right-flush text causes the text to 
line up evenly against the right paragraph indent 
position. Right-flush text has an uneven left 
margin. 

Specifying justified text adjusts the spaces 
within the text so that the text is lined up 
evenly against both the right and left paragraph 
indent positions. Words are spaced out within 
the text to conform to this format. 

Specifying centered text centers the text on the 
page, leaving uneven right and left margins. 
Note when an even numbered character string is 
entered, the additional character will be placed 
to the right of the center. However, when this 
text is printed out, the characters will align 
correctly with respect to each other and the 
center point. 

Text alignment is a paragraph attribute. Any 
alignment change affects the entire paragraph in 
which the change was made. 

To specify text alignment while you are entering 
text: 

1. Press FORMAT (f4) twice. The Format menu 
appears. 

2. Choose-the desired type of alignment: 

Press L for Left-flush text 
Press C for Centered text 
Press J for Justified text 
Press R for Right-flush text 

3. Once you make your choice, the Format menu 
goes away and ~he text you enter is aligned 
as specified. 
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To change text alignment of existing text: 

1. Use the appropriate Mark (and Bound) command 
to select and highlight the text you wish to 
realign. 

2. Press FORMAT (f4) twice. The Format menu 
appears. 

3. Choose the desired type of alignment: 

Press L for Left-flush text 
Press C for Centered text 
Press J for Justified text 
Press R for Right-flush text 

4. The Format menu goes away, and the selected 
text is realigned. 

When you are specifying different text alignment 
formats for consecutive paragraphs, you must 
press the RETURN key before specifying the 
different format for the new paragraph. For 
example, you are typing a document that has left­
justified text and you want to start a new para 
graph that has centered text. After typing the 
left-justified text, press RETURN. Then, invoke 
the Format command and choose C for centered 
text. The subsequent text you type will be 
centered. 

PAGE FORMATTING 
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Certain formatting characteristics apply to one 
or more adjacent pages. Different page formats 
can be specified for the first page of a docu­
ment, and for all odd and all even pages. Pages 
are formatted with combinations of the following 
attributes: 

0 paper height and width 

0 text height and width 

0 top, bottom, left, and right margins 

0 headers 

0 footers 

0 page numbers 



The Format command is used to specify these 
attributes. (See "Format Command, above.) Invoke 
the command by pressing FORMAT (f4), which dis­
plays the Format menu. (See Figure 4-19.) Then 
press P to display the Page Format form, shown in 
Figure 4-24. All the procedures described below 
are for use with the Page Format form. Page 
numbers are specified with the Page Number 
command, described below under "Headers" and 
"Footers." 

The Page Format form shows the current values in 
both inches and lines. 

Paper Height and Width 

You can specify the size of the paper on which 
your document will be printed. The system 
default paper size is 8 1/2 by 11 inches, which 
is standard letter size. Before the document is 
printed, make sure your printer is adjusted 
according to paper size. 

To change paper height and width: 

1. Press FORMAT (f4) twice. The Format menu 
appears. 

2. Press P. The Page Format form appears. 

3. Enter the paper width in inches. 

4. Press NEXT to move the highlight to "Paper 
height". 

5. Enter the paper height in inches. 

6. If no other changes are to be specified, 
press GO. Otherwise, enter the other 
changes, using the appropriate steps 
described below. 
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PAGE FORMAT: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Currently (Please enter measuremp.nts in inches) 
Paper width: 
Paper height: 

8.5" 
11.0" (66.0 lines) 

Left margin: 1.5" 
Text width: 6.0" 
Right margin: 1.0" 

Top margin: 1.0" (6. a lines) 
Text height: 9.0" (54.0 lines) 
Bottom margin: 1.0" .(6. a lines) 

Header position: 0.5" (3.0 lines) 
Footer position: 0.5" (3.0 lines) 
Facing pages? Yes No (Press Y or N) 

Forced page? 
Forced page number: 

Yes No Odd Even (Press Y, N, 0, or E) 

Figure 4-24. Page Format Form. 

Page Margins and Paper Size 
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You can specify the size of the top, bottom, 
left, and right margins and the height and width 
of the text on the printed page. 

If the printed text will be bound, it will 
require different sized left and right margins. 
(The margins for a left page also are different 
from those for a right page.) Size is specified 
in inches. (A two-inch margin is entered as 2.0, 
and a half-inch margin is entered as 0.5.) 

It is not necessary to specify both margin size 
and text size, as long as text size is speci­
fied. For example, if the page size is standard 
8 1/2 by 11 inches and you specify text height of 
9 inches and text width of 6 1/2 inches, you do 
not have to specify margin size. 



However, if you need to specify margins of 
different widths or heights, such as a left 
margin that is wider than a right margin, you 
should specify margin size rather than text size. 

To specify either page margins or text size: 

1. Press FORMAT (f4) twice. The Format menu 
appears. 

2. Press P. The Page Format form appears. 

3. Press NEXT to move the highlight to "Left 
margin". 

4. Enter the left margin width in inches. 

5. Press NEXT to move the highlight to "Text 
width". 

6. Enter the text width in inches. (On an 8 
1/2-by-11-inch sheet of paper, the text 
width is 6 1/2 inches if each side margin is 
1 inch wide.) 

7. Press NEXT to move the highlight to "Right 
margin". 

8. Enter the right margin width in inches. 

9. Press NEXT to move the highlight to "Top 
margin". 

10. Enter the top margin height in inches. 

11. Press NEXT to move the highlight to "Text 
height". 

12. Enter the text height in inches. (On an 8 
1/2-by-11-inch sheet of paper, the text 
height is 9.0 inches if the top margin is 1 
inch. 

13. Press NEXT to move the highlight to "Bottom 
margin". 

14. Enter the bottom margin height in inches. 

15. If no other changes are to be made, press 
GO. Otherwise, enter the other changes, 
using the appropriate steps described below. 
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Header and Footer Position 

Facing Pages 

Example 
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Before you specify headers and footers (see 
"Headers" and "Footers," below), determine where 
they should appear in the top or bottom 
margins. 

Header and footer position refers to the distance 
from the top or bottom edge of the page. For 
example, if the header is to appear one-half inch 
below the top edge of the page in a one-inch top 
margin, specify a header position of 0.5 (one­
half inch). If the footer is to appear one inch 
from the bottom edge of a page in a three-inch 
bottom margin, specify a footer position of 1.0 
(one inch). 

To specify header and footer positions: 

1. Press FORMAT (f4) twice. The Format menu 
appears. 

2. Press P. The Page Format form appears. 

3. Press NEXT to move the highlight to "Header 
position". 

4. Enter the header position in inches. 

5. Press NEXT to move the highlight to IIFooter 
position". 

6. Enter the footer position in inches. 

7. Press GO. 

Some printed documents have facing pages. In 
such cases, the margins on the left page are a 
mirror image of the margins on the right (facing) 
page. 

If a printed document is bound in a ring binder, 
the margin containing the ring holes must be wide 
enough to accommodate them. Generally, that side 
margin is wider than the other side margin. In 
this example, you would specify a right page with 
a one-and-one-half-inch left margin and a one­
inch right margin. 



Forced Pages 

If any of the pages are facing each other, 
specify the "Facing pages" option. T~is op~ion 
causes the Word Processor to make a mIrror Image 
of the right page and print a left page with a 
one-inch left margin and a one-and-one-half-inch 
right margin. (The wider right margin accommo­
dates the ring holes in a left-hand. page.) 

To specify facing pages: 

1. Press FORMAT (f4) twice. The Format menu 
appears. 

2. Press P. The Page Format form appears. 

3. If facing pages are required, press NEXT to 
move the highlight to "Facing Pages". (Make 
sur~ your left and right margins have been 
specified.) 

4. Type Y. 

5. Press NEXT to move the highlight to the next 
item, if needed. 

6. Otherwise, press GO. 

You can use the Page Format option to force a 
page to break and a new page to begin. 

Page breaks can be either temporary or permanent 
(forced). A temporary page break can be removed 
with the Review Documents command. A permanent 
page break cannot be removed. In addition, a page 
break can be required to fallon an odd- or even­
numbered page. For example, if a section of a 
document must always begin on an odd-numbered 
page, the beginning of a section is a forced odd 
page break. Forcing an odd page might insert a 
blank page of text to precede it. 

1. Press FORMAT (f4) twice. The Format menu 
appears. 

2. Press P. The Page Format form appears. 

3. Press NEXT to move the highlight to "Forced 
page". 
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4. Choose the desired type of page break: 

Press Y for a forced page break 
Press N for a temporary page break 
Press 0 for an Odd forced page break 
Press E for an Even forced page break 

5. Press GO. 

Forced Page Number 

Headers 
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You can force page numbering to start on a 
particular page. The Word Processor finds the 
page within the document, and resets the page 
counter, and subsequent pages are numbered 
accordingly. 

The page number appears on the printed copy of 
the document in place of the page number symbol 
(#) when one is specified (usually within a 
header or footer). A forced page number can be 
applied to any page in the document. 

To specify a forced page number: 

1. Press NEXT to move the highlight to "Forced 
page number". 

2. Enter the number of the forced page. 

3. Press GO. 

You must specify the forced page option before 
assigning the forced page number. Otherwise, the 
following message appears after you press GO: 

Forced page number requires forced page 

Specify your forced page using the steps 
described above under "Forced Pages." 

You can specify certain text to appear at the top 
of a printed page. Titles, subtitles, page 
numbers, and dates are examples of headers that 
can be specified. The Header command, which you 
invoke by pressing HEADER (f5), displays the 
Header menu shown in Figure 4-25. 



You can specify headers for an entire document or 
for just a few pages. To do so, select those 
pages with Mark Page before you specify the 
header. 

You can specify both odd and even headers for the 
same page if there is a chance that a page might 
change from odd to even. The Word Processor will 
retain both types of headers and will print the 
appropriate one after repagination has occurred. 

HEADER: (press CANCEL to dismiss) 

Press 0 to set Odd header 
E Even header 
B Both headers 

Figure 4-25. Header Menu. 

Odd headers appear on odd-numbered pages. Even 
headers appear on even-numbered pages. If B is 
selected, the header appears on all pages. 

To specify header text for an entire document: 

1. Press GO TO BEGINNING (CODE-b) to move the 
cursor to the beginning of the document. 

2. Press HEADER (fs). The Header menu appears. 

3. Choose the desired type of header: 

Press a to set Odd header 
Press E to set Even header 
Press B to set Both headers 

4. When the header type is chosen, a small 
window appears at the bottom of the screen in 
which to enter the header text. 

5. Enter the header text. 
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6. If you want to include the page number in the 
header text, press PAGE # (CODE-fs) at the 
exact place in the header where the page 
number is to appear. This procedure inserts 
a half-bright # that is replaced by the 
actual page number when the document is 
printed. 

To include a Roman page number in the header 
text, press PAGE # (CODE-SHIFT-fs) at the 
exact place in the header where the page 
number is to appear. This procedure inserts 
a half-bright i that is replaced by the 
actual Roman page number when the document 
is printed. 

7. Press GO. 

To specify header text for specific pages of a 
document: 

1. Use the Mark Page (and Bound) command to 
select the pages for which you are specifying 
headers. 

2. Press HEADER (fs). The Header menu appears. 

3. Choose the desired type of header: 

Press 0 to set Odd header 
Press E to set Even header 
Press B to set Both headers 

4. When the header type is chosen, a small 
window appears at the bottom of the screen in 
which to enter the header text. 

5. Enter the header text. 

6. If you want to include the page number in the 
header text, press PAGE # (CODE-fs) at the 
exact place in the header where the page 
number is to appear. This procedure inserts 
a half-bright # that is replaced by the 
actual page number when the document is 
printed. 

To include a Roman page number in the header 
text, press PAGE # (CODE-SHIFT-fs) at the 
exact place in the header where the page 
number is to appear. This procedure inserts 
a half~bright i that is replaced by the 
actual Roman page number when the document 
is printed. 

7. Press GO. 



To delete an existing header for an entire 
document: 

1. Press GO TO BEGINNING (CODE-b) to move the 
cursor to the beginning of the document. 

2. Press HEADER (fS). The Header menu appears. 

3. Choose the type of header that exists 
currently. 

4. When the heade~ text appears in the window at 
the bottom of the screen, select it with the 
appropriate Mark key. 

5. Press DELETE. 

6. Press GO. 

To delete an existing header in a specific page: 

1. Use the Mark Page (and Bound) command to 
select the page in which the header is to be 
deleted. 

2. Press HEADER (fS). The Header menu appears. 

3. Use the DELETE or BACKSPACE key to delete the 
header text. 

4. Press GO. 

To change the text in an existing header for an 
entire document: 

1. Press GO TO BEGINNING (CODE-b) to move the 
cursor to the beginning of the document. 

2. Press HEADER (fS). The Header menu appears. 

3. Choose the type of header that exists 
currently. 

4. When the header text appears in the window at 
the bottom of the screen, make the necessary 
changes. 

5. Press GO. 
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To change the header text in a header for a 
particular page in an existing document: 

1. Use the Mark Page (and Bound) command to 
select the page in which the header is to be 
changed. 

2. Press HEADER (fS). The Header menu appears. 

3. Choose the type of header that exists 
currently. 

4~ When the header text appears in the window at 
the bottom of the screen, make the necessary 
changes. 

5. Press GO. 

NOTE 

When doing such operations as Formatting, Search, 
Replace, or Check Spelling, etc., the word proc­
essor will not include the header into these 
operations on the document. Therefore, a header 
should be treated as a separate document when 
these operations need to be performed on headers. 
This is done by calling up the header, position­
ing the cursor within the header text, and then 
invoking the required operation. 

You can specify certain text to appear at the 
bottom of a printed page. The Footer command, 
which you invoke by pressing FOOTER (SHIFT-fS), 
displays the Footer menu shown in Figure 4-26. 

Odd footers appear on odd-numbered pages. Even 
footers appear on even-numbered pages. If B is 
selected, the footer appears on all pages. 

You can specify footers for an entire document or 
for just a few pages. To do so, select those 
pages before you specify the footer. 



FOOTER: (Press CANCEL to dismiss) 

Press 0 to set Odd footer 
E Even footer 
B Both footers 

Figure 4-26. Footer Menu. 

You can specify both odd and even footers for the 
same page if there is a chance that a page might 
change from odd to even. The Word Processor will 
retain both types of footers and will print the 
appropriate one after repagination has occurred. 

To specify footer text for an entire document: 

1. Press GO TO BEGINNING (CODE-b) to move the 
cursor to the beginning of the document. 

2. Press FOOTER (SHIFT-fs). The Footer menu 
appears. 

3. Choose the desired type of footer: 

Press 0 to set Odd footer 
Press E to set Even footer 
Press B to set Both footers 

4. When the footer type is chosen, a small 
window appears at the bottom of the screen in 
which to enter the footer information. 

5. Enter the footer information. 

6. If you want to include the page number in the 
footer text, press PAGE # (CODE-fs) at the 
exact place in the footer where the page 
number is to appear. This procedure inserts 
a half-bright # that is replaced by the 
actual page number when the document is 
printed. 
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To include a Roman page number in the footer 
text, press PAGE # (CODE-SHIFT-fs) at the 
exact place in the footer where the page 
number is to appear .. This procedure inserts 
a half-bright i that is replaced by the 
actual Roman page number when the document 
is printed. 

7. Press GO. 

To specify footer text for specific pages of a 
document: 

1. Use the Mark Page (and Bound) command to 
select the pages for which you are specifying 
footers. 

2. Press FOOTER (SHIFT-fs). The Footer menu 
appears. 

3. Choose the desired type of footer: 

Press a to set Odd footer 
Press E to set Even footer 
Press B to set Both footers 

4. When the footer type is chosen, a small 
window appears at the bottom of the screen in 
which to enter the footer information. 

5. Enter the footer information. 

6. If you want to include the page number in the 
footer text, press PAGE # (CODE-fS) at the 
exact place in the footer where the page 
number is to appear. This procedure inserts 
a half-bright # that is replaced by the 
actual page number when the document is 
printed. 

To include a Roman page number in the footer 
text, press PAGE # (CODE-SHIFT-fS) at the 
exact place in the footer where the page 
number is to appear. This procedure inserts 
a half-bright i that is replaced by the 
actual Roman page number when the document 
is printed. 

7. Press GO. 



To delete an existing footer for an entire 
document: 

1. Press GO TO BEGINNING (CODE-b) to move the 
cursor to the beginning of the document. 

2. Press FOOTER (SHIFT-fs). The Footer menu 
appears. 

3. Choose the type of footer that exists 
currently. 

4. When the footer text appears in the window at 
the bottom of the screen, select it with the 
appropriate Mark key. 

5. Press DELETE. 

6. Press GO. 

To delete an existing footer in a specific page: 

1. Use the Mark Page (and Bound) command to 
select the page in which the footer is to be 
deleted. 

2. Press FOOTER (SHIFT-fs). The Footer menu 
appears. 

3. Use the DELETE or BACKSPACE key to delete the 
footer text. 

4. Press GO. 

To change the text in an existing footer for an 
entire document: 

1. Press GO TO BEGINNING (CODE-b) to move the 
cursor to the beginning of the document. 

2. Press FOOTER (SHIFT-fs). The Footer menu 
appears. 

3'. Choose the type of footer that exists 
currently. 

4. When the footer text appears in the window at 
the bottom of the screen, make the necessary 
changes. 

5. Press GO. 
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To change the footer text in a footer for a 
particular page of existing text: 

1. Use the Mark Page (and Bound) command to 
select the page in which the footer is to be 
changed. 

2. Press FOOTER (SHIFT-fS). The Footer menu 
appears. 

3. Choose the type of footer that exists 
currently. 

4. When the footer text appears in the window at 
the bottom of the screen, make the necessary 
changes. 

5. Press GO. 

NOTE 

When doing such operations as Formatting, Search, 
Replace, or Check Spelling, etc., the word proc­
essor will not include the footer into these 
operations on the document. Therefore, a footer 
should be treated as a separate document when 
these operations need to be performed on footers. 
This is done by calling up the footer, position­
ing the cursor within the footer text, and then 
invoking the required operation. 



REVIEW DOCUMENT 

Review Document allows you to hyphenate, repag­
inate, and eliminate widow text before the 
document is printed. The Review Document com­
mand, which you invoke by pressing REVIEW (CODE­
f4), displays the Review Document form shown in 
Figure 4-27. 

REVIEW DOCUMENT: (press GO to execute, NEXT for next item, CANCEL to dismiss) 

Hyphenate? Yes 
Hot zone (default = 1/2 inch): 

No (press Y or N) 

Paginate? Yes No 
No 

(Press Y or N) 
(press Y or N) Eliminate widows? Yes 

Hyphenation 

Figure 4-27. Review Document Form. 

The "Hyphenate" option checks for excess white 
space within text. It asks you to insert discre­
tionary hyphens in places where a hyphenated word 
would cause the text to be rearranged, thereby 
eliminating the excess white space. 

White space is the blank space the system adds to 
each line of text to fill in the entire area from 
left margin to right margin. -For example, when 
text is left justified on a line, some white 
space may appear on the line at the far right. 
Right justified text may cause some white space 
to appear on the line at the far left. When text 
is both right and left justified, white space 
sometimes is inserted between words to adjust the 
spacing of the words to fit the line. 
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You can control how much white space appears 
within a line of text by specifying a hot zone. 
The hot zone represents the amount of white space 
that is acceptable within a line. If you do not 
enter a specific number (in inches or fractions 
of .an inch), the Word Processor uses the default 
of one-half inch and allows not more than one­
half inch of white space to appear on a line. 
The hyphenation function works like this: After 
you choose the hyphenate option, enter the size 
of the hot zone (or allow the default value), and 
press GO. The Word Processor starts checking 
each line for white space that exceeds the speci­
fied hot zone. The cursor moves down through the 
document on the screen while the following mes­
sage is displayed: 

Formatting ... 

When the Word Processor finds a line that con­
tains excess white space, it displays this 
message: 

Position cursor within highlighted area 
and press GO to hyphenate. Press NEXT to 
skip this word, CANCEL to cancel command. 

The Word Processor allows you to specify exactly 
where a word should be hyphenated. That word is 
on the line following the line that contains the 
excess white space. The Word Processor high 
lights an area of text anywhere within which a 
discretionary hyphen would cause reduction of 
white space on the previous line. It also posi­
tions the cursor at the last character in the 
highlighted area. You must move the cursor back 
to the specific place in the word where the dis­
cretionary hyphen is to be inserted and press 
GO. Since you probably want to reduce the white 
space on the previous line by as much as poss­
ible, choose the first such location. 

You do not have to hyphenate at every point for 
which the Word Processor prompts. Pressing NEXT 
skips the highlighted text at which the cursor is 
positioned and continues the hyphenation check. 
Pressing CANCEL cancels the command. 



Example 

Autohyphenation 

The following two lines are a typical example of 
how the hyphenation feature· works. The first 
line contains excess white space, so the cursor 
has stopped in the second line to allow you to 
specify where the text should be hyphenated. 

A selection is a contiguous block of 
characters that has been chosen for a copy 

The text "charac" is highlighted because it is 
the area of text within which a discretionary 
hyphen can reduce the amount of white space on 
the previous line. The cursor is positioned at 
the last character (c). Move the cursor back one 
position to "a" (the second "a" in the word) and 
press GO. The word is split at that point and 
the first four letters and the inserted hyphen 
are placed at the end of the previous line. The 
rest of the word remains on the second line, 
which is adjusted to contain text from the suc­
ceeding line. These lines now look like this: 

A selection is a contiguous block of char­
acters that has been chosen for a copy or 

The Word Processor continues checking for excess 
white space until the whole document has been 
checked. 

NOTE 

The Autohyphenation feature is only 
available with the dictionary option. 

It uses an internal dictionary to determine where 
words should be hyphenated, rather than asking 
you. It asks you to divide only those words that 
are not found in the dictionary. If the 
autohyphenation option has been configured in 
your Word Processor, it works when ever you 
choose the Hyphenate option for the Review 
Document command. 
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Pagination 

The "Paginate" option repaginates the document on 
the screen before printing. You can bypass this 
option if you prefer to have pagination done 
during printing.. (See "Printing a Document," 
below. ) 

Eliminating Widows 
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The "Eliminate widows" option checks through the 
document for widows. This option works in con­
junction with the "Paginate" option. A widow is 
a few words at the end of a paragraph that cannot 
fit on the page and are carried over to the next 
page. The Word Processor adjusts the number of 
lines on a printed page to prevent widows being 
printed. 

The "Eliminate widows" option also prevents a 
page containing just one line of text from being 
generated. For example, suppose you specify a 
page length of 54 lines and you create a document 
that has 55 lines. When you invoke Review Docu­
ments and specify both the "Paginate" and "Elim­
inate widows" options, the Word Processor keeps 
line 55 on the first page of the document. (How 
ever, if a document has 5q lines, a second page 
containing two lines is created.) 

To select Review Document options: 

1. Press REVIEW (CODE-f4). The Review Document 
form appears. 

2. Press Y or N to choose whether or not the 
document is to be checked for hyphens. 

3. If you pressed Y, press NEXT to move the 
highlight to "Hot zone". Otherwise, move 
the highlight to another option. 

4. Enter the amount of blank space that is 
allowable within a line (in inches or frac­
tions of an inch). (The default is one-half 
inch.) 

5. If pagination is required, press NEXT to 
move the highlight to "Paginate". 

6. Press Y. 



7. If widows are to be eliminated, press NEXT 
to move the highlight to "Eliminate 
widows". (Make sure you also specified Y 
for "Paginate".) 

8. Press Y. 

9. Press GO. 

The message 

Formatting ... 

appears on the screen during execution of any or 
all of the Review Document options. 

At completion, the Review Document form goes 
away, and the document on the screen is 
reformatted and repaginated. Hyphens have been 
inserted where needed, widows have been 
eliminated (if found), and new page numbers have 
been assigned. 

PRINTING A DOCUMENT 

There are many options available for printing 
your documents. 

o You can request one or more entire documents 
at one time for printing. 

o Documents can be printed on continuous 
attached pages, or each page can be printed 
on a separate sheet of paper. 

o Documents can be repaginated as they are 
being printed. 

o A specific number of copies of a document 
can be printed. 

o Various types of printers can be used, in­
cluding a line printer, which has no charac­
ter formatting but has paragraph and page 
formatting. 

o Each print request can be assigned a 
priority in the print queue. 

o Both direct printing and spooled printing 
are available. (Both operations are 
performed in the background.) 
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You can choose these options with the Print com­
mand, which you can invoke at any time during a 
word processing session. Invoke the Print command 
by pressing PRINT (SHIFT-f4). The Print form, 
shown in Figure 4-28, appears on the screen. 

PRINT: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Document name (s): 
Number of copies: 
Repaginate? Yes No (Press Y or N) 
P ages to pr in t: 

for example: 1, 3-5 
Number dods. separately? Yes No (Press Y or N) 
Paper feed: Continuous Manual (Press C or M) 
Pr in ter name: 

for example: Serial, Parallel, DirectSer, Directpar, etc. 
Priority (0-9): 

Figure 4-28. Print Form. 

Printing From a Standalone, Master, or Cluster Workstation 
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Documents can be printed on a printer that is 
connected to a standalone, master, or cluster 
workstation. If a printer is connected to a 
standalone workstation, it can be used only by 
that station. A printer connected to a master 
workstation or to a cluster workstation can be 
used only by that workstation or by any cluster 
workstation attached to it if the printer spooler 
is installed. 

Two types of printing are available with the Word 
Processor: direct printing and spooled printing. 
Both types of printing are performed in the back 
ground, which means that word processing opera­
tions can continue while a document is being 
printed. 



Direct Printing 

Spooled Printing 

Direct printing is done on a printer that is 
directly attached to your workstation. 

Direct printing transfers text directly from the 
workstation to the printer and allows word 
processing operations to continue during print 
ing. However, the document being printed, as 
well as any documents in the print queue, cannot 
be accessed. 

You can issue additional print requests while a 
document is being printed. The Word Processor 
will place these requests in the print queue and 
print the documents in turn. 

Spooled printing can be done on a printer that is 
attached to either a master workstation or a 
cluster workstation. Spooled printing requires 
that the printer spooler program be installed. 

In spooled printing, an entry is created for each 
print request and is entered in the print queue. 
When the printer is available, the printer 
spooler obtains the queue entry for printing. 

You need not wait for a printer to be available 
to enter a print request. Once your print 
request has been entered in the print queue, you 
can continue your word processing session and 
work on any document other than those documents 
that are in the print queue or being printed. 
Use the Printer Status command (CODE-p) to check 
the status of your document in the print queue. 

With both types of printing, the Word Processor 
includes a spooled printing facility that is 
quite similar in its functions to those provided 
by the Spooler Status program. However, the two 
facilities are intended for two somewhat 
different groups of users--that in the Executive 
for sophisticated data processing users and that 
in the Word Processor for casual or less 
sophisticated end users. Certain adaptations 
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have been made to suit the needs of these two 
groups. The two facilities remain fully 
compatible and either may be used without 
knowledge of the other. However, the user 
already familiar with the Spooler Status program 
and the user who will be using both facilities 
should be aware of the following distinctions. 

If the name of the spooled document is 
examined from within the Word Processor, 
using the Display Print Queue option of the 
Printer Status command (CODE-P), the 
document name will be shown exactly as it is 
known to the user. If the same name is 
examined from the Spooler Program, the name 
will appear as a unique name derived from 
the document name, user name, and the time 
that the document was entered into the print 
queue. 

The Spooler program distinguishes two 
commands for removing a document from the 
print queue: Delete print request and 
Cancel print. The former is used for a 
document which has not begun printing, 
whereas the latter is used for a document 
whose printing is in progress (including the 
case where the printer is temporarily 
paused). The Word Processor merges these 
two commands into the single Cancel printing 
command which applies to both cases. 

The Spooler manages multiple print queues 
and mUltiple printers and allows a print 
queue to be served by multiple printers. 
The Spooler program has commands for 
selecting particular printers or print 
queues and performing the operations 
applicable to the selected entity. The Word 
Processor at once simplifies and restricts 
this facility by assuming that a print queue 
is served by a single printer. It offers a 
single Select printer command for selecting 
the unique combination of queue and single 
printer and, when given a command, applies 
it to the printer or queue as appropriate. 
The name used by the word processing 
operator to refer to the printer and queue 
is the "friendly" printer name defined in 
the file Sys.printers and associated with 
a particular print queue or direct printer. 



Printer Description File 

See Appendix C, "Printer Configuration," for in­
formation,about the printer description file, 
which is used for specifying printer configura­
tions. 

Designating Print Specifications 

To designate print specifications: 

1. Press PRINT (SHIFT-f4). The Print form 
appears. 

2. Enter the name(s) of the document(s) to be 
printed. If a document is currently open 
and contains the cursor, its name will auto 
matically appear in the Print form when 
Print is invoked. 

If more than one document is entered, a"," 
should be used as a delimiter to separate 
the document names. 

3. Press NEXT to move the highlight to "Number 
of copies". 

4. Specify how many copies of the document are 
to be printed. 

5. Press NEXT to move the highlight to 
"Repaginate". 

6. If the document is to be repaginated, press 
Y. Otherwise, press N. 

7. Press NEXT to move the highlight to "Pages 
to print". 

8. If individual pages are to be printed, enter 
their page numbers (in the form 1-3, 1, 2-). 

9. Press NEXT to move the highlight to "Number 
docs. separately". 

10. If more than one document is to be printed, 
specify whether or not each document is to 
be numbered separately. 
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Printer Status 
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11. Press NEXT to move the highlight to "Paper 
feed". 

12. To indicate the type of paper feed, press C 
(Continuous) or M (Manual). If M is speci­
fied, the printer will pause after each page 
is printed to allow insertion of a new piece 
of paper. 

13. Press NEXT to move the highlight to "Printer 
name". 

14. Enter printer name(s). Names of printers 
are listed after "for example". (The default 
printer is the first name on the list.) 

15. If you want to assign a priority to your 
print request, press NEXT to move the high 
light to "Priority (0-9)". Otherwise, press 
GO. 

16. Enter the desired priority number. (0 is the 
highest priority, 9 is the lowest. The 
default priority is 5.) 

17. Press GO. 

With either direct or spooled printing, the Print 
form leaves the screen. Documents are printed in 
order of priority. 

If you assigned a priority to your print request, 
the document with the highest priority will be 
printed first. (0 is the highest priority, 9 is 
the lowest.) For example, a very long document 
might be given a priority of 9, so that print 
requests for shorter documents would be honored 
first. 

After you have completed the Printer form and 
pressed GO, you can check the progress of your 
print. The Printer Status command, which you 
invoke by pressing CODE-p, displays the Printer 
Status menu shown in Figure 4-29. 



A status message, such as "Printing Page 8 of 
Status Report," appears at the top of the menu. 
This message is updated periodically to reflect 
the changing status of the printer that is iden­
tified by name next to "Printer name" on the 
menu. Possible status messages are 

Printing Page n of X (where n is a page 
number and X is a document name) 

Print queue empty 

Printing halted 

Change print wheel to X (where X is a print 
wheel name) 

Please load single-sheet paper 

Problem with printer 

PRINTER STATUS: (press CANCEL to dismiss) 

Printer name: 
Status: 

Press S to Select printer Press P to reprint from page n 
C Cancel printing -H Halt printing 

R Resume printing Q display print Queue 

Figure 4-29. Printer Status Menu. 

Certain conditions encountered by the word 
processor will cause the word processor to beep 
and display the message "Printer" on the left 
hand side of the window border just below the 
ruler. This will not interupt any work that the 
user is doing at that time. Pressing CODE-P to 
display the Printer Status menu will remove this 
message from the screen and allow the user to 
correct the printer condition that required 
attention. If the condition is not corrected, or 
the printer needs further attention, the message 
will reappear after the printer status menu has 

I been dismissed. 
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Select Printer 
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Changing print wheels, changing ribbons, loading 
paper, hardware malfunctions, and other 
conditions that require human attention can cause 
the "Printer" message to appear. 

Several Printer Status options are available. 
These options are: 

Press S to Select printer 
Press H to Halt printing 
Press R to Resume printing 
Press P to reprint from Page n 
Press C to Cancel printing 
Press Q to display print Queue 

Instructions for using these options are des­
cribed below. 

If you have access to more than one printer, 
status will be displayed for the printer you 
specified the last time you issued a print 
request. To display the status for a different 
printer, press S. The Select Printer form, shown 
in Figure 4-30, appears. 

SELECT PRINTER: (Press GO to execute, CANCEL to dismiss) 

Printer name: 
for example: Serial, Parallel, DirectSer, DirectPar, etc. 

Figure 4-30. Select Printer Form. 

1. Enter the name of the printer whose status 
you wish to display. 

2. Press GO. 

3. The Select Printer form goes away. 

4. The Printer Status menu reappears, showing 
the status of the newly selected printer. 



Half Printing 

If necessary, you can stop the printer while it 
is printing a document. For example, you may 
notice an undetected paper jam or ribbon prob­
lems. In either case, press H on the Printer 
Status menu to halt the printer. The specified 
printer stops printing after several seconds, 
and the following status message appears at the 
top of the Printer Status menu: 

Printing halted 

The printer may take a while before stopping 
because the printers have a buffer of output not 
yet printed and thus must be used up before 
halting a print. 

Resume Printing 

Reprint from Page 

To resume printing exactly where printing stopped 
when you halted the printer, press R on the 
Printer Status menu. You can also use the Resume 
Printing option when the printer has halted it 
self for a print wheel change, after loading 
paper, and for other similar conditions. 

You can use the "Reprint from Pagel! option to 
restart a halted printer at a place in the docu­
ment other than where it was halted. For example, 
if a paper jam has crumpled a page, you probably 
will want to reprint from the top of that page or 
from a previous page. This option also can be 
used to skip ahead to a page that has not yet 
been printed. Press P on the Printer Select menu 
to display the Reprint from Page form shown in 
Figure 4-31. 

REPRINT FROM PAGE: (press GO to execute, CANCEL to dismiss) 

Printer name: 
Status: 

Page number: 
(Leave blank to restart from the top of the current page) 

Figure 4-31. Reprint from Page Form. 
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1. Enter the desired page number. 

2. Press GO. 

3. The Reprint from Page form goes away. 

4. The printer restarts at the specified page. 

S. Th~ Printer Status menu reappears. 

The page number you specify should be the actual 
page number printed on that page. Thus, if your 
document begins with page 10 and you want to have 
the third page reprinted, enter the number 12, 
not the number 3. 

Cancel Printing 
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If the printer has halted with an irreparable 
problem, or if you change your mind about a 
document being printed, use the Cancel Printing 
option to remove your print request from the 
queue. Press C on the Printer Status menu to 
display the Cancel Printing form shown in Figure 
4-32. 

C~NCELPRINTING: (press GO to execute, C~NCEL to dismiss l 

Printer name: 
Status: 

Document name(s): 

Figure 4-32. Cancel Printing Form. 

1. To cancel printing for the first document in 
the queue, enter the name of that document. 

2. To cancel printing for some other document in 
the queue, enter the name of that document. 
(You can enter more than one document name; 
all will be removed frpm the print queue.) 



NOTE 

When cancelling a document that is being 
printed off a floppy, it is necessary to 
specify the volume name of the floppy. For 
instance if you have specified a print 
request for lFOj<SYS>Test and the volume name 
of the floppy is lFILESj, then in the CANCEL 
menu the file [FILES]<SYS>Test must be 
entered for the document name, not 
[FO]<SYS>Test. 

3. Press GO. 

4. The Cancel Printing form goes away. 

5. The specified documents are removed from the 
print queue. 

6. The Printer Status menu reappears. 

Cancel Printing works even if the specified doc­
ument is being printed currently. The printer 
may take a while before stopping because the 
printers have a buffer of output not yet printed 
and thus must be used up before canceling a 
print. In this case, printing resumes with the 
first document remaining in the print queue. 

You also can remove your print request from the 
queue by using the Display Print Queue option, 
described below. 

Display Print Queue 

Use the Display Print Queue option to find out 
which documents are queued for the selected 
printer. Press Q on the Printer Status menu to 
display the list of documents that are queued for 
that printer. This is a one-time rather than 
continuously updating display. For instance, if 
another document is queued up while the Print 
Queue List is displayed then that document will 
not be displayed until the Display Print Queue 
option is chosen again. (The Printer Status menu 
remains on the screen while the list is 
displayed.) Figure 4-33 is an example of a 
typical print queue list. 
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Document User Priority 
November status Report 
Weekly Report 

Fred 5 
LongUserName 9 

Time to Print 
printing 

20 min. 
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Figure 4-33. Print Queue List. 

The list displays each document name along with 
the user name of the person who made the print 
request, the document's priority, and an esti­
mated time to print. This estimated time is 
based on the length of the document and the speed 
of the selected printer. Actual printing time 
can be longer if the document requires print 
wheel changes or other human intervention, or 
excessive formatting. 

NOTE 

When printing more than one document per 
print request, the queue entry of the Printer 
Status command will only display the first 
document name followed by etc .. This is so 
the "Number docs. separately?" option will 
work. Therefore, if it is required to delete 
anyone of the documents that was queued up, 
then all the documents will have to be 
canceled by entering the name that is in the 
queue. 

You can select names in the print queue (by using 
Mark, Mark Word, Mark Line) to cancel printing. 

1. Move the cursor to the document name you want 
to remove from the print queue. 

2. Press the appropriate MARK key. 

3. The selected name is highlighted. 

4. Press C to invoke Cancel Printing. 

5. The Cancel Printing form appears with the 
selected document name already filled in. 

6. Press GO. 

7. The selected document is removed from the 
print queue. 



When you are finished with the Print Queue list, 
press CANCEL to remove it from the screen. Press 
CANCEL a second time to remove the Printer Status 
menu from the screen. 

Specifying Print Wheels 

You can change print wheels to print different 
typefaces (fonts) while a document is printing. 
When the print wheel has to be changed, the 
printer stops to allow you to insert the new 
print wheel. 

For example, the default print wheel used in the 
Word Processor is Courier 72, which has a 10-
pitch font. When a different pitch is indicated, 
such as an Elite 12 print wheel, margins and tab 
settings are adjusted accordingly. However, if 
you want the Courier 72 print wheel to print with 
12-pitch spacing, use the Pitch option of the 
Format command to change the pitch. (See 
"Changing Pitch," below.) 

The Word Processor allows you to specify various 
types of print wheels other than the print wheels 
that are part of the standard configuration. Your 
system administrator or supervisor maintains a 
file, the print wheel set, that contains the 
characteristics associated with print wheels and 
their use. A new print wheel must be defined in 
the print wheel set before it can be used.( See 
Appendix B, "Print Wheel Configuration," for a 
description of the print wheel set, and for in 
structions on how to add a new print wheel to the 
print wheel set file.) 

To specify a print wheel change (which includes a 
change of pitch) while entering text: 

1. Press FORMAT (f4) twice. The Format menu 
appears. (See Figure 4-19.)' 

2. Press W. The Print Wheel menu, shown in 
Figure 4-34, appears. Listed are the names 
of all available print wheels. If more than 
10 print wheels are available, the message 

Press W again for more choices 

appears at the bottom of the menu. Press W 
for another menu showing the remaining 
available print wheels. 
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PRINT WHEEL: (Press GO to execute, CANCEL to dismiss) 

Press 1 for Courier 72' 
2 Elite 12 
3 Cubic PS 96 
4 scientific 10 
5 Courier 10 

Note: Changing print wheel also changes pitch to the default for that wheel. 

Press 0 to change print wheel Only (and leave pitch as is) 
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Figure 4-34. Print Wheel Menu. 

3. Choose the desired print wheel by pressing 
its corresponding number. For example: 

Press 1 for Courier 72 
Press 2 for Elite 12 
Press 3 for Cubic PS 96 
Press 4 for Scientific 10 
Press 5 for Courier 10 

4. Press GO. 

5. The menu goes away. 

6. Enter text. 

During printing, when the section of the document 
is reached where the print wheel change is speci­
fied, the printer stops to allow insertion of the 
new print wheel. The Printer Status menu appears 
on the screen with the message "Change print 
wheel to X and press R to resume printing" 
(spooled printing) or "Change print wheel to X 
and press GO to continue printing. Press CANCEL 
to cancel command" (direct printing). 

T.o specify a print wheel change only, wi thout 
affecting the pitch: 

1. Press FORMAT (f4) twice. The Format menu 
appears. (See Figure 4-19.) 

2. Press W. The Print Wheel menu appears. (See 
Figure 4-34.) 



3. Press 0 to change print wheel Only. The 
Print Wheel Only menu, shown in Figure 4-35, 
appears on the screen. 

PRINT WHEEL ONLY: (Press GO to execute, CANCEL to dismiss) 

Press 1 for Courier 72 
2 Elite 12 
3 Cubic PS 96 
4 Scientific 10 
5 Courier 10 

Press B to change Both print wheel and pitch 

Figure 4-35. Print Wheel Only Menu. 

4. Choose the desired print wheel by pressing 
its corresponding number. For example: 

Press 1 for Courier 72 
Press 2 for Elite 12 
Press 3 for Cubic PS 96 
Press 4 for Scientific 10 
Press 5 for Courier 10 

5. Press GO. 

6. The menu goes away. 

7. Enter text. 

To return to the previous menu, press B. 

You also can change pitch without changing the 
print wheel. (See "Changing Pitch," below.) 

To specify a print wheel change (which changes 
the pitch) in existing text: 

1. Use the appropriate Mark (and Bound) command 
to select the text to be printed with the 
different print wheel. 

2. Press FORMAT (f4) twice. The Format menu 
appears. 
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3. Press W. The Print Wheel menu appears. 

4. Choose the desired print wheel by typing the 
corresponding number. For example: 

Press 1 for Courier 72 
Press 2 for Elite 12 
Press 3 for Cubic PS 96 
Press 4 for Scientific 10 
Press 5 for Courier 10 

5. Press GO. 

6. The Print Wheel menu goes away. If specified, 
the selected text changes to half-brightness. 

7. During printing, when the section of the doc­
ument is reached where the print wheel change 
is specified, the Printer Status menu appears 
on the screen, and the printer stops to allow 
insertion of the new print wheel. 

If an invalid print wheel name is entered, 
the following blinking message appears: 

X is not a valid print wheel name 

Specify another print wheel name and press 
GO. 

To specify a print wheel change in existing text 
without affecting the pitch: 

1. Use the appropriate Mark (and Bound) command 
to select the text to be printed with the 
different print wheel. 

2. Press FORMAT (f4) twice. The Format menu 
appears. 

3. Press W. The Print Wheel menu appears. 

4. Press 0 to change print wheel Only. The 
Print Wheel Only menu, shown in Figure 4-35, 
appears. 

5. Choose the desired print wheel by pressing 
its corresponding number. For example: 

Press 1 for Courier 72 
Press 2 for Elite 12 
Press 3 for Cubic PS 96 
Press 4 for Scientific 10 
Press 5 for Courier 10 



Changing Pitch 

6. Press GO. 

7. The menu goes away. 

To return to the previous menu, press B. 

You can also change pitch without changing the 
print wheel. (See "Changing Pitch," below.) 

The Word Processor allows you to specify a pitch 
other than the pitch that is standard for the 
print wheel currently in use. For example, if 
you a.re using the Courier 72, 10-pitch print 
wheel, you have the option of changing it to 
print as a 12-pitch print wheel. Changing pitch 
from 10 to 12 prints more characters per inch, 
leaving less space between characters. Con­
versely, changing Elite 12 printing to lO-pitch 
prints fewer characters per inch, with more space 
between characters. Page margins and tab settings 
are adjusted accordingly. 

To specify a change of pitch as text is being 
entered: 

1. Press FORMAT (f4) twice. The Format menu 
appears. (See Figure 4-19.) 

2. Press the space bar. The Pitch menu, shown 
in Figure 4-36, appears. 

3. Choose the desired pitch by typing the 
corresponding number. 

Press 8 for 8-pitch text 
Press 0 for 10-pitch text 
Press 2 for 12-pitch text 
Press 5 for IS-pitch text 

4. Press GO. 

5. The Pitch menu goes away. 

6. All the text you enter will now be printed 
with the specified pitch when the document is 
printed. 

4-105 



4-106 

To return to the standard (default) pitch: 

1. Repeat steps 1 and 2 above. 

2. Type D to choose the default print wheel. 

3. Press GO. 

4. The text you now enter will be printed in the 
standard pitch for the print wheel in use 
when the document is printed. 

PITCH: (Press GO to execute, CANCEL to dismiss) 

Press a for a-pitch text 
o lO-pitch text 
2 l2-pitch text 
5 l5-pitch text 
D Default pitch 

Figure 4-36. Pitch Menu. 

To specify a change of pitch in existing text: 

1. Use the appropriate Mark (and Bound) command 
to select the text to be printed with changed 
pitch. 

2. Press FORMAT (f4) twice. The Format menu 
appears. 

3. Press the space bar. The Pitch menu appears. 

4. Choose the desired pitch by pressing the 
corresponding number. 

Press 8 for 8-pitch text 
Press 0 for 10-pitch text 
Press 2 for 12-pitch text 
Press S for IS-pitch text 

S. Press GO. 

6. The Pitch menu goes away. The selected text 
is printed with the changed pitch when the 
document is printed. 



To return existing text from changed (non 
standard) pitch to standard (default) pitch: 

1. Use the appropriate Mark (and Bound) command 
to select the text that has the nonstandard 
pitch. 

2. Press FORMAT (f4) twice. The Format menu 
appears. 

3. Press the space bar. The Pitch menu appears. 

4. Press D for default pitch. 

5. The selected text is printed in the standard 
pitch when the document is printed. 

Changing Ribbon Color during Printing 

You can change ribbon colors while a document is 
being printed. You can specify the exact sections 
of the document in which another ribbon color is 
needed, and the printer will change ribbon colors 
accordingly. Generally, ribbon color changes are 
limited to those ribbons having red and black 
sections. The printer makes adjustments so that 
the specific section of the ribbon is struck 
during printing. When the printer is using a 
two-color ribbon, black is the default. 

Use the Format command to select an alternate 
ribbon color. (See "Format Command," above.) 

To specify an alternate ribbon color as you enter 
text: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press A for Alternate ribbon color. 

3. The Format menu goes away. 

4. Enter text. Text will appear on the screen 
in half-brightness. 

5. During printing, the ribbon color will change 
as specified. 
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To return to the original ribbon color (usually 
black), repeat steps 1, 2, and 3 above, but press 
CODE-A instead of A in step 2. 

To specify an alternate ribbon color for existing 
text: 

1. Use the appropriate Mark (and Bound) command 
to select the text that will be printed in 
another color. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press A for Alternate ribbon color. 

4. The Format menu goes away and the selected 
text appears on the screen in half­
brightness. The ribbon color will change for 
the selected text during printing. 

DOCUMENT UTILITIES 
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The Documents command 'provides the following 
document utilities. 

o Open document opens a document for creation 
or editing. 

o Delete document deletes a document from your 
directory. 

o Copy document copies an existing document and 
gives the copy a new name. 

o Rename document renames an existing document. 

o Change work area changes the work area from 
one volume (disk) directory to another. 

o List document lists documents by name or by 
date, or gives details on each document of 
page size, number of characters, date of last 
printing, and so on. 

You can use these utilities at any time during a 
word processing session. 



There are a number of subtleties of the 
implementation of the DOCUMENTS commands (e.g., 
Copy, Rename, and Delete) that are helpful to 
understand. Because of the general principle of 
the Word Processor that all operations must be 
recoverable from the typescript following a 
failure, the DOCUMENTS commands cannot in 
general be implemented by direct execution of 
the corresponding file system function. 
Instead, these commands are done· "virtually" 
during the course of a word processing session 
and completed at the time of a save (CODE-S) or 
FINISH command. Functions within the Word 
Processor such as listing the direectory of 
documents or opening documents are properly 
implemented to behave as though the "virtual" 
operation had been fully carried out. However, 
if a session fails or is terminated with 
ACTION-FINISH, then these operations will NOT 
have been carried out. If a Word Processor 
recovery is done, followed by a save, the 
pending operations will be carried out. 

Special care must be taken in using the 
DOCUMENTS commands with floppy diskettes. After 
a diskette has been accessed for an Open, 
Rename, Delete, or Copy subcommand, you must 
SAVE or FINISH before dismounting the diskette. 
(Never dismount a diskette containing a document 
currently displayed on the screen). In 
addition, if the Change Work Area subcommand is 
used to change your work area to a directory on 
a diskette, it is important to mount the 
diskette before executing the command, or 
reissue the command after the diskette has been 
mounted. If your default path (as specified by 
either the Executive Path command or by your 
name.user used by SignOn) references a diskette 
which is not mounted when you invoke the Word 
Processor, then you must execute a Change Work 
Area command after you have mounted the 
diskette. 

The Word Processor associates with a document 
information that is not understood or preserved 
by other components of Burroughs software. In 
particular, the information displayed by the 
Word Processor List documents subcommand, such 
as document length or time to print, will be 
incorrect for a document copied using the 
Executive Copy command or the Word Processor 
Copy subcommand. This is verified by the fact 
that, after the length, the symbol 11-" appears 
indicating that the length may be inaccurate. 
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However, if the document is subsequently 
modified by the Word Processor and saved, the 
correct information will be recalculated. 

If a List documents subcommand is given during a 
Word Processing session, and that session is 
subsequently recovered, the list of documents 
will appear during the recovery with the 
documents names replaced by dots. This should 
not be a subject of concern--the replacement is 
done for reasons of efficiency and it does not 
indicate any error in the recovery function. 
Note that this replacement during recovery is 
also done for the Display Print Queue subcommand 
of the Printer Status (CODE-P) command. 

The Documents command, which you invoke by 
pressing DOCUMENTS (CODE-f1), displays the Docu­
ments menu shown in Figure 4-37. The Documents 
command is automatically invoked whenever there 
are no open documents on the screen. 

DOCUMENTS: (Press CANCEL to dismiss) 

Press 0 to Open document Press W to change Work area 
D Delete document L List documents 
C Copy document 
R Rename document 

Figure 4-37. Documents Menu (#2). 

To choose a document utility: 

1. Press DOCUMENTS (CODE-f1). The Documents 
menu appears. 

2. Choose one of the following utilities by 
pressing the appropriate key: 

Press 0 to Open document 
Press D to Delete document 
Press C to Copy document 
Press R to Rename document 
Press W to change Work area 
Press L to List documents 



Open Document 

Delete Document 

For procedures on using "Open document,." see 
"Opening a Document through the Word Processor," 
above. 

If you choose "Delete document", the Delete 
Document form appears. (See Figure 4-38.) 
Deleting a document removes the current document 
as well as the "doc-Old" version. 

DELETE DOCUMENT: (press GO to execute, NEXT for next item, CANCEL to dismiss) 

Document name(s): 
Password: 

Copy Document 

Figure 4-38. Delete Document Form. 

1. Enter the name of the document to be 
deleted. (If that document is currently 
opened, its name appears in the highlight 
next to "Document name(s)". 

2. If it is necessary to enter a password: 

a. Press NEXT to move the highlight to 
"Password". 

h. Enter the password. 
c. Press GO. 

3. Otherwise, press GO. 

If you choose "Copy document", the Copy Document 
form appears. (See Figure 4-39.) The document 
specified as "Old document name" is copied. No 
documents are deleted. 
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COpy DOCUMENT: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Old document name: 
New document name: 
Password: 

Figure 4-39. Copy Document Form. 

1. Enter the name of the document that is being 
copied. (If that document is currently 
opened, its name appears in the highlight 
next to "Old document name".) 

2. Press NEXT to move the highlight to "New 
document name". 

3. Enter the name of the document that is being 
created. 

4. If it is necessary to enter a password: 

a. Press NEXT to move the highlight to 
"Password". 

b. Enter the password. 
c. Press GO. 

5. Otherwise, press GO. 

Rename Document 

If you choose "Rename document", the Rename Doc­
ument form appears. (See Figure 4-40.) The 
document specified in "Old document name" is 
renamed, but the "doc-Old" version of that 
document is deleted. 

RENAME DOCUMENT: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Old document name: 
New document name: 
Password: 

Figure 4-40. Rename Document Form. 
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1. Enter the old document name. 

2. Press NEXT to move the highlight to "New 
document name". 

3. Enter the new document name. 

4. If it is necessary to enter a password: 

a. Press NEXT to move the highlight to 
"Password". 

b. Enter the password. 
c. Press GO. 

5. Otherwise, press GO. 

Change Work Area 

If you choose "change Work area", the Work Area 
form appears. (See Figure 4-41.) 

1. Enter the name of the new volume to be 
used. (Volume is the area in the system in 
which your documents directory is located and 
in which you use the Word Processor. Note 
that the name of the volume you are in 
appears in the highlight next to "Volume".) 

2. Press NEXT to move the highlight to 
"Directory". 

3. Enter the name of the directory, which can be 
the same name you used to sign on to the 
system. 

4. If it is necessary to enter a password: 

a. Press NEXT to move the highlight to 
"Password". 

b. Enter the password. 
c. Press GO. 

5. Otherwise, press GO. 
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WORK AREA: (press GO to execute, NEXT for next item, CANCEL to dismiss) 

Volume: 
Directory: 
Password: 

List Documents 
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Figure 4-41. Work Area Form. 

If you choose "List documents", the List Docu­
ments form appears. (See Figure 4-42.) 

The List Documents form displays the names of the 
current volume, directory, and password, and asks 
for a specific type of document directory 
listing. 

You can get a directory listing of specific 
document names by specifying in the highlight 
next to "Pattern" a name containing a wild card 
character. A document name containing a wild 
card character is equivalent to a list of all the 
documents whose names match the name containing 
the wild card character. In word processing, the 
wild card character can be either a * (asterisk), 
which represents two or more characters, or ? 
(question mark), which represents one character. 

For example, suppose you have a group of 
documents in your directory whose names end in 
the characters "text": Doctext, Memotext, 
Recordstext, Lettertext, and so on. If you want 
a directory listing of only those documents, 
specify "*text" as the pattern. The Word 
Pro~essor looks through your directory for all 
names ending with "text" and then lists those 
names. 

For more information on the use of the wild card 
character, see the B 20 Executive Manual, Section 
9, "File Specification." 



LIST DOCUMENl'S: (press GO to execute, NEXT for next item, CANCEL to dismiss) 

Volume: 
Directory: 
Password: 
Pattern: 
Details: Names Dates Everything (press N, D, or E) 

Figure 4-42. List Documents Form. 
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_ ~ L ' ~ • 

trial New 
chap.3 
indents 
c rea te 
chap .4 
Section 4-New 
screens3 
mol in 
chap.2 
test 
screens 

tabbing 
x25.doc 
screens2 
testing.Lst 
chap.7 
Section 4 
test-New 
guide 
appendix.a 
help 
setindent 

.'~ii,.n;f4,Jai~ili:' 
chap.6 
checks pace 
testing 
tes t i ng .Obj 
chap.1 
help-Nelol-New 
fixing 
chap.5 
appendix.d 
out line 

Figure 4-43. Directory Listed by Names. 
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Three types of directory listings are provided. 
The "Names" option lists document names for all 
types of documents in random order. Figure 4-43 
is an example of a directory listing that was 
generated when "Names" was selected. 

'}," I I, I I , I \2' , , , I ' I I I bl I I • I I , I I I.' 1 I I I I I I I I,' I I I I I I t I I.' I I I I I I I I 1.,1 I I I I I I , I ~I I I I, 

~ L ~ 
- _",;,'8=@;;*H' 
~ ~ CJ:.A&.Wi £WLi..s..e..a ~ &in.tia 
trial-New N1 11/09/81 2/13/82 2/13/82 
tabbing N1 12/23/81 2/1'3/82 2/13/82 
chap.6 N6 1/11/82 2/13/82 2/13/82 
chap.3 N2 1/11/82 2/13/82 2/13/82 
x25.doc N31 1/13/82 2/13/82 2/13/82 
checks pace N1 1/15/82 2/13/82 2/13/82 
indents N1 12/17/81 2/13/82 2/13/82 
screens2 1 2/12/82 2/16/82 2/17/82 
testing 3 11/03/81 2/17/82 2/17/82 
create N2 12/10/81 2/13/82 2/13/82 
testing.Lst N8 1/07/82 2/13/82 2/13/82 
testing.Obj N1 1/07/82 2/13/82 2/13/82 
chap.4 N4 1/11/82 2/13/82 2/13/82 
chap.7 N3 1/11/82 2/13/82 2/13/82 
chap.1 N2 1/11/82 2/13/82 2/13/82 
Section 4-New N1 1/11/82 2/13/82 2/13/82 
Section 4 N1 1/11/82 2/13/82 2/13/82 
he Ip-New-NeH N3 2/09/82 2/13/82 2/13/82 
screens3 1 2/16/82 2/16/82 2/17/82 
test-New N1 10/23/81 2/13/82 2/13/82 
fixing NO 10/29/81 2/13/82 2/13/82 
.ain N1 10/23/81 2/13/82 2/13/82 
guide N5 1/11/82 2/13/82 2/13/82 
chap.5 N1 1/11/82 2/13/82 2/13/82 
chap.2 N5 1/11/82 2/13/82 2/13/82 
appendix.a N4 1/11/82 2/13/82 2/13/82 
appendix.d N1 1/11/82 2/13/82 2/13/82 
test N1 10/23/81 2/13/82 2/13/82 
help N4 2/10/82 2/13/82 2/13/82 
outline N2 2/10/82 2/13/82 2/13/82 

Figure 4-44. Directory Listed by Dates. 

The "Dates" option lists each document with dates 
of creation, "revision, and printing. Also listed 
for each document is the number of pages it con­
tains. Figure 4-44 is an example of a directory 
listing that was generated when "Dates" was 
selected. 



The "Everything" option ·lists each document name 
with its accessibility, length in pages and char­
acters, dates of creation, last revision, and 
last access, a~d the time it takes to be 
printed. Figure 4-45 is an example of a direc­
tory listing that was generated when "Everything" 
was selected. 

Only the name of the latest version of a document 
is listed. The name of the "doc-Old" version is 
not listed. 

, h' I I , , ' , , , \z' , , , , ' , , I I,' , , . I ' I , • I.' I I I I I I , , Is I I • I I I I I I I. I • I I I I I • I 1,' I I • J • I I I ~ I I I t I 

~ L ~ - 4 i M;;;;;;;5' a 

1rial-Hew Length: -1 pagels) 1536 character(s) 
Created: Nov 9, 1981 2:50 PM 
Revised: Feb 13, 1982 8:49 AM 
Accessed: Feb 13, 1982 8:49 AM 
Printed: 
Time to print: minute(s) 

tabbi n9 Length: -1 pagels) 1536 character(s) 
Crea ted: Dec 23, 1981 11: 18 AM 
Revised: Feb 13, 1982 8:49 AM 
Accessed: Feb 13, 1982 8:49 AM 
Printed: 
Time to print: .inute(s) 

chap.6 Length: -6 pagels) 12800 character(s) 
Created: Jan 11, 1982 2:55 PM 
Revised: Feb 13, 1982 8:49AM 
Accessed: Feb 13, 1982 8:49 AM 
Printed: 
Time to print: .inute(s) 

Length: -2 pagels) 4096 character(s) 
Created: Jan 11, 1982 2:55 PM 

chap.3 

Revised: Feb 13, 1982 8:49 AM 
Accessed: Feb 13, 1982 8:49 AM 
Printed: 
Ti.e to print: Minute(s) 

length: 
Created: 

-31 pagels) 66631 character(s) 
Jan 13, 1982 11:48 AM 

R.vised: Feb 13, 1982 8:49 AM 

Figure 4-45. Directory Listed with Everything. 
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Displayed at the end of each directory listing 
are the current number of files in the directory, 
the amount of space used in the directory (by 
number of pages and characters), and the amount 
of space left on the volume (by number of pages 
and characters). 

To obtain a directory listing: 

1. Press NEXT to move the highlight to 
"Details". 

2. Choose the desired type of listing: 

Press N for Names 
Press D for- Dates 
Press E for Everything 

3. Press GO. 

After you have chosen an option and pressed GO, 
the following message appears: 

Searching directory X. Press CANCEL to 
interrupt. 

The message goes away as soon as the directory 
listing is displayed. If there are a large 
number of documents listed it may be necessary 
to use the SCROLL UP and SCROLL DOWN keys to see 
all the documents. 

Selecting Names in the Directory 
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You can select document names in any of the three 
types of directory lists (by using Mark or Mark 
Word) for opening, renaming, copying, deleting, 
and printing options. 

1. Press L in the Documents menu to display the 
List Documents form. 

2. Use the steps described under "List Docu­
ments" to display the directory of your 
choice. 

3. Move the cursor to the name of the document 
that is to be opened, renamed, copied, or 
deleted. 

4. Press the appropriate MARK key. 



5. The selected name is highlighted. 

6. Choose the desired option from the Documents 
menu. 

7. When the appropriate form is displayed, the 
selected document name appears in the high 
light next to "Document Name(s)" (in Open 
Document and Delete Document forms) or in the 
highlight next to "Old document name" (in 
Copy and Rename forms). 

8. Press GO. 

To select a document for printing: 

1. Press L in the Documents menu to display the 
List Documents form. 

2. Use the steps described under "List Docu­
ments" to display the directory of your 
choice. 

3. Press CANCEL once to dismiss the Documents 
menu. 

4. Move the cursor to the name of the document 
to be printed. 

5. Press the appropriate MARK key. 

6. Press PRINT (SHIFT-f4) to invoke the Print 
command. 

7. When the Print form appears, the selected 
document name appears in the highlighted text 
next to "Document(s)". 

When you are finished with the Directory list, 
press CANCEL to remove it from the screen. Press 
CANCEL a second time to remove the Documents menu 
from the screen. 
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SECTION 5 

ADVANCED OPERATIONS 

This section describes the more advanced word 
processing operations such as 

0 mUltiple windows 

0 multiple documents 

0 line spacing 

0 column operations 

0 add row/column 

0 the Zoom command 

0 recovery procedures 

0 store/recall phrases 

0 the Commands function 

MULTIPLE WINDOW OPERATIONS 

Multiple Windows on a Single Document 

The Word Processor allows you to work in one or 
more sections of a single document at one time. 
For example, you can view the first page of a 
long document in a window at the top of the 
screen; you can view another part of the same 
document in another window on the same screen. 
The top window within each document is the pri 
mary window; the others are secondary windows. 
Figure 5-1 shows the screen divided into one 
primary and one secondary window of the same 
document. 

Multiple windows are separated by index tabs. 
The index tab is a shortened version of the docu 
ment status line. It displays the page number of 
the window below it and the number of the line in 
which the cursor is positioned. 
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The current window is the window containing the 
cursor. Editing operations affect the document 
in the current window. 

You can specify mUltiple windows with the Divide 
Window command, which you invoke by pressing 
CODE-d. Each time you invoke this command, the 
current window divides into two- windows. Up to 
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actIons to perform in this operation. Pressing 
GO executes the operation, pressing NEXT moves 
the highlight from item to item, and pressing 
CANCEL stops the operation. 

Figure 5-1. Document with Multiple Windows. 

seven windows can be on a screen at one time. If 
you try to create too many windows on a single 
screen, this message appears: 

Too many windows 



To remove a window, move the cursor into that 
window and press CODE-c to invoke the Close 
Window command. The window goes away, and the 
adjoining window lengthens. 

Moving the Cursor from One Window to Another 

Scrolling 

You can use the cursor control keys to move the 
cursor around a multiple window screen. Use them 
in the same way as in a single window screen. 
(See "Cursor Control Keys" in Section 4, "Basic 
Operations.") There are two exceptions: 
CODE-down arrow moves the cursor downward to the 
index tab (or document status line) of the next 
window. CODE-up arrow moves the cursor upward to 
the index tab (or document status line) of the 
previous window. 

Text can be shifted up or down within a window 
with the SCROLL UP and SCROLL DOWN keys. (See 
"Vertical Scrolling" in Section 4, "Basic 
Operations.") To scroll within a particular 
window, move the cursor to that window and press 
the appropriate scroll key. Scrolling does not 
alter the number of lines of text in the window. 

You can shift the content of one or more windows 
horizontally on the same screen by using the left 
or right arr.ow cursor. control key. (See "Hori­
zontal Scrolling" in Section 4, "Basic Opera­
tions.") 

Expanding a Window 

SCROLL UP and SCROLL DOWN also change the size of 
the window by expanding it upward or downward. 
The window expands by "borrowing" lines from 
adjoining windows. The expansion occurs only in 
the window containing the cursor. However, the 
window below or above the expanded window grows 
smaller, depending on whether the expansion is 
downward or upward. 
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For example, there are three windows on the 
screen and you want to expand the top window. 

1. Position the cursor in the index tab (or 
document status line) that is under the top 
window. 

2. Press SCROLL DOWN. 

3. The top window expands downward. (The middle 
window becomes smaller.) 

If you want to expand the middle window, you can 
either expand downward using SCROLL DOWN, or 
expand upward using SCROLL UP as follows: 

1. Position the cursor in the index tab (or 
document status line) that is above the 
middle window. 

2. Press SCROLL UP. 

3. The middle window expands upward. (The top 
window becomes smaller.) 

Multiple Documents on a Single Screen 
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You can work on several documents at the same, 
time on a single screen. Each separate document 
has its primary window. Each of these primary 
windows can be divided (as described above under 
"Multiple Windows in a Single Document") into one 
or more secondary windows. 

Figure 5-2 shows the screen divided into two 
primary windows, one for each document. 

Each primary window, representing a different 
document, is topped by a document status line 
showing the document name, page number, and 
number of the line containing the cursor. 
Secondary windows for each separate document are 
topped by the index tab showing just the page 
number of that window and the number of the line 
containing the cursor. 

You can open documents on the screen with the 
Open Document command, which you invoke by 
pressing CODE-o. (See "Opening a Document 
through the Word Processor" in Section 4.) 



Scrolling, window expansion, and cursor movement 
work the same way among mUltiple documents as 
they do among mUltiple windows of a single 
document. (See "Multiple Windows in a Single 
Document," above.) 

Moving Text from One Window to Another 

You can move text from one window to another in 
the same way as you move it within a single 
window. Text movement can be from one document to 
another document, or to and from windows within a 
single document. Movement can be in an upward or 
downward direction, from a window at the top of 
the screen to a window at the bottom, and vice 
versa. 

There are two ways to move text from one window 
to another window: 
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appears at the bottom of the screen and 
temporari Iy overlays the text. The differences 
between a form and a menu are described below. 

For exa.ple, Figure 4-1 shows the Replace inLa. The first line 
gives the name of the form and tells which 
actions to perform in this operation. Pressing 
GO executes the operation, pressing NEXT .oves 
the highlight from item to item, and pressing 
CANCEL stops the operation. . 

M 

Uertical Scrol ling 

To scrol I the text on the screen up and down, 
one line at a time, press SCROLL UP or SCROLL 
DOWN once for each line. Pressing SCROLL UP or 
SCROLL DOWN continuously scrolls the text up or 
down progressively in one-line increments. 

To scrol I the text in screen-sized increments, 
press SHIFT whi Ie pressing SCROLL UP or SCROLL 
DOWN. 

Figure 5-2. Two Documents on a Single Screen. 

- -
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o By first selecting the text to be moved, 
moving the cursor to the position where the 
text is to be placed, and then pressing MOVE. 

o By moving the cursor to the position where 
the text is to be placed, pressing MOVE, 
selecting the text to be moved, and then 
pressing GO. 

To use the first procedure, in which you make the 
selection before pressing MOVE: 

1. Use the appropriate Mark command (and Bound, 
if needed) to select and highlight the text 
to be moved from one window to another 
window. 

2. Move the cursor to the location in the other 
window where you want the selected text to 
appear. 

3. Press MOVE. 

4. The selected text moves to the cursor posi­
tion in the other window (and is deleted from 
its original location). 

To use the second procedure, in which you make 
the selection after pressing MOVE: 

1. Move the cursor to the exact place in the 
other window where you want the text to 
appear. 

2. Press MOVE. The Move prompt appears on the 
screen. (See Figure 5-3.) 

MOVE: {Press GO to execute, CANCEL to dismiss} 

Select text to be moved, then press GO to execute 

Figure 5-3. Move Prompt. 



3. Once you have pressed MOVE and the Move 
prompt is displayed, you can move the cursor 
to the beginning of the text to be moved. 
(The Word Processor remembers where the 
cursor was located when MOVE was pressed.) 
Use the appropriate Mark (and Bound) command 
to select the text to be moved. 

4. Press GO. The selected text moves to the 
position where the cursor was located when 
MOVE was pressed (and is deleted from its 
original location). 

Copying Text from One Window to Another 

You can copy text from one window to another in 
the same way as you copy it within a single 
window. Text can be copied from one document to 
another document, or to and from windows within a 
single document. You can copy in an upward or 
downward direction, from a window at the top of 
the screen to a window at the bottom, and vice 
versa. 

There are two ways to copy text from one window 
to another window: 

o By first selecting the text to be copied, 
moving the cursor to the position where the 
text is to be placed, and then pressing COPY. 

o By moving the cursor to the position where 
the copied text is to be placed, pressing 
COPY, selecting the text to be copied, and 
then pressing GO. 

To use the first procedure, in which you make the 
selection before pressing COPY: 

1. Use the appropriate Mark command (and Bound, 
if needed) to select and highlight the text 
to be copied from one window to another 
window. 

2. Move the cursor to the location in the other 
window where you want the selected text to 
appear. 

3. Press COPY. 
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4. The selected text is copied to the cursor 
position in the other window (but is not 
deleted from its original location). 

COPY: (Press GO to execute, CANCEL to dismiss) 

Select text to be copied, then press GO to execute 

Figure 5-4. Copy Prompt. 

To use the second procedure, in which you make 
the selection after pressing COPY: 

1. Move the cursor to the exact place in the 
other window where you want the text to 
appear. 

2. Press COPY. The Copy prompt appears on the 
screen. (See Figure 5-4.) 

3. Once you have pressed COpy and the Copy 
prompt is displayed~ you can move the cursor 
to the beginning of the text to be copied. 
(The Word Processor remembers where the 
curs9r was located when COpy was pressed.) 
Use the appropriate Mark (and Bound) command 
to select the text to be copied. 

4. Press GO. The selected text is copied to the 
position where the cursor was located when 
COpy was pressed (but is not deleted from its 
original location). 

LINE SPACING 
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Text is .single spaced automatically within a 
paragraph when it is first entered if you did not 
choose a different line spacing with the Format 
command. 



Format, which you invoke by pressing FORMAT (f4), 
has five line spacing options: 

o single-spaced text 

o double-spaced text 

o one and one-half spacing 

o double spaced between paragraphs and single 
spaced within the par.agraph 

o other line spacing 

These options are described in Section 4 under 
"Paragraph For.matting." However, the more 
advanced ways of using the "Other line spacing" 
option are described in this section. This option 
allciws you to specify line spacing other than the 
single, double, and one-half line spacing pro­
vided by the Format function. You can use the 
"Other line spacing" option to specify triple or 
larger spaces between paragraphs or to insert 
extra-wide spaces for future insertion of text or 
figures. 

Unless you need to format a.complex document 
(with mUltiple levels of section headings, for 
example), you can defer reading the rest of this 
section. 

When you choose the "Other line spacing" option 
by pressing a in the Format menu, the Line 
Spacing form appears on the screen. (See Figure 
5-5.) 

The Line Spacing form shows the line spacing for 
the paragraph containing the cursor and provides 
areas in which to specify line spacing. In the 
example in Figure 5-5, there is triple spacing 
before the paragraph, and double spacing within 
the paragraph. Paragraphs that have the same 
space values before and after are simple to 
specify. 

However, when a paragraph has different values 
before and after, such as double spaces before 
and triple spaces after, line spacing formatting 
can get complicated. You can specify the line 
spacing for a current document with particular 
values, which will show in the Line Spacing form 
as the current values. However, the spacing you 
see on the screen may differ from the spacing in 
the printed document. 
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LINE SPACING: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Before: 
Within: 
After: 

Example 
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Currently 
3.0 lines 
2.0 lines 
0.0 lines 

(Please enter measurements in lines) 

Figure 5-5. Line Spacing Form. 

If the first paragraph has an "after" line 
spacing of three, but the next paragraph has a 
"before" line spacing of two, the Word Processor 
compares the larger value with the smaller value, 
and the larger value takes precedence. Hence, if 
you specify line spacing of double spaces before, 
single spaces within, and triple spaces after, 
the following occurs. The triple spaces "after" 
the first paragraph take precedence over the 
double spaces of the next paragraph's "before," 
and so on, as long as these values are unchanged 
for that document. The document still retains 
the current values of double spaces before, 
single spaces within, and triple spaces after (as 
shown in the Line Spacing form). However, your 
screen and printed copy will show triple spaces 
before and after the paragraphs of that document. 

If you have an existing document that needs line 
spacing changes, follow the steps in this example 
to make the changes. 

You have a short document that contains a total 
of seven paragraphs that are double spaced before 
and after and single spaced within. Two para­
graphs need to change to quadruple spacing before 
and after and double spacing within. 

To change the line spacing: 

1. Press MARK PARA and BOUND to select the two 
paragraphs. 



2. Press FORMAT (f4). The Format menu appears. 

3. Press O. The Line Spacing form appears. 

4. Enter 4.0 (the number of spaces to appear 
before the paragraph). 

5. Press NEXT to move the highlight to 
"Within". 

6. Enter 2.0 (the number of spaces to appear 
between the lines within the paragraph). 

7. Press NEXT to move the highlight to "After". 

8. Enter 4.0 (the number of spaces to appear 
after the paragraph). 

9. Press GO. 

10. The Line Spacing form goes away, and the 
line spacing in the two paragraphs changes 
accordingly. 

In this example, note that the line spacing 
changes affect the spacing of the paragraphs on 
either side of the two changed paragraphs. The 
paragraph above the first changed paragraph still 
has line spacing specifications of double spaces 
before and after. However, the new quadruple 
spacing of the next paragraph's "before" takes 
precedence over the double spacing of the pre 
vious paragraph's "after." 

When you are inserting new text and changing line 
spacing attributes in an existing document, be 
aware of how the larger value takes precedence 
over a smaller value before and after a 
paragraph. 

COLUMN OPERATIONS 

The Word Processor allows you to select, move, 
copy, delete, and total columns of text as well 
as lines or paragraphs of text. The column 
operations deal specifically with columns that 
you create by typing tables of numbers or other 
data separated by tab characters. Columns of 
text created when you specify wide page margins 
are not affected by any of the column operations. 
It should be noted, however, that groups of 
columnar text should begin with a new paragraph. 
If this is not done, then certain operations will 
not work correctly wheri selecting columns. 
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Selecting a Column 
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Columns in a table are selected with Mark Column 
(CODE-f9). The cursor must be within a table 
when Mark Column is invoked; otherwise, the 
message 

Cursor must be in a table 

is displayed and no selection is made. 

Mark Column selects and highlights the column 
containing the cursor, as well as the tab char­
acter pertaining to that column. All text under 
the tab stop nearest the cursor is included in 
the selection. 

To select a column: 

1. Move the cursor into the specific column. 

2. Press MARK COLUMN (CODE-f9). 

The selected column is highlighted. You can use 
the selection as needed. 

You can extend a column selection to include 
several columns by pressing BOUND. The cursor 
must be within a table when BOUND is pressed, 
otherwise, the message 

Cursor must be in a table 

is displayed and the selection is not altered. 

There are two ways to expand a column selection: 

1. Press BOUND once. The cursor moves to the 
next column and the highlighted selection 
extends to include that column. Pressing 
BOUND consecutively expands the selection 
accordingly. 

2. Move the cursor to the last column within the 
table that is to be part of the expanded 
selection. Press BOUND. The selection is 
expanded automatically to include the column 
containing the cursor. 



Selecting a tine 

Moving a Column 

You can select one or more lines within a table 
using the existing Mark Line and Bound com­
mands. Commands such as Move, Copy, and Delete 
work in the usual way for selected lines. 

You can move a column of text to another position 
within the same document or to another 
document. 

When a column is moved, its corresponding tab 
stop is moved with it. (The text and the tab 
stop are deleted from their original location.) 

Tab stops are not merged when columns are 
moved. If necessary, the position of a new tab 
stop will be shifted a bit to the right to 
prevent it from coinciding with an existing tab 
stop. 

The steps provided below explain how to move 
columns within a single document. To move 
columns from one document to another, use the 
steps provided above in "Moving Text from One 
Window to Another." 

There are two ways to move a column to another 
location within a document: 

o By first selecting the column to be moved, 
moving the cursor to the position where the 
column is to be placed, and then pressing 
MOVE. 

o By moving the cur~or to the position where 
the column is to be placed, pressing MOVE, 
selecting the column to be moved, and then 
pressing GO. 

To use the first procedure, in which you make the 
selection before pressing MOVE: 

1. Select the column to be moved with Mark 
Column (and Bound, if necessary). 

2. Move the cursor to the position where the 
column is to be placed. 
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3. Press MOVE. The selected column moves to the 
cursor position (and is deleted from its 
original location). 

To use the second procedure, in which you make 
the selectione after pressing MOVE: 

1. Move the cursor to the position where the 
column is to be placed. 

2. Press MOVE. The Move prompt appears on the 
screen. (See Figure 5-6.) 

MOVE: (Press GO to execute, CANCEL to dismiss) 

Select text to be moved, then press GO to execute 

. Figure 5-6. Move Prompt. 

3. Move the cursor into the column to be moved. 

4. Select the column with Mark Column (and 
Bound, if ~ecessary). 

5. Press GO. The selected column moves to the 
position wh~re the curs6r was located when 
you pressed MOVE (and is deleted from its 
original location). 

Copying a Column 
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You can copy a column of text to another position 
within a document. When the column is copied, 
its corresponding tab stop is copied with it. 
(The text and the tab stop remain at their 
original location.) 

The tab stop is not merged when the column is 
copied. If necessary, the position of a new tab 
stop will be shifted a bit to the right to 
prevent it from cOinciding with an existing tab 
stop. 



The steps provided below explain how to copy 
columns within a single document. To copy 
columns from one document to another, use the 
steps provided above in "Copying Text from One 
Window to Another." 

There are two ways to copy a column of text 
within a document. 

o By first selecting the column to be copied, 
moving the cursor to the position where the 
copied column is to be placed, and then 
pressing COPY. 

o By moving the cursor to the position where 
the copied column is to be placed, pressing 
COPY, selecting the column to be copied, and 
then pressing GO. 

To use the first procedure, in which you make the 
selection before pressing COPY: 

1. Select the text to be copied with Mark Column 
(and Bound, if necessary). 

2. Move the cursor to the position where the 
column is to be copied. 

3. Press COPY. The selected column is copied to 
the cursor position (but is not deleted from 
its original location). 

To use the second procedure, in which you make 
the selection after pressing COPY: 

1. Move the cursor to the position where the 
copied column is to be placed. 

2. Press COPY. The Copy prompt appears on the 
screen. (See Figure 5-7.) 

3. Move the cursor into the column to be copied. 

4. Select the column with Mark Column (and 
Bound, if necessary). 

5. Press GO. The selected column is copied to 
the position where the cursor was located 
when COpy was pressed (but is not deleted 
from its original location). 
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COPY: (Press GO to execute, CANCEL to dismiss) 

Select text to be copied, then press GO to execute 

Figure 5-7. Copy Prompt. 

Deleting a Column 

You can delete a column of text from a table 
along with its corresponding tab stop. Other 
columns (and their tab stops) within the same 
table are not affected when a column is 
deleted. You can delete several columns within 
the same table at once by using Bound with Mark 
Column as described under "Selecting a Column." 

To delete a column: 

1. Select the column to be deleted with Mark 
Column (and Bound, if necessary). 

2. Press DELETE. The column is removed. 

Clearing a Line or a Column 
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You can clear a single line or a single column. 
Clearing deletes the selected line or column but 
leaves the corresponding tab stops in place. 

Clearing is useful in conjunction with totaling a 
line or column. (See the section "Totaling a 
Line or a Column" below.) 

For example, in a table where the last line 
contains the totals for each of the columns, you 
can easily remove only the totals but leave the 
rest of the column intact. This feature is help­
ful when you are inserting more entries into a 
table and the columns must be totaled again for 
a new total. 



To clear a line or column: 

1. Use Mark Line (and Bound, if needed) to mark 
the line to he cleared, or 

2. Use Mark Column (and Bound, if needed) to 
mark the column to be cleared. 

3. Press CODE-DELETE. 

4. The selected line or column is deleted. 
However, the tab characters and tah stops for 
those entries are left in place. 

The cleared line or column continues to exist in 
the table and can be filled in again with new 
text entries. 

ADD ROW/COLUMN 

The Add Row/Column feature (CODE-=) of the Word 
Processor(WP) is actually a generalized 4-funct­
ion math expression evaluator. When CODE-= is 
depressed, the WP will evaluate each entry of 
the table within the current selection before 
summing up the entries. This means that if 
all the entries in a table are simply numbers, 
then the Add Row/Column feature will simply add 
up the selected rows or columns. If, however, 
there are entries which are expressions, the WP 
will evaluate them before including the result 
into the sum. 

An expression does not have to occur in a table 
before it can be evaluated. If you s~lect an 
expression within your text and press CODE-=, 
the expression will be evaluated and the result 
displayed at the bottom of the screen. 
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An "expression" can contai,n any of the 
following: 

0 numbers 
0 + plus sign 
0 minus sign 
0 * mUltiply sign 
0 x multiply sign 
0 X multiply sign 
0 / divide sign 
0 mod modulus sign 
0 $ dollar sign 
0 ¢ cent sign 
o· i'o percent sign 
0 M half sign 
0 ~ fourth sign 
0 () parentheses 
0 <> debit signs 
0 decimal point 
0 comma 
0 space 

Therefore any of the following are valid 
expressions together with their computed 
results: 

$10,343.50 - 10,000.00 
34 + 54¢ 
23M - 10¢ 
<54 - 32> 
(123 * 49800)/(4 + (-10*3» 
100000/3 
100000.000/3 
100000.00000/3 
100000/3.00000 
(100 + 43) * 10% 
«234 - 23) x 53%) 
345.45-
-345.45 
345.45+ 
+345.45 
25 mod 6 
27 mod 6 
12 mod 3 

$343.50 
$34.54 
$23.40 
-22 
-235592.31 
33333.33 
33333.333 
33333.33333 
33333.33333 
14.30 
-111.83 
-345.45 
-345.45 
345.45 
345.45 
1 
3 
o 



Note that the number of digits displayed in the 
fraction of the result is determined by the 
maximum number of digits of precision of the 
supplied operands. If this number is less than 
two, and the result has a non-zero fraction, two 
digits of fraction will be displayed in the 
result . 

. Also note that parentheses which enclose the 
entire expression are taken as a debit sign, 
negating the result. 

If the word processor encounters an expression 
which is malformed, it will do one of two things. 
If the selection contains other expressions, the 
word processor will go ahead and evaluate all 
other expressions, add them up, and display the 
result at the bottom of the screen together with 
the message "Selection contains n invalid 
entries". If the selection contains no other 
expressions, then a message will display at the 
bottom of the screen describing what it is about 
the expression which makes it malformed. For 
example, here are some malformed expressions 
together with the messages they generate. 

(345 + 34 - 98) + 86/(40 - 23 - 17) 

Cannot divide by zero: 86/(40 - 23 - 17) 

456 x 988ef 

ef is not a valid operator 

anc54 

Number expected near anc 

345 / (15 mod 35.3) 

Operand must be an integer: 15 mod 35.3 

(3455 + 453) / 9345) 

Unmatched ) in expression 
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Totaling a Line or Column 

You can total numbers in a single line or in a 
single column within a table. A line is totaled 
across; a column is totaled downward. 

To total a line or column of numbers: 

1. Select the line with Mark Line, or 

2. Select the column with Mark Column. 

3. Press CODE-+. 

4. The total' is displayed in the Add Row/Column 
form. (See Figure 5-7.) 

5. The displayed total is highlighted as a 
selection and you can copy it out of the form 
by using Copy. 

If any of the entries in the line or column is 
invalid, the message 

Value must be a number less than 65535 

is displayed. Otherwise, the entire line or 
column is totaled. 

ADD ROW/COLUMN: (Press CANCEL to dismiss) 

Sum: 

Figure 5-8. Add Row/Column Prompt. 

ZOOM COMMAND 
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The Zoom command, which you invoke by pressing 
CODE-z, switches the content of the screen 

,_ between 80 columns of text and 132 columns of 
text. 



This command works only on a B 22 workstation, 
which can display up to 132 columns of text on 
the screen. If you press CODE-z on a B 21 
workstation, the follow~ng message appears: 

Cannot ZOOM with this type of worksta~ion 

When the" screen expands to 132 columns, the size 
of the characters decreases. (Figure 5-9 is an 
example of a 132-column screen.) 

~ ." \" II b" I 'I" , I b'l II I" II ~I I I 'I' I I I b' I I I I' I I I ~I II 'I'; I I bill '1111 I ~I t I 'I 

~ L ~ 

ScrHn Size 

TIlt size of the screen depends on the type 
of Morkshtion being used. A B 22 
IIOrkshtion screen displays up to 34 lines 
that tin be 80 to 132 columns in Midth. 
TIlt ZOOIl cOllnland (see Section 5) is used to 
s.i tch the contents of the scretn bebleen 
80 colulns of text and 132 colu,nns of text. 

IIItn the screen content expands to 132 
colUllins. the size of the characters grOMs 
proportionately suller. 

Figure 5-9. I32-Column Screen. 

- -
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Screen Size 

The size of the screen depends on the type 
of workstation being used. A B 22 
workstation screen displays up to 34 lines 
that can be 80 to 132 columns in width. 
The Zoom command (see Section 5) is used to 
switch the contents of the screen between 
80 columns of text and 132 columns of text. 

When the screen lontent expands to 132 
columns, the size .of the characters grows 
proportionately smaller. 

Figure 5-10. SO-Column Screen. 

If the screen is displaying 132 columns, Zoom 
contracts the screen from 132 columns of text to 
80. In this case, the size of the characters 
increases. (Figure 5-10 is an example of an 80-
column screen.) 

RECOVERY PROCEDURES 
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The Recover procedure protects your documents 
against loss or damage caused by, for example, a 
power failure or the accidental pressing of the 
power button. Recovery is possible because the 
Word Processor maintains a special document, the 
typescript, of all work done during a session. 



When you invoke the Word Processor after such a 
failure, the following message appears: 

Your last session did not finish success­
fully. Press GO to recover, CANCEL to start 
a new session. 

Pressing GO invokes the recovery and you will see 
an "instant replay" on the screen of your 
previous word processing session. The Word 
Processor replays all the entering and editing 
performed on your document and stops at the point 
in the session when the failure occurred. 

You can interrupt recovery by pressing CANCEL, 
which causes the following message to appear: 

Recovery suspended 

Press GO to continue the recovery, or CANCEL to 
end it. 

When recovery is complete, or when you press GO 
twice, the following message appears: 

Recovery complete 

You can then open your documents and proceed with 
the word processing session. 

You also can invoke recovery through the Execu­
tive with the Recover command, whether or not a 
failure occurred. Enter "Recover" in the Execu­
tive command form. (See Figure 5-11.) The pre­
vious word processing session is replayed on the 
screen. 
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Selection 

Password 

Day /Date/Time 

Selection 
Password 

(Current day/date/time shown here) 

Enter an application name or leave this line blank 
to display a Command form. 

Enter your assigned password (optional). 

Enter the current day, date and tim'e (if not already set). 

.. , 

"(henpi'8$StheGO ~~.; 

Day/Date/Time (e.g., Man 6/21/82 8:00 am) 

Command 

Figure 5-11. Executive Command Form, Recovery. 

STORE/RECALL PHRASE 
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The Store/Recall Phrase feature provides the user 
with away of assigning short names to commonly­
used text strings ("phrases") in such a way that 
the long string may be recalled and inserted into 
a document by typing the short phrase name. 
Phrases may contain arbitrary formatting, 
including paragraph and page marks; indeed, 
storing a paragraph mark as a phrase is a 
convenient way to remember a commonly-used group 
of format settings (e.g. justified, double 
spaced, first line indented) for easy access 
later. 



Phrase names and their associated phrases are 
stored together in a single file. The name of 
this phrase file is specified by each user in 
his or her .user file, as follows: 

:WpPhrases:[vol]<dir>PhraseFileName 

Phrases are added to the phrase file with the 
Store Phrase command. First enter the text of 
the phrase into a document (e.g. "The Wall Street 
Journal") and select the Phrase text. Press 
STORE PHRASE (shift f7) and the STORE PHRASE 
command form is displayed. (See figure 5-12). 

STORE PHRASE: (Press GO to execute, CANCEL 
to dismiss) 

Phrase name: 

Figure 5-12. Store Phrase Form. 

Enter the desired phrase name (e.g. "wsj") and 
press GO. The selected text is entered in the 
phrase file under the given phrase name. If 
there is already a phrase by that name, the 
following message is displayed: 

Press GO to redefine phrase X, CANCEL to 
cancel command 

where X is the phrase name. Press GO to confirm 
overriding the previous definition of X. 

Stored phrases may be recalled using the Recall 
Phrase command. Recall Phrase may be used in two 
ways. As you are entering text, at the point 
where you wish to include a phrase expansion, 
press Recall Phrase (f7) and the Recall Phrase 
command form is displayed. (See figure 5-13). 

RECALL PHRASE: (Press GO to execute, CANCEL 
to dismiss) 

Phrase name: 

Figure 5-13. Recall Phrase Form. 
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Enter the desired phrase name and press GO. The 
given phrase name is looked up and expanded at 
the cursor position. If no phrase by that name 
is found, the message 

There is no phrase named X 

is displayed. 

Formatting attributes of the expanded phrase are 
combined with the formatting attributes currently 
in effect for insertion, as shown in the Format 
menu under "Current:". That is, if the Format 
menu shows "Underlined" text and the phrase as 
stored contains bold text~ the expansion comes 
out both bold and underlined. 

Alternatively, Recall Phrase may be used to 
expand a phrase name which already appears in 
exisiting text. Select the existing phrase name. 
Press Recall Phrase. No command form is 
displayed in this case; rather, the selected 
phrase name is immediately replaced by its 
expansion. The attributes of the replacement 
text are determined by combining the attributes 
of the selected phrase name and of the stored 
phrase as described above. As before, if no 
phrase by that name is found, a message so 
informing the user is displayed. 

To remove phrases or list phrases in the phrase 
file see the "Remove Phrase" and "List Phrases" 
subsections under the section "Commands Function" 
below. 



COMMANDS FUNCTION 

I 
! 

The Commands function allows you to access 
certain advanced word processing operations as 
well as other programs while in the Word 
Processor. For example, these operations are 

0 Document Exchange 

0 Mail 

0 Multiplan 

0 Picture Editor (Business Graphics Package) 

0 Sort/Select 

0 Merge 

0 Spelling Checker 

The Commands function also allows you to go 
directly to the Executive from the Word Processor 
without having to FINISH the word processing 
session. 

When you invoke th~ Commands function by pressing 
COMMANDS (CODE-f7), the Commands menu appears on 
the screen. (See Figure 5-14.) 

COMMANC6: (Press CANCEL to dismiss) 

Press D for Document Exchange 
E Electronic Mail 
M Mul tiplan 
P Picture Editor 
X Execu t ive 

S Sort/Select 
G Merge 
TAB Reformat Tabs 

Press C 
V 
L 
U 
H 
R 
I 

to Check Spelling 
View Dictionary 
Load Personal Dictionary 
Unload Personal Dictionary 
Hyphena te Word 
Remove Phrase 
LIs t Phrases 

Figure 5-14. Commands Menu. 
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To choose an operation from the Commands menu: 

1. Press COMMANDS (CODE-f7). The Commands menu 
appears. 

2. Choose one of the operations by pressing the 
appropriate key. For example: 

Press D 
Press E 
Press M 
Press P 
Press X 
Press S 
Press G 
Press TAB 
Press C 
Press V 
Press L 
Press U 
Press H 
Press R 
Press I 

for Document Exchange 
for Electronic Mail 
for Multiplan 
for Picture Editor 
for Executive 
for Sort/Select 
for Merge 
to Reformat tabs 
to Check Spelling 
to View Dictionary 
to Load Personal Dictionary 
to Unload Personal Dictionary 
to Hyphenate Word 
to Remove Phrase 
to List Phrases 

Document Exchange 

Electronic Mail 
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For procedures on using "Document Exchange", see 
the "Document Exchange Format" subsection below. 

If "Electronic Mail" is chosen, the Mail form 
appears on the screen. (See Figure 5-15.) 

MAIL: (Press GO to execute, CANCEL to dismiss) . 

[To] : 
[Attach]: 

Figure 5-15. Mail Form. 



Multiplan 

1. Press GO to invoke Electronic Mail. 

2. Any documents that are currently opened are 
saved, the word processing session finishes, 
and Mail's initial display appears on the 
screen. 

If you are signed on to the Electronic Mail 
system and you have new mail arrive during a 
word processing session, or have any mail 
that has not been put into your "in tray" 
when you start a word processing session, the 
message "Mail" or "Urgent Mail", as 
appropriate, will, be displayed on the left 
hand side of the window border just below the 
ruler. These messages will remain until you 
enter the Electronic Mail system and read the 
new mail into your "in tray". 

If "Multiplan" is chosen, the Multiplan form 
appears on the screen. (See Figure 5-16.) 

MULTIPLAN: (Press GO to execute, CANCEL to dismiss) 

Figure 5-16. Multiplan Form. 

1. Press GO to invoke Multiplan. 

2. Any documents that are currently open are 
saved, the word processing session finishes, 
and Multiplan's initial display appears on 
the screen. 
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Picture Editor 

If "Picture Editor" is chosen, the Picture Editor 
form appears on the screen. (See Figure 5-17.) 

PICTURE EDITOR: (press GO to execute, CANCEL to dismiss) 

Picture file: 

Executive 

Merge 

Sort/Select 
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Figure 5-17. Picture Editor Form. 

1. Press GO to invoke the Picture Editor. 

2. Any documents that are currently open are 
saved, the word processing session finishes, 
and the Picture Editor's initial display 
appears on the screen. 

If "Executive" is chosen, any documents that are 
currently opened are saved, the word processing 
session finishes, and the Executive command form 
appears on the screen. (See Figure 5-11 in this 
section, and Section 3 of the Executive Manual, 
"Filling in a Form.") 

For procedures on using "Merge", see the "Merge" 
subsection in Section 6, "List Processing." 

For procedures on using "Sort/Select", see the 
"Sort/Select" subsection in Section 6, "List 
Processing." 



Tab 

Documents created under 1.0 WRITEone handle tabs 
differently then in the current version. 
Therefore, if a 1.0 document is brought up that 
has tabs, the user should perform this operation 
so that the tahs will align correctly. 

CAUTION 

The Reformat Tabs command should be run on 
only documents last SAVEd on version 1.0 
WRITEone. In addition, this command should 
only be executed once on these documents. 

If it is required to run Reformat Tabs on a large 
number of documents, it is not necessary to enter 
the word processor and type CODE-f7 TAB for each 
one. This feature also works in a batch mode as 
a command from the executive. This allows you to 
create submit files to run overnight (for example) 
which will convert large sets of documents. 

This utility is invoked by entering "Fix Tabs" on 
the command line in the executive. The executive 
form will then prompt the ,user for a document or 
documents to be reformatted, saved, and,then the 
utility will exit to the executive. The document 
as well as status messages will be displayed 
while a document is being reformatted. As many 
as seven documents may be reformatted at one 
time. 

To implement this feature, the user must create a 
new command called "Fix Tabs" as follows: 

New Command 
Command name 'Fix Tabs' 
Run File [sys]<sys>WordProcessor.run 
Field Names 'Document(s), 
Description 'Reformat tabs from 1.0 to 3.0' 
[Overwrite ok?] 

NOTE 

The command name entered should be "Fix Tabs", as 
the word processor is specifically looking for 
that command name to inform it that it is to 
perform a batch Reformat Tabs operation. 
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Spelling Checker 

Remove Phrase 

For procedures on using the Spelling Checker and 
its associated operations, "View Dictionary," 
"Load Personal Dictionary," "Unload Personal 
Dictionary," and "Hyphenate Word," see Section 7, 
"Spelling Checker." 

This command is used to delete phrases from the 
phrase file. When this command is invoked the 
Remove Phrases form will be displayed. (See 
Figure 5-18). 

REMOVE PHRASE: (Press GO to execute, CANCEL to dismiss) 

Phrase name: 

Figure 5-18. Remove Phrase Form. 

To remove a phrase from the phrase file: 

1. Fill in the name of the phrase to be removed. 

2. Press GO. 

If there is no phrase with that name, or any 
other problems are encountered, appropriate 
messages and instructions will be displayed. 

Phrase names in form letters: 
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During a Merge operation, if a form letter 
contains a keyword which is not found in the 
supplied records file, the word processor will 
look to see if the keyword is a phrase name. If 
so, it will treat it as a phrase name, 
substituting the associated phrase text. 



List Phrases 

This command is used to display a listing of all 
or part of the phrase file. When this command is 
invoked the List Phrases form is displayed. (See 
figure 5-19.) 

LIST PHRASES: (Press GO to execute, CANCEL to dimiss) 

Pattern: 
Details: Names Expansions (Press N or E) 

Figure 5-19. List Phrases Form. 

To display a listing of phrases: 

1. Fill in the Pattern line with: 

a. The name of a specific phrase. This will 
display a single phrase. 

or 

b. The wild-card character '*'. This will 
display all phrases in the phrase file. 

or 

c. A combination of characters and wild­
card(s). This will display a portion of 
the phrases in the phrase file. 

2. Select one of two choices under Details. 
Selecting the 'Names' displays only the names 
of the phrases that match the given pattern 
and selecting 'Expansions' displays both the 
names of the phrases matching the given 
pattern and the text that the phrase expands 
to. 

3. When the desired pattern and details have 
been entered, press GO. 

The list of phrases and details will be 
displayed on the screen. If any problems are 
encountered, appropriate messages will be 
displayed. 
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SECTION 6 

LIST PROCESSING 

The Word Processor's list processing oper~tions 
are Merge and Sort/Select. You can use Merge to 
merge text from one file into another. Use 
Sort/Select to sort and/or select specific 
records of a file before the file is merged. 

One of the most common list processing applica­
tions is the creation of mailing lists of names 
and addresses that are merged with a form 
letter. You can specify that an entire mailing 
list be merged, or that only parts of it be 
merged. Also, you can have the mailing list 
sorted alphabetically or numerically before it is 
merged with the form letter. 

List processing requires three components: 
records files, form documents, and the commands 
used to sort, select, merge, and print the final 
output. The records files and the form documents 
are standard word-processing documents. 

For example, you might be sending to 200 people a 
form letter in which only the name, address, and 
greeting differ in each letter. The records file 
contains the names, addresses, and greetings that 
are merged into the form letter. The form letter 
contains specific areas into which the contents 
of the records file are merged. The Merge com­
mand merges the records file into the form letter 
and then prints 200 copies of the letter. Each 
copy of the letter contains a different name, 
address, and greeting. If addresses in only a 
specific geographic area are to receive the 
letters, the Sort/Select command sorts or selects 
the records file to obtain the specific records 
to be merged. 
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RECORDS FILES 

Template Record 

6-2 

A records file is a text document containing a 
list of records, each of which contains zero or 
more fields. In list processing, a record is 
defined as a contiguous group of related items, 
and each item is represented by a single field. 
A field is a group of related characters, sepa­
rated by a special symbol, that represent a 
single unit. (These special symbols, when acting 
as separators, also are called delimiters.) 

Each record and field is defined with a special 
character or symbol. Records start with the 
record start character: for example, an fll" 
(exclamation symbol). Fields start with the 
field start character: for example, a "/" 
(slash). Any character or symbol (except a 
paragraph symbol, new page symbol, or space) can 
be used as a record start or field start 
character. However, they must be used consis­
tently within the records file in which they are 
defined. 

The first two characters of a records file are 
always the record start character and the field 
start character of the template record. 

The first record of any records file is called 
the template record. The template record defines 
the record start and field start characters. It 
al~o defines the symbolic field name, or keyword, 
an~ establishes the correspondence between the 
keyword and the positions within the record for 
all records in the file. Each keyword represents 
the actual data that is merged into the form 
letter during the merge operation. A keyword can 
represent a word, a phrase, or a paragraph. You 
will be using keywords when you create the form 
letter into which the records data is merged. 

The records file can contain any number of key 
words not found in the form letter with which it 
is merged. 



Example of a Records File 

Figure 6-1 is an example of a records file con­
sisting of the template record and two text 
records. The template record defines the record 
start character, the field start character, and 
the keywords. The two subsequent records contain 
the actual names and addresses that can be merged 
into a form letter. 

l/FirstName/lnitial/LastName 
/Address 
/City/State/Zip 

l/John/A./Johnson 
/210 Elm Street 
/Centervi11e/CA/92900 

Ithis is a comment 

l/Mary/J./Jones 
/1299 Main Street 
/Springda1e/NJ/11688 

Figure 6-1. Example of a Records File. 

In this example,re~ord start and field start 
characters for this records file are, respec­
tively, "!" and "/". The first record in the 
file is the template record, which has seven 
fields. Each field represents a particular item 
in the record. The first field of the template 
record has the keyword "FirstName". Each first 
field in subsequent records contains an actual 
first name that will be inserted into the form 
letter. The second field of the template record 
has the keyword "Initial". Each second field in 
subsequent records is the middle initial of the 
name that will be inserted into the form letter. 

Any text in a records file that is between a 
record start character and the next record start 
or field start character is ignored. This 
feature allows you to insert comments into the 
records file. 
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In Figure 6-1, note the third entry 

Ithis is a comment 

This entry has a record start character but no 
field start character. It is placed between its 
own record start character and the record start 
character for the next record in the file. Hence, 
it is considered to be a comment, and it will not 
be used for any list processing operations. 

Special characters such as blanks, commas, forced 
page symbols, new page symbols, paragraph 
symbols, and new line symbols surrounding record 
start and field start characters are ignored. 
Therefore, you can use these characters freely to 
format the records file in any way you like. 
These same special characters cannot be placed 
within a keyword in the template record. How­
ever, a special character placed in a keyword in 
a form letter acts as a delimiter. 

A keyword must not contain an embedded blank 
(space inserted with the spacebar). However, 
corresponding text in subsequent records can 
contain an embedded blank. For example, the 
keyword "Address" ·in the template record can 
correspond to "10 Main Street" in subsequent 
records. However, the keyword "First Name" in 
the template r~cord cannot be used because it 
contains an embedded blank. The keyword 
"FirstName" should be used instead. 

A keyword can contain up to .20 characters. 
However, this limitation does not apply to the 
number of characters in the text that the 
keyword represents. 

FORM DOCUMENTS 
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Form documents are the documents into which the 
data in the records file is merged. The form 
letter can contain any of the keywords defined in 
the template record of the records files to 
indicate where the information represented by the 
keyword will appear in the printed letter. 



Example of a Form Letter 

Figure 6-2 is a typical form letter created with 
word processing. The keywords representing the 
information to be merged into the letter are 
underlined here for visibility. 

FirstName Initial LastName 
Address 
City State Zip 

Dear Mr. LastName: 

I am pleased to inform you that you are the lucky winner of a 
FREE trip to sunny Hawaii! All your neighbors in City will 
be green with envy when you and the entire LastName family 
take off this winter for two lovely weeks in the Islands. 

We will be contacting you very soon, Mr. LastName, to tell 
you more about your exciting vacation. 

Sincerely, 

Vista Travel Services, Ltd. 

Figure 6-2. Example of a Form Letter. 

The keywords in the above letter are the same 
keywords that are contained in the template 
record of the records file that will be merged 
with the letter. The keywords are replaced at 
merge time with data from the corresponding 
fields of the records file. 

A keyword can appear more than once ina given 
form letter. Every time the keyword appears, it 
is replaced in the printed letter with the same 
text value. For example, in the form letter in 
Figure 6-2, the same "LastName" keyword appears 
four times. Each time, the same last name 
appears in the printed letter. 
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If a keyword in a form document does not have a 
corresponding keyword in the template record of 
the specified records file, no merge operation 
occurs. Instead, the following statistics for 
the merge operation are printed: 

Records file lvol]<dir>filename cannot be 
merged with this form letter. Its template 
record does not contain the keyword X. 

Records file(s) provided 
lvolJ<dir>filename 

Number of these record(s) found to be 
useable: 0 

Total number of records (in the useable 
files): 0 

o record(s) successfully merged 
. 1 records file(s) rejected 

In the records files used, 0 record(s) 
rejected or skipped. 

Specifying Keywords in a Form Document 
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Keywords are specified in a form document with a 
special keyword format option. It is the "Merge 
Keyword" option in the Format command. (See 
Figure 6-3.) 

To specify a keyword as you enter it in a form 
letter or document: 

1. Press FORMAT (f4). The Format menu appears. 

2. Press K for "merge Keyword". 

3. Enter the keyword text. It appears in half­
brightness. 

To indicate the end of a keyword after it is 
entered: 

1. Press FORMAT (f4).. The Format menu appears. 

2. Press CODE-K to remove the keyword attribute. 

3. The Format menu goes away. Subsequent text 
is entered in normal brightness. 



FORMAT: (Press CANCEL to dismiss) 

Current: * Normal Text 
* Le ft Fl ush 

* Courier 72 * lO-pitch 
* Single Spaced 

Press D for Boldface text Press '" for Superscript text 
Underlined text Subscript text 
Double-underlined text A Alternate ribbon color 

S Struck-out text K merge Keyword 

or CODE and indicated key to remove attribute 

Press N for Normal text Press FORMAT again for more choices 

Figure 6-3. Format Menu, Part 1. 

To specify existing text to be a keyword: 

1. Use the appropriate Mark (and Bound) command 
to select the text for a keyword. (See 
"Selections" in Section 4, "Basic 
Operations.") 

2. Press FORMAT (f4). The Format menu appears. 

3. Press K for "merge Keyword". 

4. The Format menu goes away. The selected text 
changes to half-brightness. 
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To change a keyword in existing text back to 
normal tex~: 

1. Use the appropriate Mark (and Bound) command 
to select the keyword. 

2. Press FORMAT (f4). The Format menu appears. 

3. Press CODE-K to remove the Keyword attribute. 

4. The Format menu goes away. The selected text 
returns to normal brightness. 

Formatting Keywords 

The character formatting attributes (underline, 
boldface, and so on) of the text that replaces 
the keyword at merge time come from two sources. 
They are the attributes of the keyword as it 
appears in the form letter, plus the attributes 
of the text within the records file. For 
example, if the keyword in the letter is in bold 
face and the corresponding text in the records 
file is underlined, the replacement text is in 
boldface and is underlined. 

A keyword can have more than one character attri­
bute. Before or after you have specified a key 
word in a form letter, you can give it any of the 
formatting options of the Format command. (See 
"Character Formatting" in Section 4, "Basic 
Operations.") 

Reserved Keywords 
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Some reserved keywords have been predefined by 
the Word Processor. These keywords expand to 
their predefined text when the form document is 
printed. Reserved keywords do not have to be 
defined in a records file. 

You can specify a reserved keyword in the form 
document by using the "merge Keyword" option of 
the Format command. Reserved keywords are listed 
in Table 6-1. 

Whenever you want the current date and/or time to 
be printed, enter the keywords "date" or "sdate" 
and/or "time" in the appropriate place in the 
form document. The current date or time is 
merged into the form document at merge time and 
appears in the printed copies. 



MERGE 

The keyword "date" causes the date to appear in 
the printed document in long format (for example, 
December 18, 1982). The keyword "sdate" causes 
the date to appear in the printed document in 
short format (for example, 12-18-82). 

The current time always appears as 8:15 am, or 
10:05 pm. 

Table 6-1. Reserved Keywords. 

Expansion Keyword 

date 

sdate 

Current date in long format. 

Current date in short format. 

time 

sequence 

Current time. 

Sequence number of the 
current record. 

The keyword "sequence" shows the sequence number 
of the current successfully merged record. For 
example, you might have a records file containing 
40 records. Each record is sequentially numbered 
1 through 40. If you specify the keyword 
"sequence" in the form letter that is merged with 
the records file, the sequence number of each 
successfully merged record appears in the printed 
letter that corresponds to it. 

You invoke the Merge operation with the Merge 
command through the Commands function. 

To invoke Merge: 

1. Press COMMANDS (CODE-f7). The Commands menu 
appears on the screen. (See Figure 6-4). 
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COMMANC6: (Press CANCEL to dismiss) 

Press D for Document Exchange Press C to Check Spelling 
E Elec tron ic Ma il V View Dictionary 

L Load Personal Dictionary 
U Unload Personal Dic tionarj 

M Mul tiplan 
P Picture Editor 
X Executive H Hyphena te ivord 

R Remove P hr ase 
S Sort/Select I LIst Phrases 
G Merge 
TAB Reformat Tabs 

Figure 6-4. Commands Menu. 

2. Press G to choose the Merge command. The 
Merge form appears on the screen. (See 
Figure 6-5.) 

:-tERGE: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Form name: 
Records file (s): 
Number of records to skip: 0 
Paper feed: Continuous Manual (Press C or H) 
P r in te r name: 

for example: Serial, Parallel, DirectSer, Directpar, etc. 
Priority. (0-9) 

Figure 6-5. Merge Form. 

Records from the records file(s) are merged with 
the form document. You can specify more than one 
records file to be merged with a single form docu­
ment. As each record is processed, a new copy of 
the form letter is made. The new copy starts at 
the top of a new page whose page number is one, 
unless the form contains a "forced page number" 
attribute. (See' "Page Formatting" in Section 4, 
"Basic Operations.") 



Pagination of each completed form letter occurs 
automatically. However, you can change this 
pagination by inserting forced page breaks within 
the form letter when it is. first created. 

You can use the "Number of records to skip" 
option to skip the first n useable records in the 
records file, if necessary. This option can be 
useful if a previous merge operation was not 
completed, and you want to start again without 
repeating the letters that already have been 
done. 

For spooled printing, the form letters or docu­
ments are queued for printing in batches of 50. 
Each batch appears in the print queue as 
"FormNamel-SO", "FormName5l-l00", and so on. If 
the disk becomes full, smaller batches are 
created. (FormName represents the name you have 
given to that particular form letter.) 

Any bad records that are found during Merge are 
flagged with a message such as "Field X does not 
exist." These messages, together with a copy of 
the. record that caused them, are collected in a 
log that is printed at the end of the merged 
output. 

When the merge operation has completed and the 
form letters have been printed, the following 
statistics are printed. 

Records file(s) provided 

[voll<dir>filename 
Number of these records file(s) found to be 
useable: n 

Total number of records (in the useable 
files): n 

n record(s) successfully merged 
n records file(s) rejected 
In the records files used n record(s) 
rejected or skipped 

To merge a records file with a form letter: 

1. Enter the name of the form letter next to 
"Form name". 

2. Press NEXT to move the highlight to "Records 
file(s)". 
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3. Enter the name of the records file(s). 

4. Press NEXT to move the highlight either to 
"Number of records to skip" or to "Paper 
feed". 

5. If needed, enter "Number of records to skip". 

6. If needed, specify the "Paper feed" option by 
pressing C or M for "Continuous" or 
"Manual". ("Continuous" is the default.) 

7. Press NEXT to move the highlight to "Printer 
name". 

8. Enter the printer name. 

9. If you want to change the printer priority, 
press NEXT. (The default is 5.) Otherwise, 
press GO. 

10. Specify the printer priority. Highest 
priority is 0; lowest priority is 9. 

11. Press GO. 

SORT/SELECT 
You may need only a selected portion of your 
records file merged with a particular form 
letter. Similarly, you may wish to have the 
records file sorted with respect to certain 
fields. The Sort/Select command does both 
operations. You invoke Sort/Select through the 
Commands function. 

Invoking the Sort/Select Command 
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To invoke Sort/Select: 

1. Press COMMANDS (CODE-f7). The Commands menu 
appears on the screen. (See Figure 6-4.) 

2. Press S to choose Sort/Select. The 
Sort/Select form appears on the screen. (See 
Figure 6-6.) 



SORT /SELECT: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Records from file(s): 
Records to file: 

Selection test 1: 
Select on field: 
Field value(s): 
Keep/ discard the records? Keep Discard (Press K or D) 

Selection test 2: 
Select on field: 
Field value(s): 
Keep/ discard the records? Keep Discard (Press K or D) 

Selection test 3: 
Select on field: 
Field value(s): 
Keep/ discard the records? Keep Discard (Press K or D) 

Primary sort field: 
Sort type: Ascending Descending (Press A or D) 
Secondary sort field: 
Sort type: 

Select 

Ascending Descending (press A or D) 

Figure 6-6. Sort/Select Form. 

You specify the records file to be sorted and/or 
selected with "Records from file(s)". Specify 
the file into which selected and/or sorted 
records are placed with "Records to file". The 
file(s) that you specified in "Records from 

'file(s)" does not have to be currently dis­
played. 

Records can be selected without being sorted. 
Records can be sorted without being selected. 

You specify the records to be selected by filling 
in the keyword for a field in the blank next to 
"Select on Field" under "Selection test 1, 2, or 
3". Specify the allowed values for that field in 
the next "Field value(s)" blank. Ranges of 
values are allowed (for example, 10-200, 900-, 
CA-NY). 
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Suppose you want only last names starting with A 
through J in an address list to be merged into a 
form letter. Under "Selection Test 1", specify a 
keyword called "LastName" for "Select on field" 
and A-J for "Field value(s)". Then press K 
(keep) to include these records in the file. 
Only last names starting with A to J are merged 
into the form letter at merge time. If you want 
last names starting with A to J and living only 
in California, you specify "Select on field" and 
"Field value(s)" under "Selection test 1" and 
"Selection test 2". First, under "Selection test 
1", specify the keyword "LastName" for "Select on 
field" and A-J for "Field value(s)". Then, under 
"Selection test 2," specify the keyword "State" 
for another "Select on field" and "CA" for its 
"Field value(s)". 

To select specific records in a records file 
(without specifying Sort): 

1. Invoke the Sort/Select command. (See 
"Invoking the Sort/Select Command," above.) 
The Sort/Select form appears on the screen. 
(See Figure 6-6.) 

2. Next to "Records from file(s)", enter the 
name of the record file (or files) from which 
the records are to be selected. 

3. Press NEXT. 

4. Next to "Records to file", enter the name of 
the file that will contain the selected 
records. 

5. Press NEXT. 

6. Under. "Selection test 1", enter the keyword 
of the field to be selected next to "Select 
on field". 

7. Press NEXT. 

8. Next to "Field value(s)", enter the value 
(for example, 1-10, A-G). 

9. Press NEXT. 

10. Enter K to keep selected records or enter D 
to discard selected records. 



Sort 

11. If no more fields are to be selected, press 
GO. Otherwise, repeatedly press NEXT to move 
the highlight to "Select on field" under 
"Selection test 2" and repeat steps 6 through 
11 as needed. 

After GO is pressed, the message 

Press GO to create X, CANCEL to dismiss 

appears at the top of the Sort/Select form. X is 
the name of the "Records to file" that is being 
created to contain the selected records. Press 
GO to create the file. 

If the selected records are going to a file that 
already exists, the message 

Press GO to overwrite X, CANCEL to dismiss 

appears at the top of the Sort/Select form. X is 
the name of the "Records to file" that is being 
overwritten to contain the selected records. 
Press GO to overwrite the file. 

TECHNICAL NOTE 

DUring the Select operation, each record is 
tested to see if the value of the named field 
matches one of the specified values (the 
field values specified for a particular field 
are ORed together). Records that pass the 
test for a specified field are either kept or 
discarded from the resultant set, depending 
upon whether you specified K for "keep" or D 
for "discard." Tests on subsequent fields 
will further reduce this set. If none of the 
"Select on field" blanks are filled in, all 
records specified in the "Records from 
file(s)" are selected. 

Selected records are sorted according to the 
values found in the field that is specified in 
"Primary sort field". 

The sort can be either ascending or descending: 
For example, an alphabetic sort in ascending 
order sorts from A through Z; an alphabetic sort 
in descending order sorts from Z through A. 
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The sort is stable: that is, records of equal 
sort value appear in the same sequence when they 
are output as when they were input. Two methods 
of sorting are used; numeric and lexicographic 
(see Glossary). A field is sorted numerically if 
its keyword in the template record of the records 
file is preceded by a # symbol. Otherwise, the 
field is sorted lexicographically. 

The result of a Sort/Select operation is a valid 
records file. In particular, it includes a copy 
of the template record found at the beginning of 
the input records file. 

You can specify a two-level sort by filling in 
the "Secondary sort, field" wi th another 
keyword. Groups of records whose primary field 
values are equal are sorted within the group 
according to the values of the secondary field. 

If neither "Primary sort field" nor "Secondary 
sort field" is specified, no sorting occurs. 

You can specify a sort of more levels than are 
provided in the Sort/Select form by repeating the 
Sort/Select command to the same set of records. 
In this case, it is necessary to sort on the 
least significant level first, ending with a sort 
on the most significant level. 

To sort specific records in a records file 
(without doing a Select): 

1. Invoke the Sort/Select command. (See 
"Invoking the Sort/Select Command," above.) 
The Sort/Select form appears on the screen. 
(See Figure 6-6.) 

2. Next to "Records from file(s)", enter the 
name of the records file (or files) from 
which the records are to be sorted. 

3. Press NEXT. 

4. Next to "Records to file", enter the name of 
the file that will contain the sorted 
records. 

5. Press NEXT several times to move the 
highlight to "Primary sort field". 

6. Enter the keyword of the primary field to be 
sorted. 



7. Press NEXT. 

8. Press A for ascending sort or press D for 
descending sort. 

9. If a secondary sort is not needed, press 
GO. 

10. Otherwise, press NEXT. 

11. Next to "Secondary sort field", enter the 
keyword of the secondary field to be sorted. 

12. Press NEXT. 

13. Press A for ascending sort or press D for 
descending sort. 

14. Press GO. 

After GO is pressed, the message 

Press GO to create X, CANCEL to dismiss 

appears at the top of the Sort/Select form. X is 
the name of the "Records to file" that is being 
created to contain the sorted records. Press GO 
to create the file. 

If the sorted records are going to a file that 
already exists, the message 

Press GO to overwrite X, CANCEL to dismiss 

appears at the top of the Sort/Select form. X is 
the name of the "Records to file" that is being 
overwritten to contain the sorted records. Press 
GO to overwrite the file. 

Sorting and Selecting a Records File 

A sort and a select can be performed on the same 
records file in the same fields. For example, 
suppose you have a records file consisting of 
names and addresses of people living in the three 
Pacific Coast states: California, Oregon, and 
Washington. However, you want to send form 
letters only to people living in California whose 
addresses are in alphabetic order by city. 
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In this case, under "Selection test 1", specify 
the keyword representing the state in "Select on 
Field" and specify a "Field value(s)" of CA. You 
want to keep these records in the "Records to 
file", so you press K. Next, specify the keyword 
representing the city in the '''Primary sort field" 
and specify an ascending sort by pressing A. 
Then, press GO. 

'The resulting records file contains a list of 
only California addresses, listed in order from A 

"through Z by city. 

EXAMPLES OF LIST PROCESSING APPLICATIONS 

Example 1 
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The following pages describe three examples that 
show how list processing is commonly used. 

The first example is a typical letter into which 
names, addresses, and some other data are 
merged. The form letter, records file, and 
printed letter are described. 

The second example describes a records file that 
has specific fields selected. Both the "Records 
from file" and the resulting "Records to file" 

.are illustrated. 

The third example describes a records file that 
is sorted on both primary and secondary sort 
fields. Both the "Records from file" and the 
resulting-"Records to file" are illustrated. 

This example is a typical semipersonal form 
letter produced with list processing. Figure 6-7 
shows how the printed letter appears with the 
personalized information inserted in specific 
places. The inserted text is underlined here for 
visiblity. 



Ms. Joanne R. Kramer 
4025 West Laurel Street 
Weston, cr 06810 

Dear Ms. Kramer: 

Thank you for your check in the amount of $75.00. We at WXYZ 
sincerely appreciate your generous donation. 

Friends like you, Ms. Kramer, help us to reach our goal of 
raising $450,000 h3' September 30th, 1982 to expand our 
programming facilities. 

Sincerely, 

WXYZ -- YOUR PUBLIC TELEVISION STATION 

W. J. FARMER 
Program Director 

Figure 6-7. Typical Printed Form Letter. 

The underlined information in the above letter is 
contained in the first record of a records file. 
(See Figure 6-8.) 

The information from the first record of the 
above records file appears in the letter shown in 
Figure 6-7. The other printed copies of the 
letter contain information from subsequent 
records. 

Figure 6-9 is the form letter that was used to 
produce the printed letter shown in Figure 6-7. 
The keywords are underlined for visibility and 
correspond to the keywords in the template record 
of the records file in Figure 6-8. 
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l/Title/First/Initial/Last 
/Address 
/City/State/Zip 
/Donation 

l/Ms./Joanne/R./Kramer 
/4025 West Laurel Street 
/Weston/CT/068l0 
/$75.00 

l/Mr./~rthur/M./Pendragon 
/98 South Cornwall Place 
/West Haven/CT/06866 
/$100.00 

l/Mrs./Lynette/P./Harrison 
/12387 Limestone Road 
/Ridgefield/CT/06434 
/$24.00 

Figure 6-8. Typical Records File. 

Title First Initial Last 
Address 
City, State Zip 

Dear Title Last: 

Thank you for your check in the amount of Donation. We at 
WXYZ sincerely appreciate your generous donation. 

Friends like you, Title Last, help us to reach our goal of 
raising $450,000 by September 30th, 1982 to expand our 
programming facilities. 

Sincerely, 

WXYZ -- YOUR PUBLIC TELEVISION STATION 

W. J. FARMER 
Program Director 

Figure 6-9. Form Letter Showing Keywords. 
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Example 2 

The short records file described here contains a 
sample mailing list of names and addresses of 
people living in central California. Only those 
names and addresses with zip codes beginning with 
94 and 95 are needed for a mass mailing of form 
letters. The field containing the zip code will 
be selected to be kept in the new records file 
that will be used for the mailing. Figure 6-10 
shows the template record and the eight records 
of the records file, which is named "CentralCal". 

To obtain the list of names and addresses within 
the 94 and 95 zipcode areas, use the Sort/Select 
command in the following way. 

1. Specify the records file CentralCal as the 
"Records from file(s)". Press NEXT. 

2. Specify the "Records to file" with the name 
"Zip9", which will contain the selected 
records. Press NEXT. 

3. Under "Selection test 1", specify the keyword 
"Zip" (which represents the zip code field) 
next to "Select on field". Press NEXT. 

4. Specify 94000-95999 next to "Field value(s)" 
because you want only zip codes starting with 
94 and 95. Press NEXT. 

5. Press K for "Keep" because you want all 
records containing those zip codes to be 
included in the file "Zip9". 

6. Press GO. 

The new "Records to file", Zip9, is created (or 
overwritten) and includes only the selected 
records containing the 94 and 95 zip codes. In 
this example, four records in the CentralCal file 
were selected and placed in the Zip9 records 
file. Figure 6-11 shows the template record and 
the four records of the Zip9 file. 
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1/Tit1e/FirstName/LastName 
/Address 
/City/State/Zip 

1/Mr./Robert/Ke11y 
/34 North Park Street 
/oakda1e/CA/96400 

l/Ms./Anna/Stone 
/120 Market Avenue 
/santa C1ara/CA/95050 

1/Ms./Cathy/Mi11er 
/P. O. Box 7779 
/Mi11brae/CA/94133 

l/Mr./Arthur/Grant 
/80 South 6th Street 
/Ho11ister/CA/91008 

1/Miss/E11en/Easton 
/2216 Buena Vista Lane 
/Monte Sereno/CA/95123 

l/Mrs./J./Goodfriend 
/4 Northeastern Pkwy. 
/Tracy/CA/93003 

1/Mr./Phi1ip/Peters 
/1110 Main Avenue 
/Pa10 A1to/CA/94006 

!/Ms./Tracy/Wi1kins 
/14 West Elm Road 
/Moraga/CA/98765 

Figure 6-10. Example of a Records File. 



Example 3 

1/Tit1e/FirstName/LastName 
/Ad~ress 
/City/State/Zip 

!/Ms./Anna/Stone 
/120 Market Avenue 
/Santa C1ara/CA/95050/ 

1/Ms./Cathy/Mi11er 
/P. O. Box 7779 
/Mi11brae/CA/94133 

1/Mrs./E11en/Easton 
/2216 Buena Vista Lane 
/Monte Sereno/CA/95123 

1/Mr./Phi1ip/Peters 
/1110 Main Avenue 
/Pa10 A1to/.CA/94006 

Figure 6-11. Example of a File Containing Selected Records. 

The records file in this example is another 
sample mailing list of names and addresses of 
people living in most of the 50 states. You want 
this list to be in alphabetic order, from A to 
Z, by state and by last names within each 
state. In this example, the records file to be 
sorted is named IStateList" and the records file 
being created to contain the sorted records is 
named ISortedList". Figure 6-12 shows the 
template record and the eight records in the 
StateList records file. 
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I/Title/FirstName/LastName 
/Address 
/City/State/Zip 

I/Mrs./Anna/Jackson 
/P. O. Box 4 
/Central Valley/IA/70111 

I/Mr./Richard/Kelly 
/99 South Market Street 
/Birmingham/AL/67783 

I/Mr./Robert/Greene 
/456 Second Avenue 
/Santa Clara/CA/95055 

I /Ms. / Joan/Smi th 
/375 Nut Tree Drive 
/Cedar/GA/87765 

I/Ms./Diana/Levine 
/988 Riverside Drive 
/New York/NY/10086 

I/Mr./Peter/Stewart 
/4 West Sunnyoaks/ 
/Gridley/CA/92101 

!/Ms./Mary/Wright 
/1212 Main Street/ 
/Huntsville/AL/45678 

I/Mrs./Arlene/Thompson 
/74-26 East 10th Street 
/Berkeley/CA/95338 

Figure 6-12. Example of a Records File Before Sorting. 

To sort the StateList records file by state and 
last name, do the following: 

1. Specify StateList as the "Records from 
file(s)", which is your original records 
file. Press NEXT. 

2. Specify SortedList as the "Records to file", 
which is where the sorted records will go 
after the sort. Press NEXT. 
highlight reaches the "Primary sort field". 



3. No fields need be selected, so you can skip 
the "Selection test" area of the Sort/Select 
form by consecutively pressing NEXT until the 

4. Specify the keyword IIState ll in the IIPrimary 
sort field ll

• Press NEXT. 

5. Press A for IIAscending ll because you want the 
sort to be from A to Z. Press NEXT. 

6. Specify the keyword IILastName ll in the 
IISecondary sort field ll

• Press NEXT. 

7. Again, you want the sort to be from A to Z, 
so press A for IIAscending". 

8. Then press GO. 

The sort operation will sort the StateList 
records file and put all the records in 
alphabetic order, first by state and then by last 
name. 

These sorted records go into the SortedList 
records file, which then can be used as needed. 

Figure 6-13 shows the SortedList records file. 
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1/Tit1e/FirstNarne/LastNarne 
/Address 
/City/State/Zip 

1/Mr./Richard/Ke11y 
/99 South Market Street 
/Birmingharn/AL/67783 

l/Mrs./Mary/Wright 
/1212 Main Street 
/Huntsvi11e/AL/67890 

l/Mr./Robert/Greene 
/456 Second Avenue 
/Santa C1ara/CA/95055 

l/Mr./Peter/Stewart 
/4 West Sunnyoaks 
/Grid1ey/CA/92101 

1/Mrs./Ar1ene/Thornpson 
/74-26 East 10th Street 
/Berke1ey/CA/95338 

l/Mrs./Joan/Smith 
/375 Nut Tree Drive 
/cedar/GA/87765 

!/Mrs./Anna/Jackson 
/P. O. Box 4 
/Centra1 Va11ey/IA/70111 

!/Ms./Diana/Levine 
/988 Riverside Drive 
/New York/NY/10086 

Figure 6-13. ,Example of a Sorted Records File. 



SECTION 7 

SPELLING CHECKER 

NOTE 

This feature is only available with the Dictionary option. 

The spelling checker allows you to check the 
spelling of each word in an open document and to 
correct any misspelled words that are found. 

The spelling checker has 

o two dictionaries for checking words 

o several options for correcting misspelled 
words 

o an autohyphenation option 

o an automatic correction option 

You can invoke the spelling checker at any time 
during a word processing session. Your document 
is checked one word at a time. When a misspelled 
word is found, you are given several options for 
correcting that word. 

DICTIONARIES 
The spelling checker checks against two diction­
aries to find misspelled words: a shared common 
word dictionary and a personal dictionary. 

Common Word Dictionary 

The common word dictionary contains 76,000 
commonly used words. It can be shared by other 
users within the same cluster. You can view any 
part of this dictionary, but you cannot make any 
changes to its contents. The common word 
dictionary is internal and is accessible only if 
the spelling checker is installed. 
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Personal Dictionary 

The personal dictionary is an optional dictionary 
that is keyed to the individual user. Its 
purpose is to provide a dictionary that contains 
words that do not appear in the common word 
dictionary. For example, there are certain words 
that are used in specific environments, such as 
in the computer and electronics industries, that 
may not be in the common word dictionary. You 
can put these words in your personal dictionary 
to be used by the spelling checker in the same 
way as the words in the common word dictionary 
are used. . 

After you create your personal dictionary, 
install it with the "Load Personal Dictionary" 
option of the Commands function. Once your 
personal dictionary is installed, you can view 
any part of it and make changes to its 
contents. 

Creating Your Personal Dictionary 
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Before you create your personal dictionary, 
contact your system administrator to find out if 
your internal user profile (.user file) contains 
the name for your personal dictionary. If your 
user profile has no such entry, you will not be 
able to install your personal dictionary. 

You create your personal dictionary in the same 
way as you would create any other word processing 
document. The only difference between your 
personal dictionary document and a standard word 
processing document is that once your personal 
dictionary is installed in the spelling checker, 
it assumes a different name. That name is taken 
from your internal user profile. 

For example, suppose you create a document named 
"MyDictionary" that contains the entries to your 
personal dictionary. When you install 
"MyDictionary" as your personal dictionary, it 
assumes the name specified for it in your 
internal user profile (.user file). The original 
document, "MyDictionary," still exists in your 
directory as a normal word processing document. 



To create your personal dictionary, 

1. Create a new document. (Use either the Open 
Document command or the "Open Document" 
option of the Documents command.) 

2. Enter the words that you need for your 
personal dictionary. You can enter the words 
in any order. If you are unsure of the 
spelling of a word, do not put that word in 
the document until you make sure it is 
spelled correctly. 

Use the Discretionary Hyphen command (CODE­
hyphen) to insert discretionary hyphens in any 
words that have two or more syllables. (See 
"Special Characters" in Section 4, "Basic 
Operations.") Make sure that hyphenation is 
correct. 

You can add more words to your personal 
dictionary while you are correcting misspelled 
words. (See "Spelling Correction Options" 
below.) 

Your personal dictionary can contain up to 250 
words. If the number of words reaches 250, the 
message 

Personal dictionary is full 

is displayed at the bottom of the screen. You 
should unload the contents of your personal 
dictionary and create a new one. (See "Unloading 
Your Personal Dictionary," below-.) 

Installing Your Personal Dictionary 

After you create your personal dictionary 
document, install it with the "Load Personal 
Dictionary" option of the Commands function. 
To install your personal dictionary, 

1. Press COMMANDS (CODE-f7) to invoke the 
Commands function. The Commands menu, shown 
in Figure 7-1, appears on the screen. 
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COMMANDS: (Press CANCEL to dismiss) 

Press D for Document Exchange Press C to Check Spelling 
E Electronic Mail V View Dictionary 
M Multiplan L Load P~rsonal Dictionary 
P Picture Editor U Unload Personal Dictionary 
X Execu t ive H Hyphenate vlord 

R Remove Phrase 
S Sort/Select I LIs t Phrases 
G Merge 
TAB Reformat Tabs 

Figure 7-1. Commands Menu. 

2. Press L to invoke the "Load Personal Diction­
ary" option. The Load Personal Dictionary 
form, shown in Figure 7-2, appears on the 
screen. 

LOAD PERSONAL DICTIONARY: (press GO to execute, CANCEL to dismiss) 

From docwnment: 
Keep old dictionary contents? Yes No (Press Y or N) 

Figure 7-2. Load Personal Dictionary Form. 

3. Next to "From document", enter the name of 
the document that contains the words for your 
personal dictionary. (The name of the "From 
document" is filled in automatically if the 
document is open and contains the cursor.) 



4. Press NEXT. 

5. If you wish to keep the contents of the old 
dictionary, choose "Y" for "Keep old 
dictionary contents". In this case, the 
words from the "From document" will be added 
to the words in the old dictionary. 

6. If you press "N" to choose No for "Keep old 
dictionary contents", the words in the "From 
document" will replace the words in the old 
dictionary. (The default is no.) 

7. Press GO. 

The message 

Loading dictionary . 

appears on the screen. When your personal 
dictionary has been installed, the Load Personal 
Dictionary form goes away, and the message 

Dictionary load complete. n words loaded 

appears on the screen. (n represents the number 
of words placed in your personal dictionary.) 

If the document containing the words for the 
dictionary is still open and displayed on the 
screen, press CODE-c (Close Window) to close the 
document and remove it from the screen. 

When you use the spelling checker to correct 
misspelled words, you can add entries to your 
personal dictionary. (See "Spelling Correction 
Options" below to find how to add these entries.) 

Unloading Your Personal Dictionary 

You can move the contents of your personal 
dictionary to another document with the "Unload 
Personal Dictionary" option of the Commands 
function. 

The "Unload Personal Dictionary" option either 
creates either a new document for the purpose of 
unloading your personal dictionary, or overwrites 
the contents of an existing document. 
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To move the contents of your personal dictionary, 

1. Press COMMANDS (CODE-f7) to invoke the 
Commands function. The Commands menu appears 
on the screen. (See Figure 7-1.) 

2. Press U to invoke the "Unload Personal 
Dictionary" option. The Unload Personal 
Dictionary form, as shown in Figure 7-3, 
appears on the screen. 

UNLOAD PERSONAL DICTIONARY: (Press GO to execute, CANCEL to dismiss) 

To document: 

Figure 7-3. Unload Personal Dictionary Form. 

3. Enter the name of the document that is to 
contain the contents of your personal 
dictionary. 

4. Press GO. 

The message 

Unloading dictionary . 

appears at the bottom of the screen. When the 
operation is completed, the Unload Personal 
Dictionary form goes away and the message 

n words unloaded 

appears at the bottom of the screen. 

Note that the contents of your personal 
dictionary are not deleted by the "Unload 
Personal Dictionary" option. To delete the 
contents of your dictionary, choose "No" for 
"Keep old dictionary contents" in the "Load 
Personal Dictionary" option the next time you 
load your personal dictionary. 



INVOKING THE SPELLING CHECKER 

You can use the spelling checker whenever you 
need it. It does not matter if you are in the 
middle of typing your document, or if the docu­
ment is completed. You invoke the spelling 
checker with the "Check Spelling" option of the 
Commands function. 

To invoke the spelling checker, 

1. Open the document in which the spelling is to 
be checked. 

2. Press COMMANDS (CODE-f7) to invoke the 
Commands function. The Commands menu appears 
on the screen. (See Figure 7-1.) 

3. Press C to invoke the "Check Spelling" 
option. The Check Spelling form, shown in 
Figure 7-4, appears on the screen. 

CHECK SPELLING: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Automatic Correction? Yes No (press Y or N) 

Figure '-4. Check Spelling Form. 

The "Automatic correction" option works only with 
your personal dictionary under certain 
conditions. You choose "Yes" for this option if 
those conditions exist. (See "Automatic Correc­
tion" option below.) 

If you choose "No" for the "Automatic Correction" 
option, you have the choice of various options to 
use for correcting the misspelled word manually 
when it is found. (See "Spelling Correction 
Options," below.) 
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When you press GO to start the spelling check, 
your document is checked word by word against 
both the common word dictionary and the personal 
ddctionary. The message 

Verifying spelling 

is displayed at the bottom of the screen. 

When a word is found that does not match any word 
in either dictionary, the message goes away. The 
word is highlighted in the document, and either 
the Word Not Found in Dictionary menu (see Figure 
7-5) or the Substitute Word menu (see Figure 7-
8), appears on the screen. 

If the Word Not Found in Dictionary menu appears 
on the screen, the highlighted word either is 
misspelled or is an uncommon word that was not 
included in the either dictionary. 

WORD NOT FOUND IN DICTIONARY: (Press CANCEL to cancel command) 

Press S to Skip 
E Enter in personal dictionary 
C Correct manually and check correction 
R Correct manually and remember correction 
V View dictionary 

Figure 7-5. Word Not Found in Dictionary Form. 

SPELLING CORRECTION OPTIONS 
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There are several different ways in which you can 
handle the highlighted word after it is found 
and the Word Not Found in Dictionary menu is 
displayed. 

You can press 1 to choose the "Skip and proceed" 
option if you want the word to remain as it 
appears in the document. This option is useful 
if you know that the highlighted word is cor­
rectly spelled and does not have to be placed ~n 
your personal dictionary. Choosing "Skip and 
proceed" removes the highlight from the word and 
allows the spelling check to continue. 



You can press 2 to choose the "Skip and save in 
Personal Directory" option if you want the word 
to remain as it is and be saved in your personal 
directory. (Note that this option works only ~f 
you have installed your personal dictionary.) 
You might use this option to place a word in your 
personal dictionary that you know is spelled cor­
rectly and will appear again in your document. 
Choosing "Skip and save in Personal Dictionary" 
removes the highlight from the word and allows 
the spelling check to continue. 

You can press 3 to choose the "Correct manually 
and check correction" option if you want to 
correct the word and then have it checked again 
against the dictionaries. When you choose this 
option, the Correct and Recheck Form appears on 
the screen. (See Figure 7-6.) 

CORRECT AND RECHECK: (press GO to accept, CANCEL to dismiss) 

Make correction: 

Reminder: Use discretionary hyphen to indicate desired hyphenation points. 

Figure 7-6. Correct and Recheck Form. 

The misspelled word is displayed in the highlight 
next to "Make correction". Correct the word and 
then press GO. The corrected word is checked 
against the dictionaries. If the word is found 
in either of the dictionaries, it is assumed to 
be spelled correctly. If so, four things occur 
on the screen. 

1. The highlighted word in the document is 
corrected automatically. 

2. The highlight goes away. 

3. The Correct and Recheck form goes away. 

4. The spelling check resumes. 
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If the corrected word is not found in either of 
the dictionaries, the Word Not Found in Diction­
ary menu again appears on the screen. (See Figure 
7-5.) If you think you may have misspelled the 
word again, you can" choose the "Correct manually 
and check correction" option a second time and 
make another correction. Or, you can choose 
another option. 

You can press 4 to choose the "Correct manually 
and Save correction" option if you want to 
correct the word and then have it saved in your 
personal dictionary. When you choose this 
option, the Correct and Save form appears on the 
screen. (See Figure 7 - 7 . ) 

CORRECT AND SAVE: (Press GO to accept, CANCEL to dismiss) 

Make correction: 

Reminder: Use discretionary hyphen to indicate desired hyphenation points. 
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Figure 7-7. Correct and Save Form. 

The misspelled word is displayed in the highlight 
next to "Make correction". Correct the word and 
then press GO. The corrected word is saved and 
placed in your personal dictionary. Four things 
occur on the screen: . 

1. The highlighted word in the document is 
corrected. 

2. The highlight goes away. 

3. The Correct and Save form goes away. 

4. The spelling check resumes. 

The Correct and Recheck form and the Correct and 
Save form display a reminder to insert a discre­
tionary hyphen in the word you are correcting to 
indicate desired hyphenation points. This 
procedure is to ensure that all words in the 
document have discretionary hyphens. If in the 
future you use the Review Documents command to 



Substitute Word 

hyphenate the document, the words will be hyphen 
ated automatically. (See "Review Documents" in 
Section 4, "Basic Operations.") 

When you correct and save a word with the 
"Correct manually and save correction" option, 
the correction is saved in your personal dic­
tionary together with the original, correctly 
spelled word. For example, suppose the word 
"workstation" is in your personal dictionary. 
However, in the document being checked, the word 
is consistently misspelled as IIworkstatoin." 

When the spelling checker first finds this mis­
spelled word, the checking stops, and you are 
given the choice of the various correction 
options. You choose the "Correct manually and 
save correction" option, correct the word, and 
press GO. Five things occur: 

1. The highlighted word in the document is 
corrected. 

2. The highlight goes away. 

3. The Correct and Save form goes away. 

4. The spelling checker places the misspelled 
word, "workstatoin," in your personal 
dictionary and pairs it with the correctly 
spelled word, "workstation." 

5. The spelling check resumes. 

The next time the spelling checker finds 
"workstatoin" in your document, it displays the 
Substitute Word menu, shown in Figure 7-8. 

SUBSTITUTE WORD: (Press CANCEL to cancel command) 

Suggested correction: 

Press S to Skip 
C Correct manually and check correction 
A Accepted suggested correction 
V View dictionary 

Figure 7-8. Substitute Word Menu. 
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In the highlight next to "Suggested correction 
is:" is the suggested correct spelling of the 
misspelled word that was just found. When the 
the spelling check resumed, the misspelled. word 
was found and compared with the previous mis­
spelling of the same word. The word is mis­
spelled the same way as it was before, and it 
matches the previous correction. 

You can press 6 to choose the "Accept suggested 
correction and proceed" option, or you can 
choose any of the other options. If you choose 
the "Accept suggested correction and proceed" 
option, four things occur. 

1. The highlighted word in the document is 
corrected. 

2. The highlight goes away. 

3~ The Substitute Word menu goes away. 

4. The spelling check resumes. 

If you choose any of the other options offered in 
the Substitute Word menu, the option works in the 
same way as it does with the Word Not Found in 
Dictionary menu. 

Automatic Correction 
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When you invoke the spelling checker and the 
Check Spelling form appears on the screen, you 
can specify "Yes" to choose the "Automatic 
Correction" option. However, you can use this 
option only under the following conditions: 

o Your personal dictionary is installed. 

o You already corrected a specific word by 
using the "Correct manually and save 
correction" option, and your personal 
dictionary has a paired entry for that 
word. (See "Substitute Word," above.) 

o You are checking a document that contains the 
same word that you corrected before and is 
still misspelled the same way throughout the 
document. 



For example, suppose you invoke the spelling 
checker to check another document that has "work 
station" misspelled as "workstatoin." You already 
corrected the same misspelled word in a previous 
doctiment and your personal dictionary contains 
the misspelled and corrected words as a pair. 

When you choose "Yes" for the "Automatic 
Correction" option, the spelling checker looks 
for the matched pair of words (workstation -
workstatoin) in the personal dictionary as soon 
as it finds the first occurrence of "work 
station." When the matched pair is found, the 
spelling checker corrects automatically all 
occurrences of "workstatoin." You can see the 
corrections being made as the spelling checker 
proceeds through your document. 

Viewing a Dictionary 

You have three ways to invoke the "View 
Dictionary" option to see the contents of the 
dictionaries. 

You can invoke the Commands function and press V 
to choose the "View Dictionary" option. Or, if 
the Word Not Found in Dictionary menu or the 
Substitute Word menu is displayed, you can press 
5 to choose the "View Dictionary" option. 

The "View dictionary" option lets you see one 
word or a group of words as they appear in the 
common word dictionary or in your personal 
dictionary. -

To invoke the "View Dictionary" option through 
the Commands function, 

1. Press COMMANDS (CODE-f7) to invoke he 
Commands function. The Commands menu appears 
on the screen. (See Figure 7-1.) 

2. Press V to invoke the "Vi~w Dictionary" 
option. The View Dictionary form, shown in 
Figure 7-9~ appears on the screen. 
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VIEW DICTIONARY: (Press GO to execute, CANCEL to dismiss) 

Search for: . 

Reminder: 3 or more letters followed by a * will display string of words. 

Figure 7-9. View Dictionary Form. 

3. In the highlight next to "Search for", type 
the word you want to view, or type three or 
more letters followed by a * (asterisk) for 
a list of all words beginning with those 
letters. 

4. Press GO. 

To invoke the "View Dictionary" option from the 
Word Not Found in Dictionary menu or from the 
Substitute Word menu (see Figures 7-5 and 7-8): 

1. Press V to invoke the "View Dictionary" 
option. 

2. The "View Dictionary" form appears on the 
screen. (See Figure 7-9.) 

3. In the highlight next to "Search for", type 
the word you want to view; or type three or 
more letters followed by a * (asterisk) for 
a list of all words beginning with those 
letters. 

4. Press GO. 

If the word is found in either dictionary, it is 
displayed in a window at the bottom of the 
screen. Press CANCEL to remove the word. 

If no word is found, the message 

Not found 

appears in a window at the bottom of the 
screen. Press CANCEL to remove the window and 
the word. 



If you entered three or more characters followed 
by a * (for example, num*), the message 

Searching for num* .... 
(Press CANCEL to interrupt) 

appears on the screen. 

When the list of words is found, it appears on 
the screen in a window that has a document status 
line above it. The document status line contains 
the title of the word list: 

Word List 1982 Houghton Mifflin Co. 

The message 

Number of matched words: nn 

appears at the bottom of the word list to show 
how many words are in the list. 

Completing the Spelling Check 

When the spelling check has completed, the 
message 

Spelling verification complete. 
Word totals: X checked, X not found, X 
corrected. 

where X is the number of words, is displayed at 
the bottom of the screen. 

HYPHENATE WORD OPTION 

You can use the "Hyphenate word" option to find 
out where to place discretionary hyphens in a 
word that has two or more syllables. This option 
checks both the personal dictionary and the 
common dictionary for proper hyphenation. 

All the words in the common dictionary that have 
two or more syllables contain discretionary 
hyphens. However, the words in your personal 
dictionary have discretionary hyphens only if you 
put them in. You can put discretionary hyphens 
in the contents of your personal dictionary when 
the dictionary was first created, or when you 
added the words during the "Correct manually and 
save correction" operation. 
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To invoke the "Hyphenate word" option: 

1. Open the document that contains the word (or 
words) in which a discretionary hyphen is to 
be inserted. 

2. Move the cursor into that word. 

3. Press COMMANDS (CODE-f7) to invoke the 
Commands function. The Commands menu appears 
on the screen. (See Figure 7-1.) 

4. Press H to choose the "Hyphenate word" 
option .. 

5. The Commands menu is dismissed and the chosen 
word appears at the bottom of the screen 
containing the discretionary hyphens. 

6. You now can insert the discretionary hyphens 
in the word in the document. Move the cursor 
to the next position to the right of the 
place where the discretionary hyphen is to be 
inserted. 

7. Press CODE-hyphen. The discretionary hyphen 
is inserted in the word. 

8. Repeat steps 4 and 5 to insert more discre­
tionary hyphens into the word, if necessary. 

9. Notice that the hyphenated word goes away as 
soon -as the cursor is moved within the text. 

AUTOHYPHENATION 
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Autohyphenation works in conjunction with the 
Review Documents command. (See "Review Documents 
in Section 4, "Basic Operations.") When you 
choose the "Hyphenate" option of the Review 
Documents command, the Word Processor checks the 
common word dictionary every time a word is 
encountered that needs to be hyphenated. (Your 
personal dictionary is not used for this 
option.) If the word is found in the dictionary, 
it is hyphenated-automatically. If the word is 
not found, you are asked to hyphenate the word 
manually. 



APPENDIX A 

STATUS MESSAGES 

1 replacement made 
Displayed at completion of Replace operation. 

A software error has occurr~d; status code = 
n. Please report the error to your system 
administrator before recovering. Press any key 
to exit Word Processor. 

Access denied 
You attempted to open a document for which you 
did not have the proper file access. Use the 
Password field on all forms to enter the proper 
password. Alternatively, make sure that your 
system administrator has configured your system 
to allow your access to this file. 

Bad password 
You entered a password of more than 12 char 
acters. 

Cancelling ... 
You invoked the "Cancel printing" option of the 
Printer Status command to remove a print 
request from the print queue. 

Cannot divide by zero: X 
The column entry has an expression X, (where X 
is the expression), which contains a division 
by zero. 

Cannot edit there 
You attempted to edit text in an area of the 
screen, such as the Document Status Line, not 
appropriate for that operation. Move the 
cursor elsewhere. 

Cannot find printer description file 
There is no printer description file avail­
able. See system administrator or supervisor 
for assistance. 

Cannot pause more than n local printers simul­
taneously 

You attempted to pause too many local back 
ground printers. 
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Cannot recover, typescript not valid 
You have attempted to recover a session that 
was created with an earlier version of the Word 
Processor. Recovery is not possible in this 
case. 

Cannot recover, no typescript 
You attempted a recovery at the beginning of a 
word processing session when no typescript file 
exists. 

Cannot search there 
You attempted a search operation in an area of 
the screen, such as a directory listing, in 
which a search cannot take place. 

Cannot select there 
You attempted to make a selection in an area of 
the screen, such as the document status line, 
not available for selection. Move the cursor 
elsewhere~ 

Cannot set more than 20 tabs per paragraph 
You specified more than 20 tab settings in a 
single paragr~ph. 

Cannot ZOOM on thi~ type of workstation 
The Zoom command works only with a B 22 work 
station. 

Can only recover on an AWS 
If you were using a B 21 workstation when the 
failure occurred, you must recover on a B 21 
workstation. 

Can only recover on an IWS 
If you were using a B 22 workstation when the 
failure occurred, you must recover on a B 22 
workstation. 

Change print wheel to X and press GO to continue 
printing. Press CANCEL to cancel command. 
The printer has come to the text for which you 
specified a different print wheel. X is the 
font name specified in the print wheel config­
uration file. Applicable to direct printing 
only. 



This message also appears if the word processor 
comes across a character which is not on the 
current print wheel. (The word processor will 
look through the print wheel file to see which 
print wheel has that character and thus print 
this message so the character can be printed. 

Change print wheel to X and press R to resume 
printing. 

The printer has come to the text for which you 
specified a different print wheel. X is the 
font name specified in the print wheel config­
uration file. Applicable to spooled printing 
only. 

This message also appears if the word processor 
comes across a character which is not on the 
current print wheel. (The word processor will 
look through the print wheel file to see which 
print wheel has that character and thus print 
this message so the character can be printed. 

Change printer forms to X and press R to resume 
printing. 

Applicable to spooled printing. 

Change printer forms to X and press GO to con­
tinue printing, press CANCEL to cancel command. 

Applicable to direct printing. 

Command canceled 
You pressed CANCEL during execution of a 
command. 

Copying ... 
The document is being copied. 

Cursor must be in a table 
You attempted to make a selection with MARK 
COLUMN when the cursor was not within a column. 

Cursor must be in a window 
You attempted an operation (such as Mark or 
Bound) that requires the cursor be in a window. 
Move the cursor to a window. 

Deleting ... 
The document is being deleted. 
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Dictionary load complete. n words loaded 
Your personal dictionary is loaded and contains 
n words. (This message applies only to the 
optional spelling checker package.) 

Dictionary not available 
You attempted to do a spelling check with no 
dictionary installed. (This message applies 
only to the optional spelling checker package.) 

Directory X is protected: Access denied 
You did not supply a password to allow you to 
access this directory. 

Disk full 
There is no room left on the disk. If it is a 
hard disk, copy some documents to a floppy disk 
and delete them from the hard disk. If it is a 
floppy disk, move some of its documents to a 
different floppy disk. 

Document X cannot be changed 
The document you are trying to change is write 
protected. 

Document X cannot be changed. Press GO to print 
without repaginating, CANCEL to cancel command. 

You issued a print request with pagination for 
a document that was opened with "No" specified 
for "Allow changes". 

Document X cannot be changed. Press GO to 
proceed, CANCEL to cancel command. 

You attempted to edit a document, X (where X is 
the name of the document), on a write-protected 
floppy disk. Specify "Allow Changes: Yes" when 
opening the document, or place a tab over the 
write-protect notch if using an 8-inch floppy 
disk~ If using a 5 1/4-inch floppy disk, 
remove the tab over the write-protect notch. 

Document X is already open 
You attempted to open a document, X (where X is 
the name of the document), that is already dis­
played on the screen. 

Document X is in use 
You attempted to open a document, X (where X is 
the name of the document), that is already in 
use by another workstation in the cluster 
configuration. 



Document X is unavailable. Please try again 
later. 

You attempted to open a document, X (where X is 
the name of the document), that is currently in 
a print queue or is being printed. 

Document X is protected: Access denied 
You attempted to open a document, X (where X is 
the name of the document), that is password 
protected. See your system administrator to 
obtain the correct password. 

Down 
The printer you specified is not available. 

Expres~ion is too complex 
There are too many parentheses , brackets 
or angle brackets «» in an expression. 
symbols must always appear as pairs. 

( [ ] ) , 
These 

Field containQ a nonnumeric character 
You cannot enter a nonnumeric character in a 
numeric field. 

Forced page number is invalid 
The page number for a forced page must be 
numeric. 

Forced page number requires forced page 
You assigned a forced page number without 
specifying a forced page. 

Form contains a keyword with more than 20 
characters 

In list processing, a keyword cannot contain 
more than 20 characters. 

Formatting ... 
This message is displayed during hyphenation 
and pagination. 

Generating a records file. Press CANCEL to 
interrupt. 

You pressed GO to execute Sort/Select. The 
"Records to" file is being generated. 

GO not valid 
You pressed GO when no command has been 
invoked. 
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Idle ... 
The status message in the Printer Status form 
shows that the printer is idle. 

Inches must be a number less than 273 
You specified a number greater than 273 in the 
Page Format form. 

Invalid character in word 

Invalid format set 
The version number of the format set (Wp.Fmt) 
does not match the version number of the format 
set in your.WordProcessor.Run file. 

Invalid hexadecimal digit in code 
You used a character other than a hexadecimal 
digit (0 to 9 and A to F) in the "Hexadecimal 
code" field of the Insert Hexadecimal form. 

Invalid print wheel ~~t 
You are attempting to access an invalid print 
wheel set. See your system administrator or 
supervisor for assistance. 

Invalid printer channel 
Only printer channels A, B, and 0 are valid. 

Invalid printer status ... Printer status code = n 
There is a printer spooler problem. See your 
supervisor or system administrator. 

Load paper and press GO to continue printing. 
Press CANCEL to cancel command. 

The printer halted because it is out of 
paper. Load paper and press GO. 

Loading Dictionary ... 
Your personal dictionary is being loaded. (This 
messages applies only to the optional spelling 
checker package.) 

Master going down in n seconds ... press GO to 
continue printing, CANCEL to cancel command 

Memory low; please Save 
Memory is too low for the current editing 
operation. Press CODE-s to save your document 
and recover memory. 



Merging ... 
You pressed GO to execute Merge and the form 
document is being merged with the records file. 

n records files were processed, of these n were 
unusable. In the records files which were 
usable, there were a total of n records. Of 
these, n records ~ere su~cessfully merged, n 
records were rejected as being malformed. 

n replacements made 
Displayed at completion of Replace operation. 

n words loaded 
n words were loaded into your personal diction 
ary. (This message applies only to the optional 
spelling checker package.) 

Next key typed will be inserted literally 

NEXT not valid 
You pressed NEXT when a form was not present. 

No replacements made 
This message is displayed at completion of the 
Replace operation. 

No such command 
You entered a nonexistent command; press HELP 
for a list of commands. 

Not found 
The Search command did not find the text you 
specified. In spelling correction operations, 
the word you requested from the dictionary for 
viewing cannot be found. 

Not in service ... 
This message appears when you specified spooled 
printing but the printer spooler is not 
installed, or if you specified a printer for 
spooled printing and that printer is not 
configured for spooled printing. 

Number expected near X 
The contents of an expression are out of 
order. 

Only vertical measurements can be entered as 
lines 

Page Format form only allows vertical 
measurements in lines as well as inches. 
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Offl ine ... 
The status message in the Printer Status form 
shows that the printer is currently offline. 

Operand must be an in~e~er: X 
The operand in this mod expression must be an 
integer. 

Operator expected near X 
The contents of an expression are out of 
order. 

Page formatting cannot be applied to headers or 
footers 

You attempted to apply a page formatting 
attribute to a header or footer. 

Page n does not exist 
The page you specified with the Go to Page 
command does not exist. 

Pages to print must be of the form 1-5, 1-, 5, 
etc. 

You entered an invalid number. Try again with 
the correct page number. 

Paragraph indent cannot be moved off edge of 
paper 

You attem~ted to set a paragraph indent beyond 
the paper w~dth specified. Check Page Format 
specifications. 

Pattern too complex 
The wild card specification you made in the 
List Directory form is invalid. (See "Docu­
ments" in Section 4, "Basic Operations," for 
information on wild card formats.) 

Paused ... 
The status message in the Printer Status form 
shows that the printer is currently paused. 

Personal dictionary is full 
Your personal dictionary can contain only 250 
words. (This message applies only to the op­
tional spelling checker package.) 

Place cursor to right of either a tab or a" " 
mark 

When you. are. setting evenly spaced tabs, the 
cursor must be to the right of either a tab or 
" "mark. 



Please delete odd or even footer 
You attempted to specify a "Both odd and even 
footer" when separate odd and even footers 
already exist. 

Please delete odd or even header 
You attempted to specify a "Both odd and even 
header" when separate odd and even headers 
already exist. 

Please fill in "Directory" 
You must specify the name of the directory 
before pressing GO to change your work area. 

Please fill in "Document name" 
You tried to open a document without filling in 
the document name in the Open Document form. 

Please fill in "Form name" 
You pressed GO to execute Merge, but you did 
not enter the form name. 

Please fill in "New document name" 
You must specify the new document name before 
pressing GO to copy a'document. 

Please fill in "Old document name" 
You must specify the old document name before 
pressing GO to copy a document. 

Please fill in "Page number" 
You did not specify a page number in the Go to 
Page form. 

Please fill in "Printer name" 
You must specify the name of the printer before 
you press GO to start print operations. 

Please fill in "Records file(s)" 
You must specify the "Records file(s)" before 
pressing GO to execute Merge. 

Please fill in "Records from file(s)" 
You must specify the "Records from file(s)" 
before pressing GO to execute Sort/Select. 

Please fill in "Records to file" 
You must specify the "Records to file"'before 
pressing GO to execute Sort/Select. 
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Please fill in "Search for" 
You left the "Search for" field of the Search 
form blank. Fill it in. 

Please fill in "Volume" 
You must specify the volume name before 
pressing GO to change your work area. 

Please load single-sheet paper 
You specified single-sh~et paper on the Print 
form. The printer has stopped and the system 
is telling you to load a sheet of paper. 

Please make a selection 
You attempted an operation that requires a 
selection but no selection exists. 

Please specify "Allow changes: Yes" 
You are are trying to copy a document to a 
document that has "Allow changes: No" 
specified. 

Position cursor and press GO to hyphenate. Press 
NEXT to skip this word, CANCEL to cancel command. 

This message is displayed during hyphenation to 
prompt you to specify insertion of a discre­
tionary hyphen. 

Press FINISH to exit Word Processor 

Press GO to confirm Discard, CANCEL to cancel 
command 

If you press GO, all edits made to the document 
will be undone. Press CANCEL if you do not 
want this to occur. 

Press GO to confirm FINISH, CANCEL to cancel 
command 

Press GO to confirm printing to file X, CANCEL to 
cancel command 

You are printing to another file, rather than 
to a printer. 

Press GO to confirm Remove Format, or CANCEL to 
cancel command 

If you press GO, ~ll formatting information, 
such as underlining, paragraph indenting, tabs, 
and so on, will be deleted. Press CANCEL if 
you do not want this to occur. 



Press GO to create document X, CANCEL to cancel 
command 

You have created a new document. 

Press GO to create document, CANCEL to dismiss 
A new document is being created to contain the 
output of a Sort or Select operation. 

Press GO to overwrite/document, CANCEL to dismiss 
An existing document is being overwritten to 
contain the output of a Sort or Select opera­
tion. 

Press GO to replace, NEXT to skip item, CANCEL to 
cancel command 

Print queue empty 
The Printer Status form shows that there are no 
entries in the print queue. 

Print queue full; try again later 
There are too many entries in the print queue. 

Print wheel X is not defined in your Wheel Set. 
Press GO to substitute X, CANCEL to cancel 
printing. 

You specified a print wheel that is not defined 
in your Wheel Set file. 

Printer spooler not available 
The printer spooler is not installed. 

Printer X does not exist 
You specified the name of a nonexistent 
printer. 

Printer X is currently out of service 
You specified printer X, which is currently out 
of service. 

Printer X must be used for direct printing 
You specified printer X for other than direct 
printing. 

Printer X must be used for spooled printing 
You specified printer X for other than spooled 
printing. 

Printing halted 
You pressed H in the Printer Status menu to 
halt the printer. 
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Printing is in progress. Press GO to cancel 
printing and proceed, CANCEL to cancel command 

Printing page n of document X. 
The status message in the Printer Status form 
shows the page number and name of the document 
being printed. 

Printing priority must be from 0 to 9 
You specified a print priority value out of the 
range of 0 to 9. 

Printing will occur in n pieces 
The output of your Merge operation will print 
in groups of n pieces. 

Problem with printer; press GO to continue or 
CANCEL to cancel command 

The printer is offline, is out of paper, or has 
another problem. After rectifying the problem, 
press GO to continue printing. n 

Records file <vol>[dir]filename cannot be merged 
with this form letter. Its template record does 
not contain the keyword X. 

In list processing, the keywords in the form 
letter must have corresponding keywords in the 
template record of the records file. 

Recovery complete 
You can continue editing, or you can FINISH 
your session. 

Recovery suspended; press GO to continue, CANCEL 
to stop recovery 

If you press GO, the recovery of the session 
will continue; if you press CANCEL, it will be 
terminated with the document left just as 
displayed. 

REDO not valid 
REDO cannot redo the last operation. 

Renaming ... 
Your document is being renamed. 

Replacing ... 
This message is displayed while a global 
replace operation is occurring; no user 
response is required. 



Save complete 
Your documents have been fully saved on disk. 
You can continue editing, or you can FINISH 
your session. 

Saving ... 
Please wait for the SAVE that you requested to 
be completed. 

Scanning queue for printer X 
The status message in the Printer Status form 
shows that the queue is being scanned for 
printer X. 

Searching ... 
This message is displayed while a search 
operation is occurring. No user response is 
required. 

Searching Dictionary for X ... (Press CANCEL to 
interrupt) 

The dictionaries are being checked for X, where 
X is the word you specified for the "View 
Dictionary" option. (This message applies only 
to the optional spelling checker package.) 

Searching directory X ... (Press CANCEL to 
interrupt) 

This message is displayed while a search 
operation is occurring. No user response is 
required. 

Selection contains n invalid entry(s) 
The column you selected for totaling contains n 
invalid entries (where n represents an alpha­
betic rather than a numeric entry). 

Service requested is not available at this work 
station 

You requested an operation that is not 
installed at this workstation. 

Spelling verification complete. Word totals: n 
checked, n not found, n corrected. 

Spooling operation incomplete -- disk full. 
Your spooled print request has been terminated 
because of lack of space on disk. 
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Starting a new session will destroy your unre­
covered work. Are you sure this is what you want 
to do? Press GO to proceed with new session, 
CANCEL to exit Word Processor. 

See "Recovery Procedures" in Section S, 
"Advanced Operations." 

Sum of values entered for Left margin, Text 
width, and Right margin exceeds Paper width. 

Sum of values for left margin, text width, and 
right margin must equal paper width. 

Sum of values entered for Top margin, Text 
height, and Bottom margin exceeds Paper height. 

Sum of values for top margin, text height, and 
bottom margin must equal paper height. 

Warning: Document X cannot be printed. Print 
wheel X is not defined in your Wheel Set. (See 
the B 20 Executive WRITEone Word Processing 
Reference Manual.) 

That document cannot be changed 
You attempted to edit a document that cannot be 
changed. 

That document has not been changed 
You attempted to discard the edits to a docu­
ment that has not been edited. 

There is already a document named X 
You attempted to open a new document, X (where 
X is the name of the document), using the name 
of an already existing one. Choose another 
name. 

There is already a user named X 
You signed on with the same user name, X (where 
X is the name you specified), as another 
user. Sign on with a different name. 

There is no directory named X. 
You entered the name X (where X is the name you 
specified), of a nonexistent directory in the 
List Document form. 

There is no document named X in the print queue 
You are trying to cancel a document that is not 
in the print queue~ 



There is no document named X. 
You entered the name X (where X is the name you 
specified), of a nonexistent document in the 
Open Document form. 

There is no file named X 
You are attempting to access a nonexistent 
file. 

There is no spooler queue named X 
You entered the name X (where X is the name you 
specified) of a nonexistent queue in the 
spooler. 

There is no volume named X. 
You entered the name X (where X is the name you 
specified), of a nonexistent volume in the Work 
Area form. 

Too many documents in directory 
You tried to save a document when there was not 
enough room in the directory. The simplest 
remedy is to log in to a different directory. 
Alternatively, you can expand the directory 
capacity as follows: Rename all the documents 
in this directory to another directory, and 
then remove this one. Create a new directory 
with the name of the old directory. Then 
rename all the documents from the other direc­
tory to this new, expanded directory. 

Too many documents open; please Save 
More documents are open than the Word Processor 
can handle. Save all the documents by pressing 
CODE-s, and then use CODE-c to close any docu­
ments that are not needed in that session. 

Too many windows 
You opened more windows than the Word Processor 
can handle (a maximum of seven). Close one or 
more windows. 

Unable to complete command: status code N 
Command cannot complete. For example, you 
filled in the Print form and pressed GO to 
print, but no printer was connected. 

Unable to create file X. 
Typescript cannot be created. 
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Unable to open file X. 
The typescript, print wheel set, or format set 
cannot be opened. 

Unattached ... 
The status message in the Printer Status form 
shows that the printer spooler is installed but 
the printer is not plugged into the back of the 
workstation. 

Unloading dictionary ... 
The contents of your personal dictionary are 
being unloaded. (This message applies only to 
the optional spelling checker package.) 

Unmatched X in expression 
Parentheses, brackets, and angle brackets 
always must be paired in an expression. 

Value entered must be a whole number -- no 
fractions.' . 

You specified a number that was not a whole 
number in the Forced page number field of the 
Page Format form. 

Value must be a number less than 65535 
The value 65535 cannot be exceeded in the 
following operations: Go to Page; totaling 
columns; Review Document (specifying hot zone); 
Print (page number and number of copies); Merge 
(skipping records). 

Verifying spelling 
The spelling checker is checking your document 
for mi~spelled words. (This message applies to 
the optional spelling checker package.) 

Volume X is not mounted 
You specified, as part of a document name in 
the Open Document form, a volume, X (where X is 
the name of the volume), that either does not 
exist or is improperly mounted. Make sure the 
door is closed on the floppy disk drive. 

Warning: Document X cannot be printed. Print 
wheel X is not defined in your Wheel Set. (See 
the B 20 Executive WRITEone Word Processing 
Reference Manual.) 



When Left margin, Text width, and Right margin 
are all specified, their sum must equal Paper 
width. 

Sum of left margin, ~ext width, and right 
margin is lower than paper width. 

When Top margin, Text height, and Bottom margin 
are all specified, their sum must equal Paper 
height. 

Sum of top margin, text height, and bottom 
margin is lower than paper height. 

Would you like to display the same documents as 
in your last session? Press GO to confirm, 
CANCEL to start a new session. 

X is not a valid configuration file 
The configuration file, X (where X is the name 
of the configuration file), which is required 
for printing, is malformed. A well-formed 
configuration file must be supplied. See the 
B 20 Software Operation Guide. 

X is not a valid directory name. 
You specified an invalid directory name when 
you invoked the "List directory" option of the 
Documents command. 

X is not a valid document name 
You specified a document, X (where X is the 
name of the document), inconsistent with BTOS 
Operating System naming conventions. See the 
B 20 Executive Manual. 

X is not a valid number 
You attempted to total a column that contains 
an invalid number. (For example, 5.5.5 or 6 
1/2 1/4.) 

X is not a valid operator 
You attempted to total a column that contains 
an operator that is not +, -, x, or /. 

X is not a valid print wheel name 
You specified an incorrect print wheel name, X 
(where X is the name of the print wheel), in 
the Print Wheel form. 

Your directory is full. Please delete or rename 
unneeded documents before Recovering. Press any 
key to exit Word Processor. 
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Your disk is full. Please delete or rename 
unneeded documents before Recovering. Press any 
key to exit Word Processor. 

Your last session did not FINISH successfully. 
Press GO to recover, CANCEL to start a new 
session. 

See "Recovery Procedures" in Section 5, 
"Advanced Operations." 

NOTE 

If you get a status message that has a 
number fro~ 1300 through 1399, please 
save your <wp>username.ts file along with the 
documents that were being worked on at the 
time of this error before recovering. Also, 
please contact your technical support 
personnel when one of these error occ~rs. If 
the above mentioned files are saved your 
technical support personnel will be more able 
to help you. 



APPENDIX B 

PRINT WHEEL CONFIGURATION 

This Appendix describes the print ~heel set and 
need be read only by the system administrator or 
supervisor who is setting up a nonstandard print 
wheel configuration. 

The print wheel set file is used to specify a 
print wheel that is not part of the standard 
print wheel configuration for the Word Proces­
sor. For example, you might have a standard 
print wheel configuration consisting of the 
following print wheels: Courier 10, Elite 12, 
Gothic PS, and a print wheel containing special 
symbols (trade mark, copyright, etc.). These 
print wheels are defined in the print wheel set 
when the system is installed. 

Whenever a new print wheel is purchased that has 
a type face or character set that has not been 
used before, an entry must be made in the print 
wheel set describing the new print wheel. 

The prlntwheel set is containedin~ file called 
[sys]<sys>Wp.wheel.~.Various attribute~ of each 

·print wheel are specified in this file. 

Print Wheel Name 

Each print wheel in the print wheel set has a 
name. This name serves two purposes: The user 
enters the name in the Print Wheel form when 
specifying that text is to be printed with ~ 
particular print wheel. Later, when the text is 
printed, the system requests that this print 
wheel be mounted. 

When adding a new print wheel to the print wheel 
set file, assign a name by making an entry at the 
end of the file as follows: 

Wheel-name "text" 

where the "text" is the name for this particular 
print wheel. (Please note when adding a new 
print wheel, it is important that the new print 
wheel be put at the end of the print wheel set 
file and that the current order of the file not 
be changed.) Usually, this name is the name 
printed on the print wheel itself, such as Elite 
12 or Cubic PS. (You can, of course, choose any 
name.) 
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Print wheels are designed with different charac­
ter spacing attributes .. They can be fixed pitch, 
with each character occupying the same amount of 
space on aline, or proportional, with certain 
characters (such as "m" or "w" ) wider than other 
characters (such as "i" and "j"). Usually, the 
print wheel's.name reflects the intended spacing, 
as Elite 12 (a 12-pitch wheel) or Cubic PS (a 
proportionally spaced wheel). 

To specify a fixed-pitch print wheel, make the 
following entry in the print wheel set file after 
the line containing the print wheel name: type 
the word "Fixed" followed by a number. The 
number is the desired spacing measured in 240ths 
of an inch. For example: 

Wheel-name "Elite 12" 
Fixed 20 

Since this is a 12-pitch print wheel, the number 
"20" is entered (240 divided by 12 equals 20). 
For a 10-pitch wheel such as Pica 10, the correct 
number is 24. 

To specify a proportionally-spaced print wheel, 
make the following entry in the print wheel set 
file after the line containing the print wheel 
name: type the word "Proportional" followed by a 
table of 256 numbers. The numbers are the 
desired character spacings, measured in 240ths of 
an inch, for each of 256 possible characters. 
For example: 

Wheel-name "Cubic PS" 
Proportional 

20 20 20 20 20 20 20 20 20 20 
20 20 20 20 20 20 20 20 20 20 
20 20 20 20 20 20 20 20 20 20 
20 20 20 12 16 24 20 32 28 8 
12 12 20 20 12 16 12 16 20 20 

You can derive the correct number from the 
manufacturer's data sheet supplied with the print 
wheel by following these steps: 

1. See Table B-1 for the set of possible symbols 
to be printed. These symbols are compatible 
with the Word Processor. 



Table 8-1. Word Processor Symbol Table. 

(0 ) (1 ) ( 2 ) ( 3 ) (4 ) ( 5 ) (6 ) ( 7) (8 ) ( 9) 

(0-9) ¢ Y2 

(10-19) t ~ 1 
(20-29) ~ § -; "::' '1 ---, .:::; 

(30-39) ± :;:: # $ % & 

(40-49) * + / 0 1 

(50-59) 2 3 4 5 6 7 8 9 

(60-69) < > ? @ A B C D E 

(70-79) ·F G H I J K L M N 0 

(80-89) p Q R S T U V W X Y 

(90-99) Z [ \ ] 1\ a b c 

(100-109) d e f 9 h i j k 1 m 

(110-119) n 0 p q r s t u v w 

(120-129) x y z f',J 

(130-139) 

(140-149) 

(150-159) 

(160-169) R 0 )\ a (j 0 ¢ ¢ u U a 

(170-179) ~ ~ e , 
e h:: ae (3 £ 0 © 

(180-189) ® 

(190-199) 

(200-209) 

(210-219) 

(220-229) 

(230-239) 

(240-249) 

(250-255) 
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2. For each position in Tabl~ B-1, find that 
same symbol in the manufacturer's data sheet. 

3. Next to each symbol on the data sheet is a 
number, sometimes called a "PS value" or "PS 
units." If the desired symbol does not 
appear in the data sheet, use the number 
listed for the space character (usually 5 or 
6). 

4. Multiply the number by 4 to obtain the 
correct spacing measurement in 240ths of an 
inch. 

5. Enter the resulting number in yoctr 
proportional table for the print wheel set. 

6. Repeat steps 2 through 5 for all symbol 
positions in Table B-1. 

The set of symbols capable of being printed by a 
given print wheel is called the print wheel's 
character set. Not all print wheels have the 
same character set. Some print wheels have 
square brackets where others have symbols for 
one-half and one-fourth. Still other print 
wheels have no letters at all and consist 
entirely of special symbols. 

To make sure your documents print correctly with 
a given print wheel, it may be necessary to 
provide a mapping table to match the print 
wheel's character set with the character set used 
by the Word Processor. Follow these steps to 
determine whether your print wheel requires this 
mapping table. 

1. Mount the new print wheel on the printer in 
place of the regular print wheel. 

2. Make sure that the printer switch settings 
are appropriate for the new print wheel. For 
example, if the new print wheel is a 96-
character metal wheel, set the switches 
accordingly. 

3. Invoke the Word Processor and open the 
document "TableB-2.Doc". This document was 
entered under each [sys]<WRITEn> directory 
during installation. It contains Table B-2, 
which corresponds to Table B-2 in this 
Appendix. 



(32-39) 

(40-49) 

(50-59) 

(60-69) 

(70-79) 

(80-89) 

(90-99) 

(100-109) 

(110-119) 

'(120-129) 

4. Print a copy of Table B-2, using the Print 
feature of the Word Processor. 

Compare the printed output with Table B-2 as 
viewed on the screen. If each position in the 
printed table contains the same symbol as on the 
screen, then no mapping table is required. If 
any positions differ from printed copy to screen, 
a mapping table is required. 

To specify a mapping table, make the following 
entry in the print wheel set file after the line 
where you have specified fixed spacing (if it is 
a fixed-pitch wheel) or after the proportional 
table (if it is a proportional wheel): type the 
word "Mapped" followed by a table of 256 
numbers. For example: 

Wheel-name "Elite 12" 
Fixed 20 
Mapped 

255 255 255 

Table B-2. Example of Print Wheel Symbol Table. 

(0) ( 1 ) ( 2) ( 3 ) (4) ( 5) (6 ) ( 7) (8 ) 

¢ # $ % & 

* + / 0 

2 3 4 5 6 7 8 9 

< > ? @ A B C D 

F G H I J K L M N 

p Q R S T U V W X 

z [ ] 1\ a b 

d e f g h i j k 1 

n 0 p q r 5 t u v 

x y Z 
r-J I 

You can determine the correct number by following 
these steps: 

1. See Table B-1 for the set of possible symbols 
to be printed. 

( 9 ) 

1 

E 

0 

Y 

c 

m 

w 
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2. For each position in Table B-1, find that same 
symbol in the printed version of Table B-2 
that was made with the new print wheel. 

3. Determine the position number of the symbol in 
Table B-2 by reading up and across to the 
numbers in parentheses at the left. If the 
desired symbol does not appear in the printed 
copy of Table B-2, use the number 255 or the 
hex value FFh. Note that the decimal values 
can be used instead of the hexadecimal values 
for the symbols. An ASCII chart has been 
provided at the end of this appendix giving 
both the hexadecimal and decimal equivalents 
of the ASCII characters. 

4. Enter the resulting number in your mapping 
table in the print wheel set file. 

5. Repeat steps 2 through 4 for all symbol 
positions in Table B-1. 

Assembling the Print Wheel Set File 
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After you have added the above entries to the 
print wheel set file, you must assemble the file 
so that the Word Processor recognizes the new 
print wheel. Use the Make Wheel Set command as 
follows: 

1. Invoke the Executive. 

2. Type in the command form: Make Wheel Set 

3. Press RETURN. 

4. The screen now displays 

Make Wheel Set 
Wheel set file 
[Listing file] 

5. Type Wp.Wheels in the highlight next to "Wheel 
set file". 

6. Press GO. 

The print wheel set is translated into a form 
that is usable by the Word Processor. To verify 
that your print wheel has been successfully added 
to the print wheel set, enter the Word Processor 
and use the Format command to display the Print 
Wheel form. The new print wheel name should be 
listed along with the other print wheel names. 



Character Mapping to Multiple Print Wheel Spokes 

Word processing allows character mapping to 
mUltiple print wheel spokes. A single character 
within a font can be composed of several 
different characters when printed, such as the 
combination of a character and a diacritical 
mark. 

The following example from a print wheel set file 
shows the exact syntax used to define a cent sign 
that the printer creates by combininr. a lower 
case "c" and the ASCII vertical bar 'I". 

Wheel-name, "Special cent sign" 
Half-Bright 
Fixed 24 (10 pitch) 
Mapped 

FFh FFh FFh *1 FFh FFh FFh FFh FFH FFH FFh 

Overstrike 
-"'1 < "c" 1 0 0 > < "I" 1 0 0 > 

Wheel-name "special type" 

The *1 in the mapped table is a tag to connect a 
given character to the proper character list in 
the overstrike table. 

The width of the combined character is the width 
taken from the entry in the width table at 
location 3 (character code for a cent sign). 

The entries in the overstrike table consist of 
two parts: the tag (*1, *2, and so on), and the 
character list ( < "c" 0 -2 3 ». The 
components of a single element in the character 
list are as follows: 

1. Opening bracket < 

2. Print wheel spoke c 
(This component can be either a single quoted 
character, a decimal number, or hexadecimal 
number.) 
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3. Hammer energy 1 
(Included for a future version of the Word 
Processor. The current Word Processor ignores 
this field and uses the printer's default 
hammer energy.) 

4. X (horizontal) offset -2 
(This offset is used to fine tune the position 
of each component character on the paper. The 
offset is in 1/240ths of an inch. Position is 
relative to the center of the character cell 
[that is, where a normal individual character 
would be printed]. The value can be positive 
or negative. Note that the offset of each 
character in the character list is relative tb 
the center of the character cell, and not to 
the previous character in the list.) 

5. Y (vertical) offset 3 
(Si~ilar in effect ·to the horizontal offset of 
the character. Can be positive or negative.) 

6. Closing bracket > 

The number of items in the. character list for a 
single character code can be from 1 to 255. 



Table B-3. Hexadecimal and Decimal Equivalents of ASCII Characters. 

HEX ASCII DECIMAL HEX ASCII DECIHAL 

20 space 32 50 P 80 

21 33 51 Q 81 

22 " 34 52 R 82 

23 II 35 53 S 83 

24 $ 36 54 T 84 

25 ~ 37 55 U 85 

26 & 38 56 V 86 

27 39 57 w 87 

28 40 58 X 88 

29 41 59 y 89 

2A • 42 5A Z 90 

2B + 43 58 [ 91 

2C 44 5C \ 92 

2D 45 5D ] 93 

2E 46 5E 94 

2F / 47 5F 95 

30 0 48 60 96 

31 49 61 a 97 

32 2 50 62 b 98 

33 3 51 63 c 99 

34 It 52 64 d 100 

35 5 53 65 e 101 

36 6 54 66 f 102 

37 7 55 67 g 103 

38 8 56 68 h 104 

39 9 57 69 i 105 
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Hexadecimal and Decimal Equivalents 
of ASCII Characters 

HEX ASCII DECIMAL HEX ASCII DECIMAL 

3A 58 6A j 106 

38 59 68 k 107 

3C < 60 6C 1 108 

3D = 61 6D m 109 

3E > 62 6E n 110 

3F ? 63 6F 0 111 

40 @ 64 70 p 112 

41 A 65 71 q 113 

42 B 66 72 r 114 

43 C 67 73 s 115 

44 D 68 74 t 116 

45 E 69 75 u 117 

46 F 70 76 v 118 

47 G 71 77 w 119 

48 H 72 78 x 120 

49 I 73 79 y 121 

4A J 74 7A z 122 

48 K 75 78 123 

4C L 76 7C 124 

4D M 77 7D 125 

4E N 78 7E 126 

4F 0 79 7F DEL 127 
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Hexadecimal and Decimal Equivalents 
of ASCII Characters 

HEX ASCII DECIHAL HEX ASCII DECIHAL IIEX ASCII DECIHAL HEX ASCII DECIHAI. 

20 :space 32 50 80 3S 'jt 6& h 104 

21 33 51 Q 81 39 ::J~ lG~ 

22 34 52 82_ 3A ~8 6A lOt; 

23 "le:. 5j S 8< 3B S9 6B 107 

24 $ 54 T 84 3C 60 tJC 1010 

25 S ; . 5:" U 85 3D G' 6[, m 109 

26 & 38 St- 86 3£ 62 6E n 110 

27 is 5'1 W 8~' 3F 65 6F 0 111 

28 40 5£ 88 40 @ 64 70 P 112 

29 41 59. y 89 41 A 55 71 q i 1 j 

2A 42 5A Z 90 42 B 66 72 114 

26 43 5B 91 43 C 67 73 115 

2C 44 5C 92 44 D 68 74 116 

2D 45 51) 93 45 69 75 u 117 

2E 46 5E 94 46 F 70 76 v 118 

2F I 4'T ')F 95 47 G '11 77 w 119 

30 0 48 6C 9t 48 H 72 78 120 

31 49 61 g't 49 73 79 121 

32 2 5C 62 b 9P 4A 74 7A z 122 

33 51 6~ :jS 46 K 75 '18 12j 

34 5'< 64 d ICC 4C I. 76 'Ie 124 

35 5 53 65 e 101 4D H 77 'TD 12:' 

36 (, 54 66 102 4E 7& 7E 126 

37 7 55 67 g 10:; 4F 0 79 7F DEL 127 
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APPENDIX C 

PRINTER CONFIGURATION 

This Appendix describes the printer description 
file and printer switch settings. 

The information about the printer description 
file need only be read by a system administrator 
or supervisor who is setting up a nonstandard 
printer configuration. 

Printer Description File 

The printer description file is used to specify 
all printers that are part of the printer config­
uration for the Word Processor. This file is 
installed with the Word Processor. At installa­
tion, the file contains entries for each pr.inter 
in the standard printer configuration. When a 
new printer is added to the Word Processor, an 
entry must he made to the printer description 
file to describe it. 

There is one entry in the printer description 
file for each printer. Each entry is on a 
separate line within the file. 

The Word Processor defaults to the first entry in 
the printer description file if no other printer 
is specified by the user. 

The syntax for entries in the printer description 
file is 

"printer name":device:format 

where: 

"printer name" 

device 

format 

is the string identifying this 

r.articular outr.ut device, such as 
'PAR", "SERIAL', or "DIRECT PAR". 

is the system device name, spooler 
queue name, or file specification to 
which the document is to be sent, 
such as "[Ptr]B", "[Lpt]", or 
[New]<Edit>Edited.doc". 

is the printer format in which the 
document is to be generated, such as 
"Draft", or "Diablo630". 
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SERIAL: 
PARALLEL: 
DIRECTSER: 
DIRECTPAR: 
SER: 
PAR: 
DSER: 
DPAR: 
DIRECT: 

C-2 

NOTE 

When a file is specified for a printer name, that 
document will be copied tri that file name and all 
formatting will be lost. This should only be 
done if an edit file needs to be created, 
otherwise the Copy function of the Document 
Utilities command (CODE-fl) should be used. 

There is no physical limitation to the number or 
size of entries in the printer description 
file. However, there are some practical limita­
tions. The identifiers should be kept short for 
two reasons: to make it easy for the user to 
specify a particular device for printing, and 
because they are used in the Print form to dis­
playa list of possible choices. 

The size of the Device field is not critical and 
can be as long as needed. 

The Printer Format field must contain one of the 
codes recognized by the Word Processor, or it 
will default to "draft". For example, two of the 
printer format codes currently recognized are 

Diablo630 (for Diablo 630 format) 
Draft (for draft printer format) 

Instead of entering an identifier in the Print 
form, you can enter Device and/or Format fields 
directly, separated by a colon. The Word 
Processor will react in the same way as if the 
Device and Format fields were read from the 
printer description file. In this case, if the 
Format field is omitted, Format defaults to 
"draft". 

Figure C-l is an example of a typical printer 
description file. 

[SplB] : 
[Spl]: 
[Ptr]B&[sys]<sys>WpPtrBConfig.sys: 
[Lpt]&[sys]<sys>WpLptConfig.sys: 
[SplB]: 
[Spl] : 
[Ptr]B&[sys]<sys>WpPtrBConfig.sys: 
[Lpt]&[sys]<sys>WpLptConfig.sys: 
[Lpt]&[sys]<sys>WpLptConfig.sys: 

Diablo630 
Draft 
Diablo630 
Draft 
Diablo630 
Draft 
Diablo630 
Draft 
Draft 

Figure C-l. Example of a Printer Description File. 



The following are the descriptions of the 
printers listed in the printer description file. 

SERIAL or SER To print to a serial-style printer 
using spooler from a master or cluster 
workstation. 

PARALLEL or PAR To print to a parallel-style 
printe~ using spooler from a master or cluster 
workstation. 

DIRECTSER or DSER To print direct to a serial­
style printer directly connected to a standalone 
or cluster workstation. 

DIRECTPAR or DPAR To print direct to a parallel­
style printer directly connected to a standalone 
or cluster workstation. 

Changing Printer Default Values 

The standard file Sys.printers makes direct 
printing the default way of printing for 
standalone systems and spooled printing for 
cluster systems. The following describes the 
steps necessary to change the default values of 
the [sys]<sys>Sys.printers file while in the word 
processor. 

1. Press the CODE key and fl. Press the 
CODE key and f1 key at the same time to get the 
DOCUMENTS menu. 

2. Press C for Copy document, and the 
following form will be displayed. Fill it in as 
follows: 

COpy DOCUMENT 

Old document: 
New document: 
Password: 

Press the GO key. 

[sys]<sys>Sys.printers 
[sys]<sys>Sys.printers.new 
(optional) 

C-3 



C-4 

3. Press 0 for Open document, and the 
following form will be displayed. Fill it in as 
follows: 

OPEN DOCUMENT 

Document name: [sys]<sys>Sys.printers.new 
Password: (optional) 
Allow changes: Yes 
Copy from document: 

Press the GO key. 

4. The Sys.printers.new file will be 
displayed so it can be edited. 

1) Move the cursor to the line which 
has the desired default value. 

2) Press the Mark Line (f9) key. 

3) Position the cursor to the first 
line. 

4) Press the MOVE key and the new 
defaulted value will move to the 
first line. It may occur that these 
two lines will run together. To 
correct this, position the cursor 
under the character where you wish 
the second line to begin and press 
the SHIFT and RETURN keys at the same 
time. This will insert a carriage 
retuLn at that position. 

5) Pres~ the FINISH key to save the new 
file and return to the executive. 

5. Enter COpy into the command form. 

6. Press the RETURN key and the following 
form will be displayed. Fill it in as follows: 

COpy 

File from: 
File to: 
[Overwrite ok?] 
[Confirm each] 

Press the GO key. 

[sys]<sys>Sys.printers.new 
[sys]<sys>Sys.printers 
Yes 



7. Enter WRITEone in the command form and 
press the GO key. 

8. To verify the new default printer, press 
the SHIFT and f4 keys at the same time. If the 
correct printer is displayed in the "Printer 
name:" field, then press the CANCEL key. Now the 
[sys]<sys>Sys.printers.new file can be deleted 
because it is no longer needed. Use the 
following steps to do this. 

1) Press the CODE and f1 keys at the 
same time. 

2) Press D for Delete document, and the 
following form will be displayed. 
Fill it in as follows: 

DELETE DOCUMENT 

Document name(s): [sys]<sys>Sys.printers.new 
Password: (optional) 

Press the GO key. 

When the Documents menu is redisplayed, press the 
CANCEL key and continue with the word processing 
session. If, however, the default is incorrect, 
press 'the CODE and 0 key and fill in the form as 
shown in step 3 and repeat the procedures from 
that step. 

Printer Switch Settings 

For the switch settings on the various B 20 
printers refer to the appropriate printer 
reference manuals. 
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APPENDIX D 

HARDWARE CONSIDERATIONS 

The size of the screen depends on the type of 
workstation being used. A B 22 workstation 
screen displays up to 34 lines that can be either 
80 or 132 columns wide. The Zoom command (see 
Section 5, "Advanced Operations") is used to 
switch the content of the screen hetween 80 
columns of text and 132 columns of text. 

When the screen content expands to 132 columns, 
the size of the characters grows proportionately 
smaller. 

Figure D-1 shows a B 22 screen that has been 
expanded to 132 columns. 

", \"" k"" \ '" I 'a"" \ I I I '~" I I I I I I I Is" " I " I I L' I I I I I I I I b' I "I I '" ~'" I I 
I ~_ L ~ 

ScrH" SiZI 

The size of the screen depends on the type 
of Morkstation being used. A B 22 
IIOrkshtion scrun displays up to 34 lints 
that can be 80 to 132 columns in Midth. 
The ZOOIl c01.lllland (see Section 51 is used to 
ui tch the contents of the scrMn bet .... n 
&:I colulns of tut and 132 colu.~ns of text. 

IIltn the scmn content expands to 132 
colulilns, the siZt of the characters grOils 
prQ90rtionately suller. 

Figure D-l. 132-Column Screen. 
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A B 21 workstation screen displays 28 lines of 
text that are up to 80 columns wide. (The Zoom 
command has no effect on a B 21 screen.) 

Figure D-2 shows an 80-column B 21 screen. 
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Screen Size 

aM· _ _ 

The size of the screen depends on the type 
of workstation being used. A B 22 
workstation screen displays up to 34 lines 
that can be 80 to 132 columns in width. 
The Zoom command (see Section 5) is used to 
switch the contents of the screen between 
80 columns of text and 132 columns of text. 

When the screen cont;nt expands to 132 
columns, the size of the characters grows 
proportionately s~aller. 

Figure D-2. 'SO-Column Screen. 



Format Change Limitations 

The B 21 screen displays a maximum of 14 
character format changes (such as boldface, 
underline, subscript) per line of text. , 
(Changing to boldface text and then changing back 
to normal text counts as two character format 
changes.) However, changes exceeding this amount 
will still be recorded and printed, even though 
they do not show up on the screen. 

Character format changes other than underline 
cause the text to show up on the screen in half­
brightness. If 16 changes occur on one line of 
text, the remainder of the line is displayed as 
half-bright text. 

Write-Protecting Disks 

All floppy disks used with the Word Processor 
have a write-protect feature. This feature. 
prevents accidental changes being made to the 
disks. 

There is an exposed write-protect notch on the 
edge of floppy disks. If you are using a B 22 
workstation with standard-sized (8-inch) disks, 
the disks are write-protected and cannot be 
changed as long as there is no tab covering the 
write-protect notch. To make changes to that 
disk, you must place a tab over the write-protect 
notch. 

If you are using mini-floppy (5 1/4-inch) disks 
with B 21 workstations, you must 
uncover the write-protect notch to make changes 
to the disk. To prevent the disk from being 
changed, place a tab over the write-protect 
notch. 
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APPENDIX E 

PROGRAMMING FEATURES 

This Appendix describes the programming-specific 
functions that are used primarily by software 
programmers for editing and documenting their 
work. These functions are inserting hexadecimal 
and literal characters, thumbing through a docu­
ment, discarding edits, removing formats, and 
programmer format sets. 

Inserting Hexadecimal Code 

The Insert Hexadecimal command inserts a char­
acter specified by hexadecimal code. This 
command, invoked by pressing CODE-i, brings up 
the Insert Hexadecimal form shown in Figure E-l 
below. 

INSERT HEXADECIMAL: (Press GO to execute, CANCEL to dismiss) 

Hexadecimal ~ode(s): 

Insert Hexadecimal Form 

Figure E-l. Insert Hexadecimal Form. 

To insert a character specified by hexadecimal 
code: 

1. Move the cursor to where you want to insert 
the character. 

2. Press CODE-i. The Insert Hexadecimal form 
appears. 
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3. Type the hexadecimal code. (You can specify 
more than one hexadecimal code by separating 
them with commas. For example: A6, A7, AB.) 

4. Press GO. 

The hexadecimal character appears in the text at 
the cursor position. 
For example, to insert a slashed 0, fill in the 
form this way: 

Hexadecimal code(s}: A6 

If you specify other than a hexadecimal digit, 
the following message appears: 

Invalid hexadecimal digit in code 

Inserting Literal Characters 

The Insert Literal command inserts a literal· 
character at the cursor position. 

To insert a literal character, do the following: 

1. Move the cursor to where you want to insert 
the literal character. 

2. Press CODE-' or CODE-SHIFT-'. 

3. Type the character. 

For example, to insert a t (up arrow), press 
CODE-' and then the up arrow key. (Pressing the 
up arrow key without first pressing CODE-' only 
moves the cursor.) 

Thumbing Through a Document 

E-2 

Thumbing moves the cursor to a specified relative 
position within the document. The keys - (caret) 
to 0 on the top row of the typewriter pad are 
analogous to the thumb indents of a dictionary. 
Think of the document as being divided into 
tenths. Each time you press CODE together with 
any of keys 1 through 0, the cursor moves through 
the document in increments of ten. (CODE-­
represents the beginning of the document.) 



Discarding Edits 

Action Finish 

For example, pressing CODE- moves the cursor to 
the beginning of the document; pressing CODE-I 
moves the cursor to the 10-percent point of the 
document; CODE-2 moves the cursor to the 20-
percent point of the document, etc. CODE-O 
specifies .the end of the document (IOO-percent 
point). 

As the cursor moves within the document, the 
content of the window shifts accordingly. 

The Discard command discards all edits made to 
the current document since the last Finish or 
Save. 

Discard is invoked by pressing CODE-u. When 
these keys are pressed, the following message 
appears: 

Press GO to confirm Discard or CANCEL to cancel 
the command 

Before you press GO, be sure that you really want 
to remove the edits from the document. Once this 
command is executed, it cannot be undone. 

Pressing ACTION and FINISH at the same time exits 
the Word Processor without saving any documents 
and returns the Executive to the screen. This 
procedure should not normally be used to finish a 
word processing session. 

Removing Formatting 

You might wish to remove a document's formatting 
attributes and leave just the raw, unformatted 
text. Use the Remove Format command, invoked by 
pressing CODE-r. 

When these keys are pressed, the following 
message appears: 

Press GO to confirm Remove Format, CANCEL to 
cancel command. 
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Before you press GO, be sure that you really want 
to remove the formatting from the document. Once 
this command is executed, it cannot be undone. 

When GO is pressed, the message 

Saving ... 

appears at the bottom of the screen to indicate 
that the document is being saved while the 
formatting attributes are removed. 

The message 

Save complete 

appears when the formatting is removed. The 
document thenloGks like the example in Figure 
E-2 below. All character attributes (such ~s· 
boldface andundeiline) ar~ removed, as are tab 
and para~~aph indent settings. All text is 
aligned at the d~fault left indent setting. 

/ 



Indenting the First Line of a Paragraph 
The first line of a paragraph can be automatically indented to 
the right or to the left of the left indent setting each time 
RETURN is pressed. The Paragraph Indent command is used to 
set first-line paragraph indents. 
To set the first-line paragraph indent while entering text: 
1. Press INDENT {CODE-f3}. The Paragraph Indent menu appears. 
2. Move the cursor to the desired first-line indent stop on 
the ruler display. This can be to the right or to the left of 
the existing paragraph indent stop. 
3. Press F for first-line paragraph indent. The paragraph 
symbol appears in the ruler display to denote the first-line 
paragraph indent stop, and the menu goes away. 
4. Press INDENT again. The Paragraph Indent menu reappears. 
5. Move the cursor to the desired indent stop for the other 
lines of the paragraph. 
6. Press o. The indent symbol appears in the ruler display to 
denote the indent stop for the other lines of the paragraph, 
and the menu goes away. 

Figure E-2. Example of an Unformatted Document. 

Programmer Format Sets 

One of the files placed on a system by the 
installation procedures, WP.fmt, specifies certain 
word processor defaults in a way more suitable for 
editing of documents rather then programs. If 
instead, the user is going to use the word 
processor to edit programs, one file 
[sys]<sys>Prog80.fmt or [sys]<sys>ProgI32.fmt, 
should be added to the user's .user file. This is 
done by following these steps: 

1. Enter WRITEone in the command form. 

2. Enter the name of the user file to be edited. 
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3. Press the GO key. 

4. Make an entry of one of the following forms: 

:WPFormatSet: [sys]<sys>Prog80.fmt 

or 

:WPFormatSet: [sys]<sys>Prog132.fmt 

This allows the user to edit programs in 80-column 
or 132-column mode. In addition these formats 
contain evenly spaced tabs stops. These tabs 
should not be used when creating COBOL or FOTRAN 
sources because they will not be accepted when 
these sources are compiled. If it is desired to 
to use the word processor for writing program~, 
then delete the first page marker before any 
typing is done on the document. This is 
accomplished by pressing the Return key twice and 
then positioning the cursor on the first line. 
This will eliminate page markers being inserted 
into the document and thus eliminate syntax errors 
when the source programs are compiled. This can 
also be accomplished by using the Remove Format 
command (CODE-r). 



APPENDIX F 

FILES CREATED BY THE WORD PROCESSOR 

The Word Processor creates the following files 
during its operation: 

In the user dictionary: Document, Document-old, 
and Document-new where Document is the name of a 
document being edited. Normally, the "new-" file 
only exists temporarily during the save 
operation; its presence on the disk with no save 
operation in progress indicates that some failure 
has occured. If this is observed, the user 
should attempt to recover. If unable to recover, 
a comparison· of the contents of the various 
versions of the document should be made to 
determine which is the most accurate version. (If 
the Word Processor is to be used to compare the 
contents of the files, copies must first be made 
without the "-old" and "-new" suffixes.) If the 
"-new'" file is determined to be most accurate, it 
should be renamed to Document. 

The presence of an "-old" file on the disk is 
normal--this file reflects the contents of the 
document prior to the most recent save (CODE-S) 
of FINISH. Therefore, the user can return to 
this prior state renaming Document-old as 
Document. Alternatively, if the user is 
confident that he does not wish to return to this 
prior state, he may free space on the diskette by 
deleting the "-old" files. 

In the <Wp> directory: User.ts where User is the 
name supplied at the time of sign on. These are 
called typescript files and are used by the Word 
Processor recovery function. There will be one 
such file for each word processing user on a 
system. This file grows in size as keystrokes 
are entered during a word processing session. If 
space on a hard disk system runs short, the files 
may be deleted--this will recover the space 
occupied for inactive users and the typescripts 
of active users will be automatically recreated. 
Beware that if a user's most recent session ended 
abnormally, then the deletion of the typescript 
will make it impossible to recover the session. 

F-1 



F-2 

In the <$> directory: WpBin.tmp, WpBinB.tmp, 
WpFop.tmp, WpQue.tmp, WpDir.tmp, Wp.tmp, and 
WpB.tmp. These files contain various temporary 
data structures internal to the Word Processor 
that are needed during sessions. In between 
sessions they may be deleted to recover space and 
they will be automatically recreated as required. 
The creation of a file does take some time so in 
the interests of efficiency, their deletion is 
not performed automatically. 



APPENDIX G 

DOCUMENT EXCHANGE FORMAT (DEF) 

INTRODUCTION 

The Document Exchange Format is a programmer's 
tool and requires programming knowledge in order 
to be used successfully. A program has to be 
written, in one of the available B 20 languages, 
in order to convert a non-B 20 word processing 
file to a B 20 word processing file. This is 
accomplished by translating the non-B 20 word 
processing file's embedded escape codes to the 
equivalent DEF escape codes. This information 
along with the commands to do this are provided 
below. 

THE DEF FORMAT 

Levels of Format Application 

The Burroughs word processor applies document 
formatting in three levels. These are: 
character-level formats, paragragh-level formats, 
and page-level formats. No other levels of 
format exist. Also, DEF respects only these 
three levels of formatting. 

Character formats are those that modify 
characters only. Examples of character formats 
are superscript, boldface, and underscore. 
Examples of paragraph formats are tab settings 
and line spacing. Page formats include paper 
size and header margins. 

It is important to understand the relationship 
between these three levels. Since paragraphs 
are composed of characters and pages consist of 
characters and paragraphs, it may be confusing 
as to the level a particular format applies. For 
example, all of the characters in a paragraph may 
be boldface. This does not mean boldface is a 
paragraph-level format because it certainly is 
not necessary that every character in that 
paragraph be in boldface. However, if a 
paragraph has a tab stop at three inches, that 
tab stop exists for all text within that 
paragraph. 
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Related to the word processing format levels is 
the notion of runs. A run is a contiguous 
portion of text sharing the same formatting 
attributes. This implies that there are, again, 
three types of runs: character runs, paragraph 
runs, and page runs. A character run might 
consist of several words which are subscripted. 
A paragraph run may be many left-flush paragraphs. 
A page run would be all contiguous pages which 
have the same size and margins (Quite often in 
small documents there is only one paragraph run 
and one page run since all of the paragraphs and 
pages in a document have identical format). 

Note that all of .the formatting attributes for a 
particular run type (character, paragraph, a page) 
must be identical in order to qualify as a run. 
For example, text with boldface and strike­
through signifies a run. However, if underline 
is added, a new run begins even though both share 
boldface and strike-through. Not also that all 
the run types co-exist with each other without 
dependencies. This means that the start of a new 
paragraph run will not affect the exisiting 
character run. 

DEF Organization 
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DEF files have embedded escape codes which 
signify document formatting. These codes 
indicate format runs which are contiguous 
portions of text that share the same format 
attribute. There are three types of runs: 
character, paragraph, and page. 

Because DEF escape codes indicate formatting 
runs, this implies that any DEF action remains in 
effect until some other DEF action terminates the 
run. For example, if a DEF command sets the left 
document margin at two inches, all subsequent 
document margins are at the same position until 
changed. 

By nature, DEF files are stream files, meaning 
that DEF files can be accessed sequentially. No 
DEF command may apply to prior text, only· 
subsequent text. This also means that 
interpretation of DEF files are done in a single 
pass. Although it may be necessary to make 
several passes on a foreign system document in 
order to create.a DEF file, the DEF file can· only 
be a sequential file. 



DEF escape codes for character runs apply to the 
characters that immediately follow the escape 
sequence. However, for paragraph and page 
escape codes, the new attributes do not go into 
effect until an explicit New Paragraph or New 
Page escape code is encountered. This enables 
the DEF file to set a variety of paragraph and 
page formats prior to their actual invocation. 

Special Characters 

Several characters in Burroughs word processing 
documents are unique to Burroughs. These 
characters do not have ASCII representation. 
Unique DEF escape codes exist for these codes. 
Examples of such codes are page numbers, 
discretionary hyphens, and non-breaking spaces. 
Also included in the special characters are the 
New Paragraph and New Page escape codes. 

Headers and Footers 

Burroughs word processing headers and footers 
receive special treatment by DEF (For simplicity, 
the term headers shall apply to both headers and 
footers). Headers are a page-level formatting 
atribute. This means that a different header may 
appear on each page. 

Two components are required to apply a header to a 
page. First is the header text itself. Since 
mUltiple headers are allowed, this implies 
multiple header text definition. Secondly, there 
is the header application command. This command 
specifies that a header will reside on a given 
page, and also references the particular item 
from the array of header text mentioned. This 
array of header text must logically lie in the 
DEF file at the end of all other text if headers 
are to be used (headers are optional in 
Burroughs word processing documents). 

As an example, suppose a three-page document 
contained headers. In the body text portion of 
the first page, an escape command would indicate 
a header is used on this page, and the first 
header text defined is to be used. On the second 
page, the header command could specify the third 
header text item (order is not important). The 
third page would then specify the second header 
text item. 
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Because of this, a new class of DEF command 
exists -- the header text definition command. 
Header application commands are considered 
page-level formats. Header text definition 
command in a DEF file signifies the end of body 
text and the beginning of header text. All text 
from a header definition command until the next 
header definition command of end of the DEF file 
is considered part of the header definition. 
Note that header text may contain paragraph and 
character formats but page formats are ignored. 

DEF ESCAPE CODES 

DEF escape codes have the form $(command) where 
command is two or more characters. Recall that 
these commands are embedded within text in a DEF 
file, and that there are essentially five types 
of DEF commands: character commands, paragraph 
commands, page commands, header commands, and 
special commands. 

Certain DEF commands require numeric values in 
addition to the two or three character command 
identifiers. Many of these numeric values are 
measurements, such as margins, tab stop~,'and 
page sizes. These measurements are considered 
to be units in 1/240th inch. This allows the 
lowest common denominator of many standard word 
processing measuring schemes. Therefore, a 
numeric value of 240 represents one inch, and 
48 represents 1/5 inch. Note that these numeric 
values are kept in ASCII rather than binary. 
This enables DEF to he used with simple 
communications .schemes which only permit ASCII 
data, and it makes for DEF files which are 
easier read. 

Character Escape Codes 

G-4 

DEF character escape codes affect formatting when 
they occur. As with all DEF escape codes, 
character formats set by DEF escape codes remain 
in effect until reset by some other escape 
command. All Burroughs word processing character 
formats have corresponding DEF escape code 
representation. 



Character Excape Codes (Cont.) 

ESCAPE CODE 

$(AY) 

$(AN) 

$(BY) 

$(BN) 

$(DY) 

$(DN) 

$(KY) 

$(KN) 

$ (PT!!) 

$(SY) 

$(SN) 

$(UY) 

$(UN) 

$(XY) 

$(XN) 

$(YY) 

$(YN) 

$(NR) 

$ (WHname) 

FORMAT ACTION 

Start alternate ribbon. 

Stop' alternate ribbon. 

Start boldface. 

Stop boldface. 

Start double underline. 

Stop double underline. 

Start Keyword. 

Stop Keyword. 

Set the pitch value to the 
value specified by n. 

Start strike-thru text. 

Stop strike-thru text. 

Start underline. 

Stop underline. 

Start superscript. 

Stop superscript. 

Start subscript. 

Stop subscript. 

Start normal text. This 
will reset all character 
attributes, including the 
print wheel. 

Use the print wheel 
specified by name. The 
named print wheel must 
be supported by the 
Burroughs word processing 
system or this command is 
ignored. 
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Paragraph Escape Codes 
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Paragraph escape codes do not go into effect when 
encountered. Instead, their actions are saved 
until a New Paragraph escape code is encountered 
(see Special Character Codes). All Burroughs word 
processing paragraph formats have corresponding 
DEF escape code representation. This allows 
several formatting commands to go into effect at 
one time. Recall that whenever numeric values are 
required, these are represented in ASCII rather 
than binary. 

ESCAPE CODE 

$(IFn) 

$(ILn) 

$(IRn) 

FORMAT ACTION 

Set the paragraph first 
line indent to the value 
specified by n (given in 
units of 1/240th inch). 
The first line indent is 
measured relative to the 
paragraph left indent 
(see below). 

Set the paragraph left 
indent to the value 
specified by n (given in 
units of 1/240th inch). 
The left indent is 
measure relative to the 
left document margin (see 
page escape codes). 

Set the paragrpah right 
indent to the value 
specified by n (given in 
units of 1/240th inch). 
The right indent is 
measured relative to the 
right document margin 
(see page escape codes). 



Paragraph Escape Codes (Cont.) 

ESCAPE CODE FORMAT ACTION 

(TBtp,tp, ... ,tp) Set the tab stops to the 
position represented by 
p, and of the type 
represented by t. The 
tab types may be one of 
the following: L (left­
flush), R (right-flush), 
C (centered), D (decimal­
aligned), or A (comma­
aligned). Further, each 
type may be optionally 
preceded by a period to 
indicate leader dots 
i.e., .L indicates a 
left-flush tab with 
leader dots. 

$(LF) 

$(RF) 

$(JS) 

$(CN) 

The tab position is 
specified by p (given in 
units of 1/240th inch). 
The position is measured 
relative to the. left 
document margin. A 
maximum of twenty tabs 
per paragraph is allowed. 

Set the paragraph to 
left-flush. 

Set the paragraph to 
right-flush. 

Set the paragraph to 
justified (both left- and 
right-flush). 

Set the paragraph to 
centered. 

Note that paragraphs may be exactly one of either 
left-flush, right-flush, justified or centered. 
Unlike many other word processor implementations, 
center is a paragraph format and is mutually 
exclusive with all others 
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Paragraph Escape Codes (Cont.) 

ESCAPE CODE 

$(LNb,w,a) 

FORMAT ACTION 

Set paragraph line 
spacing. These 
measurements are required 
to set paragraph line 
spacing: before (b), 
within (w), and after 
(a) . All three 
measurements are given in 
units of 1/240th inch. 
For sy~tems which support 
only two kinds of 
paragraph spacing: 
within, and between, it 
is suggested that the 
before (b) and after (a) 
value each be set to 1/2 
of the between value. 

Page Escape Codes 
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Page escape codes do not go into effect when 
encountered. Instead, their actions are saved 
until a New Page escape code is encountered (see 
Special Escape Codes). This permits several 
formatting commands to go into effect at one time. 
All Burroughs word processing page formats have 
corresponding DEF escape code representation. 
Recall that whenever numeric values are required, 
they are represented in ASCII rather than in 
binary. 

ESCAPE CODE 

$(PGSw,h) 

FORMAT ACTION 

Set page width, 
represented by w, and 
height, represented by h 
(each given in units of 
1/240th inch). Both 
entries are required. 



Page Escape Codes (Cont.) 

ESCAPE CODE FORMAT ACTION 

$(PGMI,r,t,b) Set the page margins. 
These are represented by 
I (left margin), r (right 
margin), t (top margin), 
and b (bottom margin). 
All four entries are 
required. 
The left page margins 
measured relative to the 
left paper edge, the 
right margin is relative 
to the right paper edge, 
the top margin is 
relative to the top paper 
edge, and the bottom 
margin is relative to the 
bottom paper edge (each 
given in units of 1/240th 
inch). 

$(PGHh,f) Set the page header and 
footer margins. The 
header margin is 
represented by h, and the 
footer margin is 
represented by f. The 
header margin is measured 
relative to the top edge 
of the paper, and the 
Footer margin is measured 
relative to the bottom 
edge of the paper (given 
in units of 1/240th 
inch). Both measurements 
are necessary. 

$(PGNfa,fo,n) Set the page attributes. 
These will set facing 
pages (represented by 
fa), forced page 
(represented by fo), and 
page number (represented 
by n). 
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Page Escape Codes (Cont.) 

ESCAPE CODE 

$(HOn) 

$(HEn) 

G-10 

FORMAT ACTION 

The facing pages value 
(fa) may be either Y or 
N, where Y means facing 
pages is true. The 
forced page value (fo) 
may be either Y, N, 0, or 
E, where Y means forced 
page, N means no forced 
page, 0 means odd forced 
page, and E means even 
forced page (odd and even 
forced page breaks will 
produce blank pages in 
order to generate the 
necessary parity). The 
page number (n), 
determines the actual 
page number only if one 
of the three types of 
forced page breaks have 
been set. The facing 
pages and forced page 
values are mandatory, but 
the page number value is 
optional (the comma after 
the forced page value is 
mandatory, i.e., 
'$(PGNN,N,)'). 

Set headers for odd pages 
to the nth header of 
footer Text Definition. 
The number n indexes into 
the set of all header or 
footer text for the 
document as defined by 
the $(DH) format escape 
codes. (See Header 
Escape Codes). 

Set headers for even 
pages to the nth header 
of footer Text 
Definition. The number n 
indexed into the set of 
all header of footer text 
for the document as 
defined by the $(DH) 
format escape codes. 
(See Header Escape Codes). 



Page Escape Codes (Cont.) 

ESCAPE CODE 

$(HBn) 

$(FOn) 

$(FEn) 

$(FBn) 

$(WY) 

$ (WN) 

FORMAT ACTION 

Set headers for both odd 
and even pages to the 
nth header of footer 
Text Definition. The 
number n indexes into the 
set of all header or 
footer text for the 
document as defined by 
the $(DH) format escape 
codes. (See Header 
Escape Codes). 

Set footers for odd pages 
to the nth header of 
footer Text Definition. 
The number n indexes into 
the set of all header or 
footer text for the 
document as defined by 
the $(DH) format escape 
codes. (See Header 
Escape Codes). 

Set footers for even 
pages to the nth header 
of footer Text 
Definition. The number n 
indexes into the set of 
all header or footer text 
for the document as 
defined by the $(DH) 
format escape codes. 
(See Header Escape 
Codes). 

Set footers for both odd 
and even pages to the. 
nth header of footer 
Text Definition. The 
number n indexes into the 
set of all header or 
footer text for the 
document as defined by 
the $(DH) format escape 
codes. (See Header 
Escape Codes). 

Widow Control On. 

Widow Control Off 
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Header Escape Codes 

Header escape codes are distinct from other 
format specifications. For simplicity's sake, 
assume both header and footer text definition. 
These codes contain the actual text that appears 
within the headers or footers as defined per page 
(see Page Escape Codes). The text contained within 
a header specification begins after the Define 
Header escape code and continues until the next 
Define Header escape code (or end of file). The 
first occurence of a Define Header escape code 
signifies the end of the body text portion of a 
~ocument. All Define Header escapes must be 
contiguous. 

The text within a header text definition may 
itself contain DEF escape codes. These may be 
either character escape codes, paragraph escape 
codes, or special escape codes. Page escape 
codes are not allowed, and header escape codes 
delimit header text. 

ESCAPE CODE 

$(DH) 

FORMAT ACTION 

Define header or footer 
text. The text includes 
that which follows the 
header escape code up to, 
but not including, the 
next header escape code 
(or end of file). 

Special Escape Codes 

G-12 

Special escape codes are those which represent 
characters not easily interpreted by normal text. 
Included among the special escape codes are New 
Paragraph nd New Page. These special codes 
signify the start of a new paragraph or page, and 
also apply any new paragraph of page formats as 
defined by the paragraph or page escape codes. 

ESCAPE CODE 

$(SA) 

SPECIAL CHARACTER 

$ - Since the $ character 
identifies DEF escape 
code, this escape code 
permits their use in DEF 
files. 



Special Escape Codes (Cont.) 

ESCAPE CODE 

$(SB) 

$(SC) 

$(SD) 

$(SE) 

$(SF) 

$(SG) 

$(SH) 

$ (S I) 

$(SJ) 

SPECIAL CHARACTER 

New Paragraph - Begin a 
new paragraph setting any 
new paragraph formatting 
attributes pending such 
appl icat.ion. 

New Page - Begin a new 
page setting any new page 
formatting attributes 
pending such application. 

Arabic Page Number. 

Discretionary line break. 
Also known as a 
discretionary space. 

Non-breaking space, Also 
known as a required 
space. 

Discretionary hyphen. 

Discretionary return 
(Note - there is no such, 
character in the 
Burroughs word processing 
document format. This is 
included for 
compatibility with other 
systems but will be 
ignored by Burroughs word 
processing. 

Non-breaking hyphen. Also 
known as a required hyphen. 

Roman Page Number 
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USING DEF 
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Document Exchange Format (DEF) is a definition of 
a format for word processing document files. It 
provides a common language through which word 
processing files created on non-Burroughs 
systems (for example, NBI and Wang) can be trans­
lated into word processing files that have a 
format that a Burroughs system can use. 

If a foreign word processing file is to be 
converted to the Burroughs format, it must first 
be converted to a file that has the DEF format. 
The DEF format file then can b~ converted to a 
Burroughs format file. 

The Document Exchange Format operation has two 
functions. 

o It converts a Burroughs word processing 
format file to a DEF file. 

o It converts a DEF file to a Burroughs word 
processing format file. 

Figure G-l further illustrates how files are 
converted by using this operation. 

You invoke the Document Exchange Format command 
through the Commands function. 

1. Press COMMANDS (CODE-f7). The Commands menu 
appears on the screen. (See Figure 5-14.) 

2. Press D for Document Exchange. The Document 
Exchange menu appears on the screen. (See 
Figure G-2.) 

The Document Exchange menu allows you to convert 
a Burroughs format document file to a DEF file 
or to convert a DEF file to Burroughs format. 

To convert a Burroughs format file to a DEF 
file: 

1. Enter the document name of the Burroughs 
format file that is being converted to a DEF 
file. Press NEXT. 

2. Enter the name of the DEF file that is being 
created. Press NEXT. 



Document exchange format 
B 20 word processing document document file (converted from a 
file foreign word processing 

document file). 

! ! 
Document Exchange Format Document Exchange Format 

(DEF) command (DEF) command 

Invoke DEF command to convert 
Invoke DEF command to convert document exchange format 
B 20 word processing document document file to B 20 format 
file to document exchange format word processing document 
file. file. 

J ! 
Document exchange format B 20 word processing document 
document file file 

! 
Convert document exchange 
format document file to a foreign 
word processing file (for example, 
NBI or Wang word processing 
file). 

Figure G-1. Document Exchange Format Operations. 

3. Press T for liTo DEF" to specify the direction 
of the conversion. (Here you want the 
Burroughs file to be converted to a DEF 
file.) 

4. Press GO. 
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After you press GO, the message 

Press GO to create X, CANCEL to dismiss 

appears at the top of the Document Exchange 
form. X is the name of the file that is being 
created to contain the DEF version of the 
Burroughs file. Press GO to create the file. 

DOCUMENT EXCHANGE: (Press GO to execute, NEXT for next item, CANCEL to dismiss) 

Document name: 
DEF file name: 
Direction: 

G·16 

To DEF From DEF (Press T orF) 

Figure G·2. Document Exchange Format Menu. 

To convert a DEF file to a Burroughs format 
file: 

1. Enter the document name of the Burroughs 
format file that is being created. Press 
NEXT. 

2. Enter the name of the DEF file that is being 
converted. Press NEXT. 

3. Press F for "From DEF" to specify the 
direction of the conversion. (Here you want 
the DEF file to be converted to a Burroughs 
format file.) 

4. Press GO. 

After you press GO, the message 

Press GO to create X, CANCEL to dismiss 

appears at the top of the Document Exchange 
form. X is the name of t'he file that is being 
created to contain the Burroughs format version 
of the DEF file. Press GO to create the file. 



GLOSSARY 

NOTE 

For descriptions of specific keys and their 
functions that are not found in this 
Glossary, see Section 2, "Keyboard." 

BACKSPACE. BACKSPACE is the key used to back 
space one position. In insert mode, it deletes 
one character. In overtype mode, it moves the 
cursor one position to the left (or, if the 
cursor is at the start of a line, to the end of 
the previous line) but does not delete a char­
acter. 

BOUND. The BOUND key moves the cursor and 
extends the selection to the next space, 
character, word, line, paragraph, or page. 

Breaking Required Hyphen. A breaking required 
hyphen (typed with the hyphen key) is the 
standard hyphen and is used in expressions such 
as father-in-law and tailor-made. These expres­
sions must always be hyphenated but can be split, 
if needed, after a hyphen. The Word Processor 
breaks such an expression if it would otherwise 
extend beyond the end of a line. 

Current Window. The current window is the window 
containing the cursor. Editing operations affect 
the document in the current window. 

Cursor. The cursor is the blinking underline on 
the screen that indicates where the next charac­
ter can be entered. 

Daisy Wheel Printer. A daisy wheel printer is a 
character printer that uses interchangeable metal 
and plastic print wheels to print several types 
and sizes of characters. (Also see Draft 
Printer.) 

Dedicated Printer. A dedicated printer is a 
printer that is physically connected to a 
particular workstation and cannot be shared by 
another workstation. (Also see Local Printer and 
Shared Printer.) 
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Default Value. A default value is the value 
assumed by a field in a form or menu in the 
absence of a user-specified parameter. 

Delimiter. A delimiter is a character that is 
used to separate and organize a string of data, 
but is never a part of the string. 

Discretionary Hyphen. A discretionary hyphen 
(typed with CODE-hyphen) is a hyphen that appears 
when a word breaks at the end of a line, and not 
otherwise. Sometimes a long word cannot fit at 
the end of a line. Placing a discretionary 
hyphen in the long word causes the word to break 
when it would otherwise extend beyond the end of 
a line. If the text is later edited so that the 
word no longer breaks at the end of a line, the 
hyphen does not appear. 

Discretionary Line Break. A discretionary line 
break (typed with CODE-spacebar) inserted into a 
phrase or a sentence causes the phrase or sen­
tence to break when it would otherwise extend 
beyond the end of the line. 

Document Status Line. The document status line 
is the line dividing the main text area of the 
screen and the ruler display. It displays the 
name of the current document, the page number in 
the current window, and the number of the line in 
which the cursor is positioned. 

Draft Printer. A draft printer is a line printer 
that prints documents that do not have character 
formats, such as underlines, boldface, propor­
tional spacing, etc. (Also see Daisy Wheel 
Printer.) 

Field. A field is a part of a form in which 
specific instructions are given to the Word 
Processor. A field is either a blank (to be 
filled in) or a choice of options. In list 
processing, a field is a group of characters, 
separated by delimiters, that represent a single 
unit. 

Footer. A footer is one or more lines of text 
that print at the bottom of each page of a 
document. 



Form. A form is the screen display that requests 
you to fill in certain areas to specify 
particular operations. (Also see Menu.) 
Form document. In list processing, a form docu­
ment is the document into which the data in the 
records file is merged during the merge opera­
tion. (Also see Records File.) 

Format. A format is a set of attributes applied 
to a block of text or a single character, for 
example, underlining, centering, first line para­
graph indent. 

Function Key. A function key is one of the ten 
keys, labeled f1 to flO, in the top row of the 
typew~iter pad of the keyboard. 

Header. A header is one or more lines of text 
that print at the top of each page of a document. 

Indent. An indent is the left or right block 
indent of a paragraph from the left or right page 
margin, or its first line indent from the left 
page margin. 

Index Tab. An index tab is the highlighted strip 
at the top boundary of each window when mUltiple 
windows are displayed. The index tab shows the 
number of the page being displayed and the number 
of the line containing the cursor. 

Insert Mode. Insert mode is the mode in which 
characters typed from the typewriter pad of the 
keyboard are inserted into a document. The char­
acters are inserted just before the cursor. The 
cursor, and any characters on the line to the 
right of it, move to the right. The Word 
Processor is in insert mode when the light.on the 
OVERTYPE key is off. (Also see Over type Mode.) 

Keyword. In list processing, a keyword is the 
symbolic field name (defined in the template 
record of the records file) that represents the 
actual data that is merged into the form document 
during the merge operation. 

Lexicographic sort. In list processing, a 
records file can be sorted either numerically, or 
lexicographically (alphabetically and numeric 
ally). (Entries in a dictionary are sorted and 
listed lexicographically.) 
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Local Printer. A local printer is a printer that 
is physically connected to a particular work 
station. It can be shared by other workstations 
if it is local to the master and the spooler is 
installed. (Also see Dedicated Printer and 
Shared Printer.) 

Menu. A menu lists various options and allows 
you one choice. (Also see Form.) 

Nonbreaking Required Hyphen. A nonbreaking 
required hyph~n (typed with CODE-SHIFT-hyphen) is 
a hyphen that keeps expressions together as a 
group, rather than breaking them at a hyphen when 
at the end of a line. 

Nonbreaking Space. A nonbreaking space (typed 
with CODE-SHIFT-spacebar) is one that keeps 
expressions together as a group, rather than 
breaking them at a space when at the end of a 
line. 

Overtype Mode. Overtype mode is the mode in 
which characters typed from the typewriter" pad of 
the keyboard replace (rather than insert) charac­
ters in a document. You can move the cursor and 
type characters exactly as in insert mode, but 
every character typed replaces the existing one 
(if any) at the cursor position. The Word 
Processor is in overtype mode when the light on 
the OVERTYPE key is on. (Also see Insert Mode.) 

Page Number Symbol. The page number symbol 
(typed with CODE-fS) is a half-bright # on the 
screen and is replaced with the proper page 
number when the document is printed. 

Paging. Paging (using PREV PAGE or NEXT PAGE) is 
an operation that shifts the content of the 
window backward or forward one page at a time. 

Paragraph. A paragraph is an area of text 
beginning with a paragraph mark and ending with 
(but not including) the next paragraph mark or 
the end of the document. A new paragraph begins 
each time RETURN is pressed. 



Pitch. Pitch refers to the size of a printed 
character (in characters per inch) on a print 
wheel. The Word Processor has IO-pitch and 12-
pitch print wheels as standard. Print wheels 
with nonstandard pitch (such as 8- or IS-pitch) 
also can be used. 

Primary Window. A primary window is the top 
window of a document. (Also see Secondary 
Window.) 

Printer Spooler. The printer spooler is used to 
print documents from standalone and cluster work 
stations on spooled printers at user-specified 
priorities and permits other tasks to be per­
formed during printing. 

Records. In list processing, a record is a con­
tiguous group of related items. Each item is 
represented by a single field. 

Records file. In list processing, a records file 
is a text document containing a list of records, 
each of which contains zero or more fields. The 
contents of the records file are sorted and/or 
selected during sort/select operations, and are 
merged with the form document during the merge 
operation. (Also see Form Document.) 

Recover. The Recover command is used to repeat 
automatically the work of a word processing 
session, by replaying a typescript of all work 
done. (Also see Typescript.) 

Required Backspace. A required backspace (typed 
with CODE-BACKSPACE) allows special characters to 
be created that may not be part of a print wheel 
set. For example, a slash (I) can be printed 
over an equal sign (=) to produce the not-equal 
sign (/). 

Ruler Display. The ruler display occupies the 
top two lines of the screen and is used for set­
ting tabs and indents. It is divided into units 
that represent the columns of text, depending on 
the pitch of the print wheel being used. 

Scrolling. Scrolling is an operation that moves 
text up and down (vertical scrolling) or left 
and right (horizontal scrolling) on the screen. 
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Secondary Window. A secondary window is the 
lower window created after division of a docu­
ment. (Also see Primary Window.) 

Selection. A selection is a contiguous block of 
characters (highlighted in reverse video) in a 
document on which certain editing operations can 
be performed (such as formatting, moving, copy 
ing, deleting). 

Shared Printer. A shared printer is a printer 
that is shared by more than one workstation. A 
shared printer is always connected to the master 
workstation and contains the printer spooler. 
(Also see Local Printer and Dedicated Printer~) 

Status Message·. "A status message appears at the 
bottom line of the screen to inform you of a 
particular occurrence within the system. . 

Struck-Out Text. Struck-out text is a character 
format attribuie that specifies a single horizon 
tal line typed over the text. 

Template record. In list processing, the tem­
plate record is the first record in a records 
file. It defines the record start and field 
start characters and the keywords. (Also see 
Keyword and Records File.) 

Typescript. A typescript is a file created 
during a word processing session that contains a 
record of all changes made to a document during 
that session. (Also see Recover.) 

Widow. A few words at the end of a paragraph 
that cannot fit on the page and are carried over 
to the next page. 

Window. A window is the part of a document that 
is currently displayed on the screen. 

Wraparound. Wraparound is the automatic moving 
of text (as it is entered) to the next line when 
the end of a line is reached. 

Zoom. The Zoom command switches a B 22 work 
station screen between 80 and 132 columns of 
text. (Zoom does not work on a B 21 workstation 
screen.) 



ACTION key, 2-9 
Autohyphenation, 4-87, 7-16 
Automatic correction, 7-7, 

7-13 

Background printing, 4-89 
BACKSPACE Key, 2-3, 4-22 
Boldface text, 4-52 
BOUND key, 2-6,4-34 
Bound command, 2-6, 4-34 
Breaking required hyphen, 2-1 

4-58 

CANCEL key, 2-9 
Cancelling pringing, 4-95 
Changing selections, 4-34 
Check spelling option, 7-7 
Close Window command, 5-2 
CODE key, 2-4 
CODE-BACKSP ACE, 2-3, 4-24 

4-57 
CODE-Down Arrow, 2-5, 4-30 
CODE-hyphen, 2-1, 4-57, 7-3 
CODE-Left Arrow, 2-5 4-30 
CODE-MARK, 2-5, 4-33 . 
CODE-NEXT PAGE, 2-10, 4-42 
CODE-Right Arrow, 2-5,4-30 
CODE-SHIFT-hyphen, 2-1,4-58 
CODE-SHIFT-RETURN, 2-3, 4-64 
CODE-SHIFT-spacebar, .2-4, 4-58 
CODE-SHIFT-TAB, 2-3, 4-64 
CODE-spacebar, 2-4, 4-55 
CODE-TAB, 2-3, 4-63 
CODE-Up Arrow, 2-4, 4-30 
Columns, 5-11 

clearing, 5-16 
copying, :5-14 
deleting, 5-16 
marking, 2-8 
moving, 5-13 
selecting, 5-12 
totaling, 5-20 

Commands, 2-69,4-2,4-7 
Bound, 2-6, 4-34 
Breaking required hyphen, 

2-1,4-58 
Close Window, 5-2 
Copy, 2-9, 4-36,5-7, 5-17 
Date/Time, 4-20 
Discard, E-3 
Discretionary hyphen, 2-1, 

4-57,7-3 
Discretionary line break, 

2-4,4-59 
Divide Window, 5-1 

INDEX 

Commands (cont.) 
Document Exchange Format, 

5-28 
Documents, 2-6, 4-13, 4-17, 

4-108 
Footer, 2-7,4-80 
Forced Page, 2-10,4-42 
Format, 2-6, 4-49, 5-4 
Go to Beginning, 4-32 
Go to End, 4-32 
Go To Page, 2-8, 4-31 
Header, 2-7,4-76 
Help, 2-9, 4-20 
Indent, 2-6,4-59 
Insert Hexadecimal, E-1 
Insert Literal, E-2 
Mark, 2-5, 4-32 
Mark Column, 2-8,4-33, 5-12 
Mark Doc, 2-8, 4-33 
Mark Line, 2-8, 4-33 
Mark Page, 2-8, 4-33 
Mark Paragraph, 2-8, 4-33 
Mark Word, 2-8, 4-33 
Merge, 6-10 
Move, 2-9, 4-35, 5-5, 5-13 
Nonbreaking required hyphen, 

2-1,4-58 
Nonbreaking space, 2-4, 4-58 
Open Document, 4-25, 5-4 
Outline Indent, 2-3, 4-63 
Page ,2-7,4-76 
Paragraph Indent, 2-6, 4-59 
Print, 2-7,4-89 
Printer Status, 4-94 
Recover, 5-22 
Redo, 2-6, 4-42, 4-46, 4-47 
Remove Format, E-3 
Replace, 2-7, 4-39, 4-40 . 
Required Backspace, 2-3 

4-24,4-58 
Review Documents, 2-7; 4-83 
Roman-Page Number, 2-7 
Save, 4-25 
Search, 2-7, 4-38 
Sort, 6-1, 6-15, 6-17 
Spelling Checker, 5-32, 7-1 

7-7 
Tabs, 2-6, 4-43, 4-46 
Thumb, E-2 
Total Unindent, 2-4, 4-63 
Undo, 2-6, 4-43 
Unindent, 2-3, 4-63 
Visible, 4-57 
Word Backspace, 4-22 
Zoom, 5-20, D-1 
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Commands function, 5-27, 6-9 
6-12 

COMMANDS key, 2-"8, 5-27 
Control pad, 2-9 
Copy command, 2-9, 4-36, 5-7 
COpy key, 2-9, 4-36 
Copying a document, 4-111 
Copying text, 4-36, 5-7 
Correcting text, 4-22 
Cursor, 3-4, 5-3 
Cursor control keys, 2-4,4-29 
Cursor pads, 2-4 

Date/Time command, 4-20 
DEF escape codes, G-4 

character escape codes, G-4 
header escape codes, G-12 
page escape codes, G-8 
paragraph escape codes, G-6 
special escape codes, G-12 

DEF format, G-1 
use of, G-14 

DELETE key, 2-9, 4-22, 5-16 
Deleting, 

blank line, 4-33 
documents, 4-111 
text, 4-22, 4-35 

Dictionary, common word, 7-1 
7-8 

Dictionary, personal, 7-2 
7-3 7-4 7-8 7-9 

Dictionary: vie~ng,' 7-13 
Directory, document, 4-109 
Discard command, E-3 
Discarding edits, E-3 
Discretionary hyphen, 2-3, 

4-57,7-3 
Discretionary line break, 2-4, 

4-59 
Disks, write protecting, D-B 
Display pad, 2-10 
Displaying print queue 

entries, 4-99 
Divide Wipdow command, 5-1 
Document Exchange Format, G-1 

command,5-27 
escape codes, G-4 
headers and footers, G-3 
organization, G-2 
special characters, G-3 

Document status line, 3-2, 5-4 
Documents command, 2-6,4-14 

4-17,4-108 
DOCUMENTS key, 2-6,4-110 
Down Arrow key, 2-5, 4-30 

Editing a document, 4-32 
Electronic Mail, 5-28 
Entering text, 4-21,4-47 
Executive, 4-11, 4-12, 5-30 

Facing pages, 4-74 
Field start character, 6-2 
Fields, 6-2 

primary sort, 6-16 
secondary sort, 6-16 

Finishing a document, 4-26 
FINISH Key, 2-9, 4-25, 4-26 
Footer command, 2-7, 4-80 
FOOTER key, 2-7,4-80 
Footers, 4-80 

changing, 4-83 
deleting, 4-83 
position, 4-74 

Forced Page command, 2-10, 
4-42 

Forced page number, 4-76 
Forcing page breaks, 4-42, 

4-75 
Form documents, 6-1, 6-6 

pagination, 6-11 
FORMAT key, 2-6,4-49 
Format command, 2-6, 4-49, 5-4 
Formatting, 4-49, 4-59, 4-70 

screen limitations, D-3 
Forms, 4-7 
Function pad, 2-6 

GO key, 2-11, 4-9 
Go to Beginning command, 4-32 
Go to End command, 4-32 
Go To Page command, 2-8,4-31 

Hardware considerations, D-1 
Header compIand, 2-7, 4-76 
HEADER key, 2-7, 4-76 
Headers, 4-76 

changing, 4-79 
deleting, 4-79 
position, 4-73 

HELP key, 2-9, 4-20 
Help command, 2-9, 4-20 
Hexadecimal code, E-1 
Hot zone, 4-85 
Hyphen, 2-1 
Hyphenate word option, 7-16 
Hyphenating, 4-85, 7-10, 7-16 

INDENT key, 2-6, 4-61 
Indent command, 2-7,4-63 
Indents, 4-61, 4-63 

changing, 4-63 
first line paragraph, 4-62 

Index tab, 5-1, 5-4 
Insert Hexadecimal command, 

E-1 
Insert Literal command, E-2 
Inserting text, 4-23 
Insert mode, 4-23 
Invoking the Word Processor, 

4-14,4-15 



Keyboard, 2-1 
Keys, 

ACTION, 2-9 
BACKSPACE, 2-3, 4-24 
BOUND, 2-6, 4-33 
CANCEL, 2-9 
CODE,~-4 
CODE-BACKSPACE, 2-3, 4-24 
CODE-Down Arrow, 2-5, 4-30 
CODE-hyphen, 2-1, 4-58, 7-3 
CODE-Left Arrow, 2-5, 4-30 
CODE-MARK, 2-5, 4-32 
CODE-NEXT PAGE, 2-10, 4-42 
CODE-Right Arrow, 2-5,4-30 
CODE-SHIFT-hyphen, 2-1, 4-58 
CODE-SHIFT-RETURN, 2-3 

4-65 
CODE-SHIFT-spacebar, 2-4 

4-58· ... 
CODE-SHIFT-TAB, 2-3, 4-65 
CODE-spacebar, 2-4, 4-59 

. CODE-TAB, 2-3, 4-64 
CODE-Up Arrow, 2-4, 4-30 

"COMMANDS, 2-8, 5-27 
COPY, 2-9, 4-36 1, 

DELETE, 2-9, 4-22, 5-16 
DOCUMENTS, 2-6, 4-108 
Down Arrow, 2-5, 4-30 
FINISH, 2-9, 4-25, 4-26 
FOOTER, 2-7,4·80 
FORMAT, 2-6, 4-49 
GO, 2-11 
GO TO PAGE, 2-8, 4-31 
HEADER, 2-7, 4-76 
HELP, 2-9, 4-20 
Hyphen, 2-1 
INDENT, 2-6,4-59 
Left Arrow, 2-5, 4-30 
LOCK (SHIFT), 2-3 
MARK, 2-5, 4-32 
MARK COLUMN, 2-8, 4-33, 5-12 
MARK DOC, 2-8, 4-33 
MARK LINE, 2-8, 4-33 
MARK PAGE, 2-8, 4-33 
MARK PARA, 2-8, 4-33 
MARK WORD, 2-8, 4-33 
MOVE, 2-9,4-35, 5-5, 5-13 
NEXT,2-11 
NEXT PAGE, 2-10, 3-4, 4-29, 

4-31 
OVERTYPE, 2-9, 4-23 
PAGE ,2-7,4-78 
POINT OF LAST EDIT, 2-6 
PREVIOUS PAGE, 2-10, 3-4 

4-29,4-31 
PRINT, 2-7,4-89 
RECALL PHRASE, 2-8 
REDO, 2-6,4-42 
REPLACE, 2-7, 4-39 
RETURN, 2-3 

REVIEW, 2-7,4-85 
Right Arrow, 2-5,4-30 
SCROLL DOWN, 2-10, 3-4 

4-29,5-3 
SCROLL UP, 2-10, 3-4,4-29 

5-3 
SEARCH, 2-7,4-38 
SHIFT, 2-4 
SHIFT-Down Arrow, 2-5,4-30 
SHIFT-Left Arrow, 2-5,4-30 
SHIFT-RETURN, 2-3, 4-21 
SHIFT-Right Arrow, 2-5, 4-30 
SHIFT-SCROLL DOWN, 2-10, 

3-4,4-29 
SHIFT-SCROLL UP, 2-10,3-4, 

4-29 
SHIFT-Up Arrow, 2-4,4-30 
Spacebar, 2-4 
STORE PHRASE, 2-8 
TAB, 2-3, 4-46 
TABS, 2-6,4-43,4-45 
UNDO, 2-6, 4-43 
Up Arrow, 2-4,4-30 

Keywords, 6-2, 6-3, 6-5, 6-6, 6-8· 
date, 6-9 
format option, 6-6 
formatting, 6-8 
reserved, 6-8 
date, 6-8 
specifying, 6-6 
time, 6-8 

Left Arrow key, 2-5, 4-30 
Lexicographic sort, 6-16 
Line spacing, 4-65, 5-9 
Line Symbol, 2-3 
Lines within columns, 5-13, 

5-16,5-17 
Literal characters, E-2 
List Processing, 6-1 
LOCK (SHIFT), 2-3 

MARK key, 2-5, 4-32 
MARK COLUMN key, 2-8, 4-33, 

5-12 
Mark Column command, 4-33, 

5-12 
MARK DOC key, 2-8, 4-33 
Mark Doc command, 2-8, 4-33 
MARK LINE, 2-8, 4-33 
Mark Line command, 4-33 
MARK PAGE key, 2-8, 4-33 
Mark Page command, 4-33 
MARK PARA key, 2-8, 4-33 
Mark Paragraph command, 4-33 
MARK WORD key, 2-8, 4-33 
Mark Word command, 4-33 
Menus, 4-9 
Merge, 5-30, 6-1, 6-10 
Merge command, 6-10 

3 



4 

MOVE key, 2-9, 4-35, 5-5, 
5-13 

Move command, 2-9, 4-35, 5-5, 
5-13 

Moving columns, 5-13 
Moving text, 4-35, 5-4 
Moving within the document, 

4-28,5-5 
Multiplan, 5-25 
Multiple documents, 5-4 
Multiple windows, 5-4 

New documents, 4-21 
NEXT key, 2-11 
NEXT PAGE key, 2-10, 3-3, 

4-29,4-31 
Nonbreaking required hyphen, 

2-1,4-58 
Nonbreaking space, 2-4, 4-58 
Numeric pad, 2-11 

Opening a document, 4-13 
4-17,4-26 

Open Document command, 4-26, 
5-4 

Open document option, 4-108, 4-111 
Outline Indent command, 2-3, 

4-63 
OVERTYPE key, 2-9,4-21,4-24 
Overtype mode, 4-21, 4-24 
Overtyping, 2-3, 4-24 

Page breaks, 4-75 
Page command, 2-7, 4-78 
PAGE key, 2-7,4-78 
Pages, 

breaks, 4-75 
formatting, 4-70 
margins, 4-72 
size, 4-72 

Pagination, 4-88 
Paragraph Indent command, 2-7, 

4-61 
Paragraph symbol, 2-3 
Passwords, 4-11, 4-12, 4-17,4-26 
Personal dictionary, 7-2, 7-9 

creating, 7-2 
installing, 7-3 
unloading, 7-5 

Picture Editor, 5-30 
Pitch, 4-101, 4-102, 4-103, 4-105 
PREVIOUS PAGE key, 2-11, 3-4, 

4-29,4-31 
PRINT key, 2-7, 4-90, 4-93 
Print command, 2-7, 4-90 
Print specifications, 4-93 
Print wheels, 

changing, 4-101,4-102 
character mapping, B-7 

character spacing, B-2 
configuration, B-1 
fixed pitch, B-2 
mapping table, B-4, B-5 
name, B-1 
proportional spaced, B-2 
set, 4-101, B-1, B-4, B-6 
symbol table, B-5 

Printers, 4-90, C-1 
cables and connections, C-9 
configurations, C-1 
description file, C-1 
D~ablo 630 HPR05, C-6, C-9 
Diablo 630 SPI, C-8 
halting, 4-97 
switch settings, C-3 

Printer priority, 4-94 
Printer spooler program, 4-91 
Printer Status command, 4-94 

4-95 
Printing, 

background, 4-90 
documents, 4-89 
direct, 4-91, D-3 
reprinting, 4-97 
resuming, 4-97 
spooled, 4-91 

Prompts, 3-5, 4-10 

RECALL PHRASE, 2-8 
Records, 6-2, 6-17 

bad, 6-11 
files, 6-1, 6-2, 6-3, 6-5 
selecting, 6-14 
sorting, 6-17 
start character, 6-2 
template, 6-2, 6-3, 6-5 

Recover command, 5-23 
Recovering a document, 5-22 
Redo command, 2-6,4-42,4-46, 

4-47 
Redoing an edit, 4-42 
REDO key, 2-6,4-42,4-46,4-47 
Remove Format command, E-3 
Removing a selection, 4-35 
Removing formatting, E-3 
Removing multiple format 

attributes, 4-56 
Renaming a document, 4-112 
REPLACE key, 2-7, 4~39 
Replace command, 2-7,4-39, 

4-40 
Replacing text, 4-39 
Required Backspace, 2-3, 4-24, 

4-57 
RETURN key, 2-3 
Review Documents command, 2-7, 

4-85 
,REVIEW key, 2-7, 4-85, 4-88 



Ribbons, changing, 4-107 
Right Arrow key, 2-5, 4-30 
Roman Page Number symbol, 2-7 
Ruler display, 3-2, 3-4 

Save command, 4-25 
Saving a document, 4-25 
Screens, 3-1, D-1 
SCROLL DOWN key, 2-10, 3-4, 

4-29, 5-3 
Scroll keys, 2-10, 3-4, 4-29 
SCROLL UP key, 2-10, 3-4, 

4-29, 5-3 
Scrolling, 4-29, 5-3 
SEARCH key, 2-7, 4-38 
Searching for text, 2-7, .4-38 
Search command, 2-7,4-38 
Select command, 6-17 
Selections, 4-32, 5-12, 5-13 
SHIFT key, 2-4 
SHIFT-Down Arrow, 2-5, 4-30 
SHIFT-Left Arrow, 2-5,4-30 
SHIFT-LOCK, 2-3 
SHIFT-RETURN, 2-3, 4-21 
SHIFT-Right Arrow, 2-5,4-30 
SHIFT-SCROLL DOWN, 2-10, 3-4, 

4-29 
SHIFT-SCROLL UP, 2-10, 3-4, 

4-29 
SHIFT-Up Arrow, 2-4,4-30 
Signing on to the Executive, 

4-11 
Sort, 6-1, 6-13, 6-17 
Sort/Select, 5-26, 6.1 
Spacebar, 2-4 
Special characters, 4-57, 6-4 
Spelling Checker, 5-32, 7-1, 

7-7 
SRelling correction options, 

. 7-8 
Sign on form, 4-11 
Status messages, 3-1, A-1 
STORE PHRASE, 2-8 
Struck-out text, 4-56 
SUbscript text, 4-54 
Substituting words, 7-12 
Summary of Commands, 4-2 
Superscript text, 4-53 

TAB key, 2-3,4-47 
TABS Command key, 2-6, 4-43, 4-45 
Tabs command, 2-6,4-43,4-45 
Tabs, 4-43 

centered, 4-44 
clearing, 4-46 
decimal, 4-44 
evenly space, left-aligned, 

4-44 

leader dots, 4-44 
left-aligned, 4-44 
right-aligned, 4-44 
setting, 4-43, 4-44 

Text alignment, 4-68 
Thumb command, E-2 
Total Unindent command, 2-4, 

4-63 
Typescript file, 5-22 
Typewriter pad, 2-1 

Underlined text, 4-51 
UNDO, 2-6,4-43 
Undoing an edit, 4-43 
Undo command, 2-6, 4-43 
Unformatted documents, E-2 
Unindent command, 2-3, 4-63 
Up Arrow key, 2-4, 4-30 

Visible command, 4-57 
Volumes, 4-113, 4-114 

White space, 4-85 
Widows, 2-7, 4-85 
Wild cards, 4-114 
Windows, 3-4 

closing, 5-3 
current, 5-2 
dividing, 5-2 
primary, 5-4 
secondary, 5-4 

Word Backspace command, 4-22 
Word Processor symbol table, 

B-3 
Work area, changing, 4-113 
Workstations, 

AWS, D-2 
IWS, D-1 

Wraparound, 4-21 

Zoom command, 5-20, D-1 
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